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MYOB Australia Pty Ltd Licence Agreement

IMPORTANT – READ THIS CAREFULLY BEFORE USE. This is the software agreement. 
As you have purchased the Product, following notification of the Licence you are 
now legally bound by its conditions. HOWEVER if the Licence Agreement contains 
anything of which you were not aware prior to purchasing the Product or do not 
agree to be bound by, DO NOT INSTALL THE SOFTWARE but return the Product to 
the reseller in its entirety and a full refund of the purchase price will be made. By 
installing the software and keeping the Product you are confirming that you have 
purchased the Product subject to this Licence and are bound by its provisions.

1 Scope of Licence

MYOB Technology Pty Ltd, through its publisher MYOB Australia Pty Ltd and its 
local distribution agents, hereby grant to you, the original purchaser, a paid-up, 
personal, non-exclusive and non-transferable Licence to use the User Guide and the 
Program subject to the terms and conditions of this Agreement.

a Single Computer You may use the Program on only one computer that you own 
or operate at a single physical location. You may transfer the Program from one 
such computer to another that you own or operate provided that you do not use 
or permit the usage of the Program on more than one computer or computer 
terminal at a time. In event of an upgrade or product exchange the licence 
hereby granted shall automatically transfer to the new version or product. All 
rights in respect of the original product shall lapse and no further use of same 
shall be permitted. 

b Copies You may not copy or duplicate the Program, except as necessary solely for 
archival purposes, program error verification, or to replace defective storage 
media, provided you keep the original and the copies. You may not alter, decom-
pile or disassemble the Program. You may not make copies of the User Guide.

c Transfers You may not sub-license, lease, rent or lend the Program or the User 
Guide or otherwise transfer any of your rights under this Agreement. Subject to 
the prior written consent of the Publisher and the agreement of the transferee to 
be bound by the terms of this Agreement, you may transfer the Program 
(together with any backup copies you have made) and the User Guide on a per-

manent basis. However, you may not retain any copies of either the User Guide 
or the Program.

d Term The Licence granted in this Agreement is effective until terminated. You 
may terminate it at any time by destroying the Program and User Guide, 
together with all copies, or by returning them to the Publisher. If you fail to com-
ply with any term or condition of this Agreement, this Licence will terminate and, 
upon any such termination, you agree to destroy the Program and User Guide, 
together with all copies, or to return them to the Publisher. Termination of this 
Licence shall be in addition to and not in lieu of any other remedies available to 
the Publisher.

e Protection and Security You agree to use your best endeavours and to take all rea-
sonable steps to safeguard the Program to ensure that no unauthorised person 
has access to the Product and that there is no unauthorised copying or distribu-
tion of the Program or User Guide.

2 Limited Warranty & Disclaimer

a The Publisher warrants that the media on which the Program is recorded and the 
User Guide provided with it are free from defects in materials and workmanship 
under normal use for a period of 90 days from the date of your original purchase. 
Except for the limited warranty described above, the Program is sold “as is”, and 
you are assuming the entire risk as to its quality and performance. It is your 
responsibility to verify the results obtained from the use of the Program.

b If during the 90-day limited warranty period, you discover physical defects in the 
User Guide or in the media on which the Program was recorded, the Publisher 
will replace them at no charge to you, provided you return the item to be 
replaced with proof of purchase to the Publisher. THIS IS YOUR SOLE REMEDY. IN 
NO EVENT WILL THE PUBLISHER BE LIABLE TO ANY PERSON FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, 
EVEN IF THE PUBLISHER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

c Some jurisdictions do not allow the exclusion or limitation of implied warranties 
or of liability for incidental or consequential damages, so the above limitations or 
exclusions may not apply to you. This warranty gives you specific legal rights and 
you may also have other rights that vary from state to state. In the event that any 
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of the above limitations or exclusions are held to be unenforceable, the Pub-
lisher’s total liability shall not exceed the amount of the Licence fee you paid.

3 Entire Agreement

This Licence constitutes the entire agreement between the Publisher and the 
Licensee and any prior representations, statement or undertaking how so ever made 

are expressly cancelled. No amendment or modification to this Licence shall be 
valid unless it shall be in writing and signed by an authorised representative of the 
Publisher.
MYOB BusinessBasics v1
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1Thank you for purchasing MYOB BusinessBasics. This program has been specifically designed 
with simplicity in mind, to allow you to keep track of your important financial information. Its 
clean and elegant design allows you to instantly find the functions you need, when you need them. 
The more sophisticated features are all there, discreetly located so you’re not distracted from getting 
your work done.

Everyone will argue which is more important: keeping your customers and clients happy, 
performing your work, or keeping your accounting records up to date. They are all important to keep 
a business up and running smoothly—just some aspects of a successful operation are more pressing 
than others. No matter what, at some point in the business cycle, you will have to count your 
money and you’ll want to do it quickly as possible. The time you save using MYOB BusinessBasics 
will give you more opportunity to handle the special needs of your customers and clients.

If you’re using a computerised accounting system for the first time, you'll find MYOB 
BusinessBasics keeps you informed and in control of your business. If you’ve never worked with 
debits or credits, don’t worry; BusinessBasics handles the double-entry accounting system behind 
the scenes.

Since MYOB BusinessBasics follows all the Windows conventions, your learning curve won't be 
steep. What you know from using other programs will translate easily to MYOB BusinessBasics.

It is important that you have a clear picture about your business and what accounting information 
you want to track. For example, you might start thinking about your main areas of income and 
how your customers pay for your goods and services. Is your business a sole proprietorship, 
partnership or a company? As you read through this user guide, take notes on the MYOB 
BusinessBasics features you think will be useful to your business and incorporate them as you set 
up your own BusinessBasics company file.
 Chapter 1
Getting
Started
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Using this manual and MYOB Help

We at MYOB are committed to making MYOB BusinessBasics a 
product that is easy to use. For that reason we have developed 
comprehensive learning tools that will teach you the fundamentals 
of BusinessBasics, support you as you set up your company’s records 
and back you up in your everyday work with the product. Using 
these tools, you should find the answers to all your routine 
questions about how to use BusinessBasics. If you have any 
questions, we recommend that you explore these tools before you 
call our Technical Support team.

The MYOB BusinessBasics User Guide

The MYOB BusinessBasics User Guide is intended for use with MYOB 
BusinessBasics v1 in Australia and New Zealand.

It is a comprehensive user guide which provides detailed 
information about the features, functions and capabilities of 
BusinessBasics. It is designed to be used as an everyday reference, as 
well as a reference for periodic tasks such as importing and 
exporting data and working with your accountant.

Country specific references

For the most part, the User Guide contains information which is 
valid and correct whether you are living in Australia or New 
Zealand. However, on a few occassions, you may come across 
information which is for one country only. Information related to a 
specific country only, is preceded by the country name in brackets. 

For example, Australian specific information is preceded by 
(Australia). In this incident New Zealand users can simply ignore 
the ensuing information. 

MYOB Help

MYOB Help is BusinessBasics’ comprehensive online help system. It 
can help you with every task you want to perform in BusinessBasics. 

Depending upon your preferences and your access to the Internet, 
you can choose to view MYOB Help either on the World Wide Web 
(at http://help.myob.com.au in Australia, http://help.myob.co.nz 
in New Zealand) or using help files on your computer. If you have 
access to the Internet, you might want to use the Web-based 
version of MYOB Help since it’s updated continually and may 
provide extra information or learning tools that aren’t available in 
your computer-based version. 

If you don’t have access to the Internet or you prefer to keep your 
phone line free for other activities, use the MYOB Help that was 
installed on your computer. 

You can switch between the Web-based version and the version on 
your computer by marking or clearing the I Prefer to Use Help 
From the Internet, Rather Than My Computer preference. (This 
option appears in the Windows view of the Preferences window.)

You can access MYOB Help by choosing MYOB Help from the Help 
menu or by clicking Help from any window in BusinessBasics (see 
‘Using Help buttons’ on page 9). You can also access MYOB Help by 
clicking the  icon in the bottom left corner of a command centre 
window. 

When MYOB Help appears, click the Site Help icon in the contents 
panel. A list of topics appears. Click on a topic and read the 
information to become acquainted with MYOB Help and use it 
more effectively.
Chapter 1 : Getting Started8 MYOB BusinessBasics v1



Using Help buttons 

Help buttons appear in the lower left corner of BusinessBasics windows.

When you click Help, MYOB Help appears in your Web browser, 
displaying information about the window you’re currently viewing. With a 
few clicks, you can learn more about the individual fields and buttons in 
the window, step-by-step instructions for the tasks you can perform in the 
window, and more. 

Other Learning Tools

In addition to the User Guide and the MYOB Help, the following learning 
tools have also been provided. 

! The Getting Started Guide, details how to install and register your MYOB 
BusinessBasics software. 

! A PDF version of the MYOB BusinessBasics User Guide (as well as PDF 
versions of other user documentation) have been included in the 
Manuals folder on your MYOB BusinessBasics CD-ROM. These files are 
also available in the Manuals folder in your MYOB BusinessBasics 
program folder on your hard disk. 

You can read PDF files onscreen using Adobe Acrobat Reader or print 
them using your printer. You can install Adobe Acrobat Reader from the 
MYOB BusinessBasics CD-ROM.
Using this manual and MYOB Help 9User Guide



Starting MYOB BusinessBasics

If you haven’t installed MYOB BusinessBasics yet, refer to your Getting 
Started Guide for installation instructions before you read the rest of this 
section.

To start MYOB BusinessBasics

" Locate and double-click the MYOB BusinessBasics icon on the Windows 
desktop or in the Windows Start menu.

After a few moments, the Welcome to MYOB BusinessBasics window 
appears.

This window appears every time you start BusinessBasics. In this window, 
you are presented with the following options:

# Open your company file—use this option to open your company file 
once it has been created. 

# Create new company file—create a company file for your company. 
See ‘Creating a new company file’ on page 12.

# Explore the sample company—experiment with a sample company’s 
information and learn how to use BusinessBasics. See ‘Sample 
company file’ on page 11.

# What’s new in this version—learn about the exciting capabilities of 
BusinessBasics.

# Exit MYOB BusinessBasics—close BusinessBasics. 
Chapter 1 : Getting Started10 MYOB BusinessBasics v1



Sample company file

Before you create a new company file, we recommend that you 
experiment with sample data. We have provided a sample company file 
Aardvark Advertising to allow you to experiment freely with 
BusinessBasics’ features without accidentally altering any of your own 
company’s financial information. This is an excellent way to learn how to 
use BusinessBasics, to see actual accounting data that has already been 
entered into the BusinessBasics system, and familiarise yourself with the 
way the program works.

To explore the Aardvark company file

" Click Explore the sample company in the Welcome to MYOB 
BusinessBasics window. The command centre window of the sample 
company appears; notice the name of the sample company, Aardvark 
Advertising, appears in the centretop left of the window.

NOTE : Manually locating the sample company file If the sample 
company file has been moved, a dialog appears, requesting you to select 
the sample company file. Locate and open the file named Aardvark.dat.

Now that the Aardvark Advertising company file is open, feel free to 
browse around the BusinessBasics system and explore the accounting 
entries that have already been made for the sample company.

CAUTION : Don’t enter your own financial data Do not enter your own 
company’s financial information into the Aardvark Advertising company file. 
This company file is for learning purposes only.
Starting MYOB BusinessBasics 11User Guide



Creating a new company file

When you enter information in MYOB 
BusinessBasics, that information is stored in a 
single file in your computer called a company file. A 
company file is a lot like a computerised filing 
cabinet, with all sorts of information about your 
company stored in it. As with a normal filing 
cabinet, you are in charge and it’s up to you to record your company’s 
financial information correctly. Unlike a normal filing cabinet though, 
BusinessBasics will efficiently organise the information you store and keep 
you up to date about the state of your business. 

If you want to use BusinessBasics to keep accounting records for more than 
one business, you need to create a separate company file for each 
business. 

As you will find with most tasks in BusinessBasics, creating a company file 
is really simple. The helpful New Company File Assistant will take you step 
by step through the process. 

Getting ready

Before you create a new company file, make sure you know the answers to 
the following questions about your company. If you’re unsure, check with 
your accountant. 

WHAT YEAR IS YOUR CURRENT FINANCIAL YEAR?

A financial year is the twelve-month timeframe used to define your 
accounting year. 

In MYOB BusinessBasics and according to the standard used by most 
accountants, financial years take the name of the calendar year in which 
they end. For example, your financial year might run from October 2002 
to September 2003. Since the end of the financial year falls in 2003, the 
financial year is referred to as “financial year 2003.”

Make sure you choose the correct financial year. If in doubt, check with 
your accountant. 

WHAT IS THE LAST MONTH OF THE FINANCIAL YEAR?

For example, if your financial year runs from October 2002 to September 
2003, your last month would be September. 

WHAT MONTH WILL YOU BE CONVERTING TO USING MYOB 
BUSINESSBASICS?

Your conversion month is the month in which you plan to start using MYOB 
BusinessBasics. This month is particularly important in terms of your 
opening balances that will be entered later when you set up your company 
file.

NOTE : You can select an earlier month as your conversion month If 
you start using BusinessBasics in March but want to enter detailed 
accounting data for January and February, you can select January as your 
conversion month. On the other hand, if you’d rather enter data for January 
and February as historical information, your conversion month can be 
March. 
Chapter 1 : Getting Started12 MYOB BusinessBasics v1



Using the New Company File Assistant

The New Company File Assistant consists of a series of interactive windows 
where you will make entries and selections. When you have finished, a 
company file is created for your business. 

When using the New Company File Assistant, in most instances, you can 
return to previous windows to review (and sometimes change) the entries 
you have made. You can also quit the Assistant while you are in a window 
that has a Cancel button. Remember, if you quit the Assistant before the 
company file is created, you will need to start the Assistant again from the 
beginning. 

Follow the instructions below to create a company file. After you complete 
each window of the New Company File Assistant, remember to click Next 
to move to the next window. 

To create a company file

1 Click Create new company file in the Welcome to MYOB BusinessBasics 
window. The New Company File Assistant appears. 

If you’ve already got a company file open and want to create another 
company file, go to the File menu and choose New. The current company 
file closes before the New Company File Assistant appears.

Click Next.

2 Enter your company’s name, address, phone number, fax number and 
email address. Your company’s name and address can be printed on 
invoices and statements. Click Next.

NOTE : If you want to change this information later You can change 
your company details later and (go to the Setup menu and choose 
Company Information).

3 Enter or choose the following accounting information and click Next:

# Your company’s current financial year. (Remember that this is not 
necessarily the same as the calendar year.) 

# The last month of the financial year. 
# Your conversion month. 

CAUTION : Choose the conversion month carefully When this window 
appears, the conversion month defaults to the current month. If you accept 
this, you won’t be able to enter any transactions made before this month; 
you will need to enter them as historical information. 

4 Confirm the information you entered in Step 3. If you want to make any 
changes click Back. Otherwise click Next. 

5 Specify how you would like to build your list of accounts and click Next. If 
you selected:

# I would like to start with one of the lists provided by MYOB 
BusinessBasics, go to Step 6.

# I would like to import a list of accounts provided by my accountant, 
go to Step 7.

# I would like to build my own accounts list, go to Step 7. 
Creating a new company file 13User Guide



6 Select your Accounts List. To do this, first choose an industry classification. 
Then click the search icon  next to the Type of Business field and select 
one that matches your business. A suitable Accounts List appears.

If you can’t find an exact match, that’s all right; just find something similar. 
For example, if you are a physiotherapist, you can select the Chiropractor 
Accounts List. You will be able to tailor this list to meet the exact needs of 
your business later. Click Next.

7 Check the suggested name and location of your company file. If you want 
to change them, click Change. Enter a new file name and location in the 
dialog box that appears and click Save.

8 Click Next. Your company file is created and the Conclusion window 
appears. Choose one of the following options:

# Setup Assistant. Choose this option if you want to further customise 
your company file. This is the recommended option, especially if you 
need to build an Accounts List. At this point, the new company file 
doesn’t contain much information about your company. Chapter 2, 
‘Setting Up – The First 30 Minutes’, on page 21 explains how to set 
up your company file so it contains all your company’s existing 
business information. This process is made simple by MYOB 
BusinessBasics’s Easy Setup Assistant. 

# Command Centre. Choose this option if you want to begin entering 
transactions right away. The command centre window appears. See 
‘The command centres’ on page 15.

Changing the name of your company file

Follow the instructions below if you want to change the name of your 
company file. (This does not change the company name within your 
company file.)

1 Close MYOB BusinessBasics.

2 Using Windows Explorer, open the folder in which you saved your 
company file.

3 Click once on the company file icon. The name is highlighted.

4 Type the new name and press RETURN. The new name is assigned to the file. 
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Finding your way around MYOB BusinessBasics

MYOB BusinessBasics has been structured so you can access all its 
functions and features easily. The simple yet clear design ensures that you 
don’t get distracted from the task at hand by complicated navigation. All 
of the functions and features can be found either in the command centres 
or in the menu bar at the top of the screen. 

This section describes the MYOB BusinessBasics command centres and 
menu bar in detail. It also contains information about zoom arrows, search 
icons and the calendar—handy tools that speed navigation and transaction 
entry.

The command centres

Think of the command centres as the hub or central location of MYOB 
BusinessBasics, where all the activity takes place. There are three 
command centres—Accounts, Banking and Sales. Whenever 
BusinessBasics is running, a command centre is always displayed on your 
computer screen. 

Each command centre provides shortcuts to related tasks and areas of 
BusinessBasics. For example, from the Banking command centre you can 
conveniently record your cheques and deposits, reconcile your bank 
account, print cheques, and so on. Similarly, from the Sales command 
centre, you can enter sales, receive payments, and print statements and 
invoices. The Accounts command centre keeps the Accounts List at your 
fingertips and lets you record journal entries.

You go to a command centre by clicking one of the icons at the top of the 
command centre window. In the screenshot on the right, the Sales 
command centre is shown. Notice that the Sales icon is highlighted. Tasks 
relating to sales appear in the flowchart on the right.

Each command centre also gives you quick access to the Find 
Transactions and Reports functions.
You can use Find Transactions to do just that—find specific transactions 
you have entered in BusinessBasics. You can then view summary 
information about each of your company’s accounts, cards, invoices and 
jobs. Reports takes you to the Index to Reports, the central location from 
where you can view, print, and customise your BusinessBasics reports.

The icons representing the three command centres. The 
highlighted icon is the current command centre. 

Tasks or functions related to the current command centre are 
displayed here. You can click a task to display the window 
associated  with that task. 

Gives you quick access to the 
Find Transactions window and 
Index to Reports. 
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Menu bar

Access all of BusinessBasics’ functions easily using the menu bar at the top 
of the MYOB BusinessBasics screen.

The menu bar contains some of the standard menus found in most 
programs such as File, Edit and Window and some that are unique to 
BusinessBasics, which are described below.

! The Lists menu gives you quick access to all 
your lists, including your cards list, accounts 
list, items list, tax code list and jobs list. 

! The Command Centres menu 
contains all the functions available 
from the Accounts, Banking and 
Sales command centres and more. 
You can access the Spend Money 
and Receive Money windows 
directly from the Banking sub-
menu and the Receive Payments 
window from the Sales  sub-menu.

! The Setup menu contains functions that can’t be 
accessed from anywhere else in the program and 
that are important for the initial setup of your 
company file. Use the Setup menu to access the 
Easy Setup Assistant, your preferences, your 
Company Information window, and the windows 
in which you will set up your linked accounts and 
enter opening balances for your accounts, jobs and customers. 

! The Reports menu takes you directly to the Index 
to Reports, the central location from where you 
can print, display and customise your reports. 

! The Form menu is a special-purpose menu that only 
appears in the menu bar when you are customising 
forms. It contains menu items that are specific to the 
customisation of MYOB BusinessBasics forms.

! The Help menu not only contains the options found 
in standard help menus but also gives you quick 
access to MYOB Help and contains links to useful websites.
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Calendar

The calendar can be displayed in date fields throughout BusinessBasics and 
is used to select dates. 

Like the search icon, the calendar makes data entry easier. For example, 
you’re entering an invoice and have promised the goods to the customer 
on the last Friday of the month. Rather than figure out the date and enter 
it manually, simply display the calendar in the Promised Date field and 
select the date. 

To display the calendar, place the cursor in a date field and press either + 
(plus), - (minus) or the SPACEBAR on your keyboard. Select a date by clicking 
it or using the arrow keys on your keyboard. Then press TAB or ENTER to 
close the calendar. The selected date appears in the date field. Press ESC to 
close the calendar without selecting a date.

Handy tools in BusinessBasics

This section describes the zoom arrow, search icon and the calendar. These 
tools help you enter information quickly and simplify the ways you access 
windows in BusinessBasics. 

Zoom arrows 

Zoom arrows are unique to MYOB products and appear next to various 
fields throughout BusinessBasics. They are used to view details about a 
transaction or record.

For example, in the first screenshot on the right, zoom arrows appear next 
to each of your invoices in the Sales Register.

When you click a zoom arrow next to an invoice, the Sales window 
appears with details of the invoice—exactly how you entered it in 
BusinessBasics. 

You can go a step further. When you click the zoom arrow next to the 
customer’s name in the Sales window, the customer’s card appears. 

GREY AND WHITE ZOOM ARROWS – WHAT DO THEY MEAN?

Zoom arrows, as you may have noticed, are either white or grey . 
This is determined by the Transactions CAN’T be Changed; They Must 
be Reversed preference setting in your company file (see page 23). If this 
preference is off, zoom arrows are white; if this preference is on, zoom 
arrows are grey.

A white zoom arrow indicates that you can zoom to more detailed 
information about a transaction and make changes to or delete that 
transaction, if you want. 

A grey zoom arrow indicates that you can zoom to more detailed 
information about a transaction but this information is display only. You 
can’t change or delete it; you can only reverse the transaction. 

Use the calendar to enter dates in date fields. 

The current date appears in red; the selected date is displayed in 
blue. You can use the arrow keys next to the month to select a 
different month. 
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Use zoom arrows to view details of a transaction or record.

Search icons 

The search icon is a helpful little tool that makes data entry really easy.

Search icons are unique to MYOB products and appear next to various 
fields throughout MYOB BusinessBasics. They are used to open selection 
lists containing records you previously entered in BusinessBasics. 

For example, clicking the search icon next to the Customer field in the 
Sales window (see screenshot on the right) brings up the customer list, 
where you can select the customer to which you are making the sale. 

So when entering a transaction, rather than type names and numbers 
manually, you may find it much quicker to use the search icon to bring up 

the record you need. Use search icons to open selection lists and retrieve 

records.

 

Use search icons to open selection lists and retrieve 
records. 
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Thornville Park Flowers—a business profile

Sally runs a small home based business in the town of Thornville Park. Her 
business is quite simple, but like all businesses it involves accounting. In 
keeping with her business philosophy, she chooses the easiest way to keep 
track of her money—MYOB BusinessBasics.

Sally has now been in business for about four years. She picks up flowers 
from the wholesale flower markets, arranges the flowers and delivers them 
to corporate clients in the city. Her job is really a combination of florist, 
decorator and delivery person.

Sally’s business is a combination of service and item sales, which usually 
means dealing with inventory. However, given that the nature of flowers 
means they never stay on the shelves for long and as their value is low, 
Sally decided that it’s not important for her to keep accurate 
inventory levels.

On the other hand, Sally wants to know what arrangements she sells and 
to whom. She is able to obtain all the information she needs by creating 
item records in BusinessBasics for the various arrangements; Sally also 
creates an item record for delivery (she charges $15 for local deliveries). 

This fits well with her notions of keeping it simple and allows her to avoid 
the complications associated with high tech sales systems. 

Accounts As Sally spends cash most of the time, she sets up her Accounts 
List in BusinessBasics to include a Cash Withdrawals on Hand account. 
Every time she withdraws money from the bank, she allocates the amount 
to this Cash Withdrawals account in BusinessBasics. 

She has one income account for her main sales called Flower 
Arrangements Income and uses a second Miscellaneous Income account 
for the occasional arrangement she does for a neighbour. She tracks 
income from delivery separately. 

Sally tracks her cost of sales using separate accounts for fresh flowers, 
containers, and decorative items such as ribbons and ornaments etc.

Banking Sally wakes up early every market day and travels to the market 
equipped with her chequebook and cash. She buys what looks good and 
healthy and any flowers that may be needed to complete any special 
orders. All flowers are paid for by cash or cheque. Her main concern from 
a bookkeeping point of view is to ensure she differentiates between what 
has been paid for by cash as opposed to cheque. Her solution is 
simple—the receipts for cash purchases go in her right pocket, while 
receipts for cheque purchases go in her left pocket. When she gets home, 
she files away the receipts she paid by cheque—they’ll be recorded when 
she gets her bank statement. 

At least every two weeks, Sally enters her cash receipts in BusinessBasics. 
This includes her receipts for flower purchases as well as for miscellaneous 
expenses such as postage and gas. She speeds things up by sorting the 
Thornville Park Flowers—a business profile 19User Guide



receipts into separate piles according to their type—for example, one pile 
for flower purchases, another for gas purchases, and so on. She then uses 
BusinessBasics’ Bank Register function to record a transaction against her 
Cash Withdrawals on Hand account which is allocated to the various 
expense accounts (for gas, flowers, etc.). 

As Sally is a sole proprietor without any employees, she can simply assume 
that any cash spent that isn’t backed up by a receipt was a drawing. So, 
every time she withdraws cash from the bank, she allocates the entire 
amount to her Cash Withdrawals on Hand account. She then draws down 
her expenses as explained above and assumes anything left in the Cash 
Withdrawals on Hand account is a drawing. Once a month, she uses 
BusinessBasics’ Bank Register to clear out the Cheque account. She does 
this by writing a cheque against her Cash Withdrawals on Hand account 
and allocates it to her Drawings account.

Sally still has to contend with accounts such as her telephone, power, 
Internet and advertising bills. Any bill she receives is simply filed away in a 
folder. Every few weeks she looks in the folder and pays the bills by cheque 
or credit card. When she has time, the cheques and credit card 
transactions are recorded in BusinessBasics.

Sally uses the Get Statement feature to add transactions from her bank 
statement to BusinessBasics. This also helps her reconcile her cheque 
account once a month. She also reconciles her credit card monthly and 
takes great care to pick up any additional business expenses.

Sales Sales is another matter. Like all businesses, Sally likes to get 
payments from her clients as fast as possible. She has found that some of 
her clients prefer to be given a handwritten invoice with every delivery and 
pay her the next time she visits. Other businesses prefer her to send a 
monthly account and usually pay her within a week or two.

Sally handles her daily invoices by carrying around an invoice book to 
produce invoices on the spot. She also carries around a diary to record 
deliveries that need monthly accounts. When she gets home from her 
deliveries, Sally enters the handwritten invoices into BusinessBasics and 
any payments she has received.

Sally is really happy with the system because it’s simple, fast and accurate. 
She estimates she is at the computer doing her accounts for an average of 
10 minutes a day, which is much less than she used to spend manually 
keeping her books.
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2You’ll be up and running with MYOB BusinessBasics in no time at all. In this chapter we’ll show 
you how to complete the initial setup of BusinessBasics, which includes setting up your preferences, 
accounts and sales. 

BusinessBasics’ preferences let you customise the way the program works. For example, you might 
choose to select accounts by account name rather than number so it’s easier to find them in your 
Accounts List. Or you might prefer to group payments you receive in a temporary account before 
you deposit them in the bank. Have a good look at the preferences because they can save you a lot 
of time later down the track.

In this chapter, you’ll also learn how to set up your accounts for tracking your income and 
expenses. This is the time you should think carefully about what transactions you want 
BusinessBasics to track. For example, if you sell architectural and drafting services, you may want 
separate income accounts for both services. If you run a desktop publishing business, you may 
want to track page layout design income separately from graphic production income such as editing 
photos and creating drawings. Keep it simple—you can always add accounts to BusinessBasics to 
track new income and expenses at any time.

If your clients owe you money and you intend to use BusinessBasics to handle your invoicing, start 
preparing a list of your customers and their outstanding balances. You’ll be entering these details 
here.

As you set up your company file, if you find you don’t have all the information you need, don’t 
worry; just complete what you can. You can always go back and add the rest later. In the 
meantime, you can start using BusinessBasics.
 Chapter 2
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Setting up your company file

Set aside approximately 30 minutes of your time for the initial setup of 
your company file. The initial setup includes the following tasks:

! Step 1 – Set up preferences

! Step 2 – Set up accounts

! Step 3 – Set up sales details

The Easy Setup Assistant will guide you step by step through the process. 

Getting ready

As with any task, it helps to have all the tools and information you need 
close at hand before you begin. So take a few moments to gather these 
details before you start the Easy Setup Assistant. 

! Make a list of your accounts and their balances. (These include your 
cheque and credit card accounts, accounts for tracking income, and for 
tracking expenses such as office rent, utilities and advertising.)

! If your accountant has provided you with an accounts list, or you have 
your accounts list in another program, you can import it into MYOB 
BusinessBasics. (The file may need to be formatted to meet 
BusinessBasics requirements first.) Make sure you have the import file 
ready on your hard drive or in a floppy disk in tab-delimited or comma-
separated format. 

! Make a list of your customers and their contact details. If you want to 
include photographs of your customers in their records, get the 
graphics together in a folder on your hard disk. (BusinessBasics supports 
BMP and a variety of other popular graphic formats.) As with your 
accounts, if you have your customer list in another program, you can 
import it into BusinessBasics. Have the import file ready in tab-delimited 
or comma-separated format.

! Gather a list of all the sales you've made to customers that haven't yet been 
fully paid off. 

! If your business sells goods or services that are taxable, make a list of the 
types of taxes you collect and their tax rates. BusinessBasics provides 
you with the basic tax codes; you can easily add as many tax codes as 
your business needs. 

Start the Easy Setup Assistant

The Easy Setup Assistant will take you through the setup quickly. To start 
the Easy Setup Assistant from the final step of the New Company File 
Assistant, simply click Setup Assistant. Otherwise, go to the Setup menu 
and choose Easy Setup Assistant. The following window appears.
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Step 1—Set up preferences 

Everyone has their own way of doing their daily accounting tasks and 
working with computer programs. In MYOB BusinessBasics, you can set up 
a number of preferences so that the program operates the way that is most 
convenient for you. 

To set preferences

Click Customise in the Easy Setup Assistant window. The 
Customise Easy Setup Assistant appears. Each window contains 
a list of preferences that you can set by marking the checkbox 
next to the preference. Set the preferences you want and click 
Next to move through the windows; click Close when you have 

finished.

You can set the rest of BusinessBasics’s preferences or make changes to 
your initial selection later in the Preferences window (go to the Setup 
menu and choose Preferences).

Some preferences in BusinessBasics

Some of the preferences available in BusinessBasics are described below. 
Preferences listed here that are not available in the Customise Easy Setup 
Assistant can be set in the Preferences window (go to the Setup menu 
and choose Preferences). 

! Use Easy-Fill When Selecting From a List. You can use the Easy-Fill feature 
to quickly enter account names, item names or numbers, and card 
names that you use frequently. Easy-Fill will “recognise” the entry you’re 
making and automatically fill in the rest of the entry for you. 

! Use Expandable Data Entry Fields in Windows. If you enter long 
descriptions of services on invoices, you can view those descriptions in 
their entirety whenever the Description field is active.

! Prompt for Data Backup When Closing. Forget to back up regularly? Set 
this preference and you will be reminded to back up your company file 
when you close it. You can find this preference in the Security view of 
the Preferences window. 

! Transactions CAN’T be Changed; They Must be Reversed. This is an 
important selection. Set this preference if your accountant requires that 
you keep a strict audit trail (that is, a detailed record of all your 
withdrawals, deposits, sales and payments). When this preference is set, 
you won’t be able to make any changes to or remove any transactions 
you have recorded; they are considered unchangeable. Instead, you’ll 
need to reverse a transaction to completely remove the effects of that 
transaction on your records. You can set this preference in the Security 
view of the Preferences window. 

! Select and Display Account Name, Not Account Number. If you find it 
easier to search for accounts by their names rather than by their 
numbers, you can set up BusinessBasics so that you can enter accounts 
and sort your account search lists alphabetically using the name of the 
accounts rather than the numbers. 
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! I Prefer to Use Help From the Internet, Rather Than My Computer. 

If you have access to the Internet, you can view the latest online help for 
MYOB BusinessBasics on the World Wide Web, instead of using help files 
on your computer.

! Select Items by Item Name, Not Item Number. Set this preference if you’d 
like to sort your item search lists alphabetically by items’ names instead 
of by items’ numbers. 

! Warn if Customer has an Outstanding Credit Before Applying a 
Payment. You can set this preference if you’d like to be notified that a 
customer has an existing customer credit whenever you apply one of 
the customer’s payments to a sale.

! Automatically Print (Email/Fax/Save To Disk) Sales When They are 
Recorded. If you want to print (or email, fax or save to disk) quotes and 
invoices immediately after you record them, set this preference in the 
Sales view of the Preferences window. Choose which method you wish 
to use automatically: Print, Fax, Email or Save to Disk. 

! Apply Customer Payments Automatically to Oldest Invoice First. If you’d 
like payments from customers to be applied to the oldest outstanding 
sales first, set this preference in the Sales view of the Preferences 
window.

! Warn Before Recording Post-Dated Transactions. Set this preference if 
you want to be notified whenever you enter a future date as a 
transaction date—for example, if you mistakenly enter a date two 
months from now. You can set this preference in the Security view of 
the Preferences window.

! Prompt for Session Report When Closing. Set this preference if you want 
to be reminded to print your session report when you close your 
company file. This report contains a list of the transactions you’ve 
entered or changed since you opened your company file. You can set 
this preference in the Security view of the Preferences window. 

! Warn for Duplicate Cheque Numbers. Mark this selection if you want an 
alert message to appear each time you attempt to record a cheque 
whose number is already recorded from the cheque account you’re 
using. You can set this preference in the Banking view of the 
Preferences window. 

! Default Cheque is Already Printed. Set this preference in the Banking 
view of the Preferences window if the cheques you write usually aren’t 
printed using BusinessBasics. If this preference is set, the Already 
Printed checkbox in the Spend Money and Settle Returns & Credits 
windows will be automatically marked each time you write a cheque. 
(You can clear the selection, if you want.)

! Display AccountantLink Codes in Edit Accounts. Mark this preference if 
your accountant uses MYOB Accountants Office and you want to 
import a list of accounts or journal entries. For more information see ‘If 
your accountant uses MYOB Accountants Office’ on page 145.

Set up a password

When you begin entering your accounting data and recording 
transactions in BusinessBasics, your company file will contain your 
company’s confidential financial information. One of the ways you can 
limit access to this information is by using a password. To set a password, 
see ‘Setting up a password’ on page 154. 
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Step 2—Set up accounts

Accounts help organise a business by keeping track of the additions and 
subtractions that occur in regular business activity. Since accounts are the 
backbone of your BusinessBasics financial records, it is important that you 
set them up properly. The helpful Easy Setup Assistant will make this 
process as simple as possible for you. Just keep a list of your accounts and 
their opening balances handy. 

Setting up your accounts consists of the following tasks:

! Step 1: Review your Accounts List. (You will be going through the 
Accounts List provided by BusinessBasics and modifying it to suit the 
needs of your business.)

! Step 2: Enter account opening balances.

Start the Accounts Easy Setup Assistant by clicking
Accounts in the Easy Setup Assistant 
window. 

Step 1: Review your Accounts List

Reviewing your Accounts List involves going through the list of accounts 
provided by BusinessBasics and making sure you have all the accounts you 
need to track your business activity. 

To view the Accounts List, click Next in the Easy Setup Assistant. The 
Accounts List appears.

Use the scroll bar on the right to review the list. View an account’s details 
by clicking the zoom arrow next to the account. You may want to enlist 
the help of your accountant or an MYOB Consultant. Since your accounts 
are the foundation for the rest of your accounting records, it’s important 
that they are complete and are capable of meeting your individual 
company’s needs. 

If you chose the Import a list of accounts from accountant option when you 
created your company file, the Accounts List contains only the minimum 
accounts. If your accountant uses MYOB Accountants Office and has 
provided you with a file containing the accounts list, go to the File menu, 
choose AccountantLink, Receive from MYOB Accountants Office and 
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then choose List of Accounts. Locate and open the file—the accounts will 
import automatically. Click Import and see ‘Importing data’ on page 164.

If you chose the Build my own Accounts List option when you created your 
company file, the Accounts List contains only the minimum accounts. To 
create new accounts now, click New and see ‘To create a new account’ on 
page 28.

If you chose one of the Accounts Lists provided by BusinessBasics, you will 
have an extensive list of accounts set up for you already. You may find this 
account list adequate for your business at this time. However, if you need 
to, you can add new accounts to it (see ‘To create a new account’ on 
page 28); change the details of accounts (see ‘To change the details of an 
account’ on page 29) and remove accounts you don’t need (see ‘To delete 
an account’ on page 29).

More about your Accounts List

This section provides you with detailed information about your Accounts 
List. You can read it now or return to it later once you’ve finished your 
initial setup. 

Your Accounts List consists of six types of accounts—Asset, Liability, Equity, 
Income, Cost of Sales and Expense. BusinessBasics uses these accounts to 
track your business activity. The following table should give you an idea of 
what each account type is used for.

Account Type Description

Asset All the things your business owns. Assets include your 
cash, cheque account, inventory, equipment, furniture, 
etc., and any money people owe you.

Liability All the things a business owes. Liabilities include loans, 
mortgages, credit cards and money held by you but owed 
to someone else (GST received, customer deposits).

Equity Your stake in the company (shareholder capital, retained 
earnings, drawings).

Income The money you receive for products and services sold.

Cost of Sales The direct costs of products and/or services sold. (Raw 
materials, manufacturing labour costs, etc., are common 
cost of sales accounts.) 

Expense General expenses incurred in running a business (rent, 
office supplies, legal fees, travel, advertising, etc.).
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WHAT ARE HEADER AND DETAIL ACCOUNTS?

All accounts in your Accounts List are either Header accounts or Detail 
accounts. 

! Header accounts are displayed in bold type in your Accounts List and are 
used only for grouping Detail accounts that have a similar use. They 
serve no accounting purpose and you can’t assign (post) transactions to 
them. 

! Detail accounts appear in plain type in your Accounts List; each Detail 
account is assigned to the Header account that appears directly above 
it. When you enter transactions in BusinessBasics, the transaction 
amounts can be assigned (posted) to Detail accounts; these amounts 
will then be included in the balance of the Detail account.

WHAT ARE ACCOUNT LEVELS?

Account levels are to your Accounts List what headings and subheadings 
are to a page of text. They group and present information logically. You 
can maintain a long list of accounts without cluttering up your financial 
reports by using up to four levels of accounts. 

! Level 1 is the highest level and is reserved by BusinessBasics for the six 
header accounts (asset, liability, equity, income, cost of sales and 
expense). You can change the name of these accounts—for instance, if 
you want to change Assets to “Stuff I Own,” you can). But you can’t 
delete these accounts or move them to another level.

! Level 2 and Level 3 accounts can either be Header accounts or Detail 
accounts. 

! Level 4 accounts are generally Detail accounts.

Notice how BusinessBasics indents two spaces for each level. When you 
create an account, depending on the account number you assign to that 
account, and whether the account is a Header or Detail account, 
BusinessBasics takes its best guess as to which level you want. 

Detail account

Header account

Level 1

Level 4

Level 2
Level 3
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ACCOUNT LEVELS AND BALANCES

As you begin entering transactions in BusinessBasics, you will notice that 
your Accounts List will display the balances of your accounts. Each 
account’s balance will add up to the balance of the Header account above 
it at the previous level. For example, a level 3 Detail account adds up to a 
level 2 Header account, which in turn adds up to a level 1 Header account.

HINT : Use account levels as filters in reports You can use account levels 
as report filters to limit the information displayed in a report to a particular 
level of accounts. See ‘Determining the amount of information included on 
a report’ on page 115.

To change the level of an account If you want to change the level of an 
account in your Accounts List in order to change its hierarchy, you can do 
so from the Accounts List window. For instructions on changing account 
levels, see ‘Changing the level of an account’ on page 94.

A NOTE ABOUT ACCOUNT NAMES AND NUMBERS

You may have noticed that every account in your Accounts List has been 
assigned a unique number consisting of five digits. The first digit, or prefix, 
identifies the account type—asset accounts begin with 1, liability accounts 
with 2, etc.—and the other four digits identify the account within that 
type. When you create a new account, make sure you give it a unique 
number beginning with the appropriate prefix. 

Account names can be anything descriptive and meaningful to you. If you 
want to rename your Liability account to “Money I Owe,” go ahead. 

If you find it easier to recognise your accounts by their names rather than 
by their numbers, you can set up BusinessBasics so that you can enter 
accounts and sort your account search lists alphabetically by account 
name instead of account number. See ‘Step 1—Set up preferences’ on 
page 23.

To create a new account

1 Display the Edit Accounts window. To do this, click New in the Accounts 
Easy Setup Assistant. 

You can also display the Edit Accounts window by choosing Accounts 
from the Lists menu and then clicking New. 

2 Specify the kind of account you are creating. Choose one of the following 
options:

# Header Account [Non-Postable]. Select this option if you are creating 
a Header account under which you want to group several Detail 
accounts. 

# Detail Account [Postable]. Select this option if you intend to assign 
transactions to the account you are creating. 

# Detail Cheque Account [Postable] (available only if you are creating a 
Detail Asset account). Select this option if you intend to assign 
transactions to the account you are creating and want to write 
cheques using the funds in this account—for example, your bank 
cheque account and Petty Cash account. These accounts will be 
displayed in the accounts selection list in transaction windows.
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# Detail Credit Card Account [Postable] (available only if you are 
creating a Detail Liability account). Select this option if you intend to 
assign credit card transactions to the account. Accounts with credit 
card privileges will be displayed in selection lists in transaction 
windows.

HINT : Creating your Accounts List from scratch? If you are, you may 
find it easier to enter all your Header accounts before entering your Detail 
accounts.

3 Enter an account number and account name (See ‘A note about account 
names and numbers’ on page 28). If your accountant uses MYOB 
Accountants Office, you should enter the AccountantLink code to 
streamline the importing of accounts or journal entries. See ‘If your 
accountant uses MYOB Accountants Office’ on page 145.

NOTE : Don’t enter account opening balances yet This is done later in 
your accounts setup.

4 Click OK when you have finished. The account you created will now 
appear in your Accounts List. 

To change the details of an account

If you want to edit an account while reviewing your Accounts List in the 
Accounts Easy Setup Assistant, select the account and click Edit. You can 
then make the necessary changes in the Edit Accounts window. Also see 
‘Changing a record’ on page 93 for more information on changing an 
account. 

To delete an account

If you want to delete an account while reviewing your Accounts List in the 
Accounts Easy Setup Assistant, highlight the account and click Delete. Also 
see ‘Deleting a record’ on page 95 for more information on deleting an 
account. 

Step 2: Enter your account opening balances

Unless you’re just starting a new business, most of your accounts probably 
already have balances—for example, you’ve made sales, paid bills, 
deposited money into your business’ cheque account and conducted a 
variety of other business activities that affect your accounts’ balances. In 
this step, you’ll enter those balances in BusinessBasics.

To properly assign opening balances to accounts, you need to enter the 
balance of each of your accounts as of the first day of your conversion 
month—the month you began using BusinessBasics to track your business. 

Something important to keep in mind:

! If your conversion month is the first month of your financial year (for 
example, if your financial year runs from July to June and your 
conversion month is July), you can only enter the opening balances of 
your asset, liability and equity accounts. (The opening balances of all 
your income, cost of sales and expense accounts should remain zero.)

! If your conversion month is not the first month of your financial year (for 
example, if your financial year runs from July to June and your 
conversion month is August), enter the opening balances of all your 
accounts.
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To enter opening balances

1 Display the Opening Balances window of the Accounts Easy Setup 
Assistant.

2 Enter the opening balance for each account in the Opening Balance 
column. 

Don’t forget to enter the total of your unpaid invoices (if any) in the 
Accounts Receivable account. You will be entering each of these invoices 
separately when setting up your sales later. 

NOTE : Enter opening balances as positive numbers Don’t, for example, 
enter your liability accounts’ balances as negative numbers. BusinessBasics 
knows whether your accounts usually have positive or negative balances. 
Enter negative amounts only if accounts truly have negative balances (for 
example, your cheque account is overdrawn).

3 Check the Amount left to be allocated field at the bottom of the window. 

# If this field displays $0.00, the value of your asset accounts equals the 
value of your liability and equity accounts. This indicates that your 
opening balances are correct. 

# If this field displays an amount other than $0.00, check your opening 
balances again. This value indicates that either your opening balances 
are incomplete or incorrect. The amount that appears in the Amount 
left to be allocated field will be assigned to a special equity account 
called Historical Balancing if you choose not to correct the amount. 

4 Once you have entered your account ‘s opening balances, click Next and 
then close the Accounts Easy Setup Assistant.

Congratulations! You have completed setting up your accounts. If you 
want to make changes to or delete any accounts later, you can do so from 
the Accounts command centre. See ‘Working With Lists’ on page 91.

To continue setting up your company file, see “Step 3—Set up sales 
details” on page 31.
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Step 3—Set up sales details

Most businesses rely upon sales of goods or services to generate revenue 
for them. In the Sales Easy Setup Assistant, you can set up information 
related to sales, such as customer details, credit terms you offer and tax 
codes you use.

Before you begin using the Sales Easy Setup Assistant, remember to gather 
a list of your customers and their contact details as well as a list of sales 
you’ve made that haven’t been fully paid off. 

Setting up your sales details consists of the following steps:

! Step 1: Set up a default layout

! Step 2: Set up selling details

! Step 3: Assign a default tax code

! Step 4: Select a default payment method and credit terms

! Step 5: Set up linked accounts for sales

! Step 6: Set up your customer list

! Step 7: Enter your historical sales

Click Sales in the Easy Setup Assistant window. Work your 
way through the Sales Easy Setup Assistant by making 
selections in each window and clicking Next to move to the 
next window; click Close when you have finished. 

Step 1: Set up a default layout

BusinessBasics has four layouts or views of the Sales window: Service, 
Item, Professional and Miscellaneous. Choose the sale layout that you 
expect to use most often. For example, if your business sells predominantly 
services, select the Service layout. When you enter a sale, the Sales 
window will display this layout automatically, saving you from having to 
select a layout each time. You can override your default selection for 
individual customers in their customer record (discussed later in the setup) 
or at the point of sale. 

If you don’t want a default layout, select the No Default option. Click 
Next.

Step 2: Set up selling details

Use this window to set up default entries that will make creating new 
customer records quicker (later in the setup). Remember that you can 
change these selections for any of your customers at any time. 

Choose the income account you use for most of your sales. For example, 
for a law firm, this may be the Consultation account. If you use several 
income accounts, don’t choose an account here. 

Enter the credit limit you offer the majority of your customers. 

When you have finished, click Next.

Step 3: Assign a default tax code

If you collect GST on sales, you need to create tax codes for the various 
taxes you collect. See ‘Creating tax codes’ on page 32 for instructions. 
(Just create the tax codes that your business uses most often. You can 
always set up any miscellaneous tax codes you might need later.) 

Once you’ve created the tax codes, select the tax code that you use most 
often for your customers in this step. 

If you charge freight, specify whether freight charges are taxable for most 
of your customers. Your selections here will appear as the default in the 
Selling Details view of new customer cards you create. When you have 
finished, click Next.
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Creating tax codes

To help you keep track of the GST and other taxes, BusinessBasics uses tax 
codes. Each tax code represents a particular tax rate, which is used to 
calculate tax on your sales.

Whenever you enter a sale that should be taxed, you can choose a tax 
code from the Tax Code selection list; the amount of the item or service 
will be multiplied by the tax code’s tax rate. 

HINT : You can assign tax codes to customers and items in their cards. 
These tax codes will appear by default in invoices that you create, saving 
you the trouble of selecting a tax code each time. 

To create a tax code

1 Display the Tax Code List. To do this:

# click the search icon  beside the Tax Code field in the Sales Easy 
Setup Assistant, or 

# go to the Lists menu and choose Tax Codes. 

2 Click New. The Tax Code Information window appears. 

3 Enter up to 3 characters and the description for the tax code.

4 Select Goods & Services Tax or another appropriate tax type from the Tax 
Type list. 

5 Enter the tax rate.

6 Enter the account you want to use for tax collected; this is usually a liability 
account.

7 Enter the account you want to use for tax paid; this is usually an asset 
account

8 Click OK when you have finished.

Changing a tax code If you want to make changes to a tax code you’ve 
created, see ‘Changing a record’ on page 93.

Deleting a tax code If you want to delete a tax code, see ‘Deleting a 
record’ on page 95.

Step 4: Select a default payment method and 
credit terms 

Select how most of your customers pay you: cash, cheque, MasterCard, 
VISA, etc. (If you want to add a payment method to the list, see 
‘Customising sales information lists’ on page 102.)

Indicate the credit terms you generally extend to your customers.

BusinessBasics will use your selections here as the default when you create 
new customer records later in the setup, but you can change these terms 
any time. 

When you have finished, click Next.

Step 5: Set up linked accounts for sales

When you receive payment from customers, you can opt to either deposit 
it directly to an account (say, your cheque account) or hold it temporarily 
in an undeposited funds account until you are ready to make a bank 
deposit. 

BusinessBasics has selected the default undeposited funds account and 
customer receipts account here. If you want to change these selections, 
click the search icon beside the field and select an alternate account. 

If you want, you can change the accounts selected here later in the Sales 
Linked Accounts window (go to the Setup menu, choose Linked 
Accounts and then Sales Accounts). 

When you have finished, click Next.
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Step 6: Set up your customer list

Your customer list is made up of cards, which are simply records containing 
information about your customers. BusinessBasics requires that you create 
a record for each customer, but you can choose to enter as little or as much 
information as you like in these records. To create a customer card, click 
New and see ‘To create a customer card’ below.

Importing your customer list If you have an existing list of customer 
records in another program, you can import it into BusinessBasics. Click 
Import and see ‘Importing data’ on page 164. 

When you have finished setting up your cards list, click Next to enter your 
historical sales. See page 35.

Making changes to a customer card If you are in the Sales Easy Setup 
Assistant, simply highlight the card in the list and click Edit. Otherwise, see 
‘Changing a record’ on page 93.

Deleting a customer card If you are in the Sales Easy Setup Assistant, 
simply highlight the card in the list and click Delete. Otherwise, see 
‘Deleting a record’ on page 95. 

To create a customer card

Follow the steps below to create a customer card.

1 Display the Card Information window. To do this, either:

# click New in the Build your customer list window if you are in the 
Sales Easy Setup Assistant, or 

# go to the Lists menu and choose Cards. Then click New. 

2 Enter the customer’s contact details.

a Click the Profile tab. 

b Make sure the Card Type is set to Customer.

c Select whether the customer is a company or individual from the Desig-
nation drop-down list.

d Enter the customer’s name and a Card ID. The Card ID is optional but 
useful if you plan to search for cards by ID (see ‘Card IDs’ on page 41). 

e Enter the customer’s address, phone numbers and other contact details. 

If the customer has more than one address, for example a different 
shipping address, click the Location down arrow, select Address 2, and 
enter the details of the second address and other contact details. You 
can enter up to five different addresses and contact details for a 
customer.

3 Enter additional details.

a Click the Card Details tab. 

b If you want to add a picture of the customer, see ‘Adding a picture to a 
record’ on page 98. 

c If you want to record additional information about the customer, such 
as the customer’s birthday, use the custom fields and lists available. See 
‘Creating custom lists and fields’ on page 99 for more information. 
Step 3—Set up sales details 33User Guide



4 Enter selling details.

$ Click the Selling Details tab and complete the fields using the following 
table as a guide. 

5 Enter payment details.

a Click the Payment Details tab. 

b Enter the payment method that the customer uses most often to pay 
you and the payment details. For example, if you selected VISA as the 
payment method, you can enter the customer’s credit card number, 
expiration date, etc. This saves you from having to enter these details at 
the point of sale. 

6 Enter the customer’s sales history (optional). 

a Click the History tab. 

b Enter monthly sales figures for the customer. Sales history 
information can be entered for up to five previous years, 
the current year and the next year. 

7 Click OK when you have finished. The card you created will now appear in 
the customer list.

8 Repeat Step 1– Step 7 for each customer card you want to create. 

HINT : “Easy-Add” customer cards To find out how you can add a new 
customer card while making a sale, see ‘How to “Easy-Add” a card’ on 
page 42.

Useful reports

CARDS LIST SUMMARY AND DETAIL REPORTS

Keep customer details at your fingertips with these reports. 

ADDRESSES REPORT

Need a quick list of your customers’ addresses and phone numbers? The 
Addresses report can be filtered to list the contact details of all your 
customers or just the ones living in a particular area—ideal for marketing 
purposes. 

For more information about filtering and printing reports, see ‘Using 
Reports’ on page 113. 

A Selling information Select the default sale layout, printed form, income 
account, sale comment and shipping method you 
are most likely to use for this customer. Some of 
these fields will display the selections you made 
earlier in the setup for all your customers. You can 
override these selections here or when recording 
the sale. 

B Tax information Enter the details as relevant. The default tax code 
and freight tax you selected for all customers 
(earlier in the setup) appear here. You can override 
them here for this customer or when recording the 
sale. 

C Credit terms The credit terms you entered earlier for all 
customers appear here by default. You can 
override them here for this customer or when 
recording the sale.

B

A

C
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Step 7: Enter your historical sales

In BusinessBasics, historical sales are sales you’ve made that haven’t been 
paid in full as of the first day of your conversion month (that is, the month 
you first started using BusinessBasics).

Keep your list of unpaid invoices handy. You will be entering them now in 
BusinessBasics.

Notice that the Total Linked Receivables Account Balance field in the 
Sales Easy Setup Assistant shows the amount you entered against your 
receivables account when you entered your opening balances earlier. 

1 Click Add Sale in the Sales Easy Setup Assistant. The Historical Sale 
window appears. 

2 Enter the customer’s name, invoice number, date and customer purchase 
order number. 

3 Enter the total amount of the sale and the tax code used.

4 Click Record. 

5 Repeat Step 1 – Step 4 for each historical sale. 

6 When you have finished entering your historical sales, the amount in the 
Out of Balance Amount field in the Sales Easy Setup Assistant window 
should be zero. 

7 Click Next in the Sales Easy Setup Assistant. Then click Close.
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3You’re now up and running with MYOB BusinessBasics, but there is a lot more you can get 
BusinessBasics to do for you. This chapter shows you how to set up items to speed up invoicing, 
create additional cards, set up budgets, set up jobs and prepare your bank account for 
reconciliation.

In this chapter, you will set up records of items you sell. An item can be something physical or it can 
be time. For example, a retail business can set up an items list of goods they sell while a graphics 
business could create an item to keep track of hours spent on a design for a client. BusinessBasics 
could then report how many hours were sold and to whom.

As well as dealing with items, this chapter looks at how you can set up budgets for your business. 
A good way to create a budget is to use last year’s profit and loss statement as a start. Some 
businesses attempt to create budgets as a forecast—as close as possible to what will happen. Others 
use budgets as a set of goals, something to strive for, while some businesses mix the two.

This chapter also shows you how to create jobs to keep track of projects you undertake for clients, 
and to set up your bank account in BusinessBasics so that your account balance matches your 
bank’s records. 

As with your initial setup, don’t worry if you don’t have all these details. Just complete what you 
can, as you can always go back and set up the rest later.
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Creating item records

If your business sells items (goods), you can maintain a detailed record for 
each item in MYOB BusinessBasics.

In BusinessBasics, an item is defined as: 

! a physical unit that your company sells—for example, books, party hats, 
computers, concert tickets. 

! A service provided by your company that you want to include on an 
item invoice (see page 72) such as ‘shipping,’ ‘handling,’ and ‘labour’. 
Such an item is often referred to as a service item. For example, an auto 
repair shop can charge a customer for a car battery (item) and the 
labour to install it (service item) in one invoice. 

Before you can record the sale of an item in BusinessBasics, a record of it 
must exist in your company file. An item record contains details of the item 
such as a description, selling price, picture and so on. As with most tasks in 
BusinessBasics, creating an item record is simple and should take just a few 
minutes of your time. 

Naming and numbering items

Items are identified by a unique item number and name, which can be a 
combination of numerals, letters and symbols. How you name and 
number your items will determine how easy it is to search for an item in 
your Items List, and how clear and organised your reports are.

Spend some time thinking about how you want to organise your Items 
List—if you have an extensive list, you may want to use a numbering or 
naming system that allows you to categorise your items within that list. For 
example, a bookstore that categorises its books into Fiction and Non 
Fiction and subcategorises them by the author’s last name, could number 
a non fiction book by John Doe as NF-DoeJ01, and a fiction book by Jane 
Austen as 
F-AustenJ12.

Their Items List may look something like this:

While selecting items by item number can be useful if you use a barcode 
scanner, you may find it more convenient to select items by their names 
instead. If this is the case, mark the Select Items by Item Name, Not Item 
Number preference in the Windows view of the Preferences window (go 
to the Setup menu, choose Preferences and click the Windows tab). Your 
items will appear in search lists and be sorted in reports by name rather 
than number. 

Using wildcards to filter reports Using item numbers or names to group 
items in lists is useful when it comes to generating reports. For instance, if 
the bookstore wanted to view their sales figures for only non fiction books, 
they could filter the Sales [Item Detail] report using the wildcard NF*. 

USING THE BACKSLASH CHARACTER IN ITEM NUMBERS

The backslash character (\) serves a special purpose in BusinessBasics. Any 
item number that begins with a backslash can be included on sales 
invoices, but they won't appear on printed forms. So if you want to create 
item records for services such as labour and maintenance but don’t want 
their item numbers appearing on forms, start the item number with a 
backslash, for example \labour.
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Getting ready

Make a list of the items you sell and their selling price. Also make a note of 
the items that are subject to GST. If you intend to include a picture of each 
item in the record, make sure you get together all the graphic files you 
need in one folder. (BusinessBasics supports BMP and a variety of other 
popular graphic formats.) Next to each item on the list, write down the 
unique number and name that you want to assign it. See ‘Naming and 
numbering items’ on page 38.

If you want to record additional information about items, such as an item’s 
colour, size or brand, BusinessBasics provides several custom lists and fields 
for this purpose. See ‘Creating custom lists and fields’ on page 99 for more 
information.

If you have a list of your item records in another program, you can export 
it from that program as a text file and import it into BusinessBasics. For 
more information about importing item records, see ‘Importing data’ on 
page 164.

To create an item record

1 Go to the Lists menu and choose Items. The Items List appears. 

2 Click New. The Item Information window appears. 

3 Enter details of the item. 

a Enter an item number and name.

b Specify the income account you want to use to track sales from this 
item. Click the search icon  to select an account from the list. 

c Enter the amount you sell this item for in the Unit Price field. 

d Enter how you sell this item (for example, case, box, hour) in the Selling 
Unit of Measure field. 

4 Click the Item Details tab. 

a If you want to link a picture, see ‘Adding a picture to a record’ on 
page 98.

b If you want to record additional information about the item, use the 
custom lists and fields provided. For more information, see ‘Creating 
custom lists and fields’ on page 99.

5 If you want to enter an item’s sales history, click the History tab. See 
‘Recording an item’s sales history’ on page 40. 

6 Click OK.

HINT : Creating another item record immediately? Save time by 
clicking New (instead of OK) in the Item Information window. This adds 
your current record to the Items List and clears the window for your next 
record. 
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RECORDING AN ITEM’S SALES HISTORY

You can use the History view of the Item Information window to record 
an item’s sales history for up to five years before you began using 
BusinessBasics. 

You can enter an item’s history up to the current month of the current 
financial year. Sales made in subsequent months are tracked automatically 
by BusinessBasics. 

1 Click the zoom arrows at the top right corner of the History tab to display 
the financial year for which you want to enter item history. 

2 For each month, enter the number of units sold in the Sold column and 
the total sale amount in the Sales column. 

3 Click OK.

Changing the details of an item record You can update your item details 
by displaying the item record and typing in the changes. Some rules apply. 
For more information, see ‘Changing a record’ on page 93. 

Inactivating an item record Inactivating or ‘hiding’ item records you use 
infrequently is a great way of keeping your Items List short, up to date and 
manageable. For more information, see ‘Inactivating a record’ on page 97. 

Deleting an item record You can delete an item record you no longer 
need. Some rules apply. For more information, see ‘Deleting a record’ on 
page 95. 

Useful reports

ITEM SALES SUMMARY AND DETAIL REPORTS

Before you re-order your items, find out what’s selling and what’s not by 
printing these reports. 

ITEMS PRICE SUMMARY REPORT

This report lists your item prices—useful for sending to your customers. 
You could also convert this report to HTML and post your price list on your 
website. 

ITEMS LIST SUMMARY REPORT

View details of all or selected items in your Items List using this report. 
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Creating supplier, employee and personal cards

In addition to the customer cards you created in the initial setup, you can 
also create cards for your suppliers, employees and personal contacts. 

! Supplier cards—set up records for the people you write cheques to 
regularly such as your Internet Service Provider, real estate agent, 
advertising agency and cleaning service, and select these cards when 
you write a cheque. 

! Employee cards*—keep your employees’ contact details in one place. 
You can use the custom lists and fields that BusinessBasics provides to 
record an employee’s review date, auto licence number and other useful 
information. 

! Personal contact cards—ideal for keeping the contact details of your 
business associates, relatives and friends, personal contact cards are easy 
to create and update. You can use the custom lists and fields to record 
additional information such as birthdays and hobbies. 

Card IDs

Can’t recall people’s names easily? Prefer to use your own system for 
retrieving cards from your cards list? BusinessBasics gives you the option of 
assigning ID’s to your cards. Card ID’s can be up to 15 alphanumeric 
characters. To let BusinessBasics know that you prefer to use Card ID’s 
instead, mark the Select Cards by Card ID, Not Card Name preference in 
the Windows view of the Preferences window (go to the Setup menu, 
choose Preferences and then click the Windows tab). 

Getting Ready 

Before you start creating cards, gather a list of your personal contacts, 
suppliers and employees and their contact information. 

To create a supplier, employee or personal card

1 Go to the Lists menu and choose Cards. The Cards List appears. 

2 Click New. The Card Information window appears. 

3 Enter the details of the supplier, employee or personal contact.

a Click the Profile tab. 

b Select the appropriate card type: Supplier, Employee or Personal.

c Select whether the contact is a company or individual from the Desig-
nation drop-down list.

d Enter the contact’s name and a Card ID (optional). 

e Enter the address, phone numbers and other contact details. 

If the person or company has more than one address—for example, a

P. O. Box and a street address—click the Location down arrow, select 
Address 2, and enter the details of the second address. You can enter up 
to five different addresses and contact details.

4 Click the Card Details tab. 
* For fully integrated Payroll, consider upgrading to MYOB Accounting, Accounting Plus 
or Premier.
Creating supplier, employee and personal cards 41User Guide



a If you want to add a picture of the person, see ‘Adding a picture to a 
record’ on page 98. 

b If you want to record additional information about the supplier, 
employee or personal contact, use the custom fields and lists available. 
See ‘Creating custom lists and fields’ on page 99 for more information. 

5 For customers cards, click the Payment Details tab. 

6 Click OK. The card you created now appears in your Cards List in the 
appropriate view. 

How to “Easy-Add” a card 

You can create a new card quickly while entering a transaction by using 
the Easy-Add function. 

1 Simply type the name of the card you want to add in the transaction 
window. For example, if you are entering a sale, enter the customer’s name 
in the Customer field and click the search icon . The Select From List 
window appears. 

2 Click Easy-Add. The card is added to your Cards List. 

3 Whenever, you have time, go to the Card Information window and enter 
the rest of the card details. 

Easy-Add is not available in some transaction windows such as Spend 
Money, where BusinessBasics has no way of knowing the type of card 
(supplier, employee, etc.) that you want to create. 

Useful reports

CARD LIST SUMMARY AND DETAIL REPORTS

Keep details of your suppliers, employees and personal contacts at your 
fingertips with these reports. 

ADDRESSES REPORT

Ready to mail your holiday cards and need the addresses of your friends 
and relatives? The Addresses report can be filtered to only list the addresses 
of your personal contacts. 
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Setting up account budgets 

You can track your business’s financial progress by using a monthly budget 
for each of your Detail accounts, including your cheque and credit card 
accounts. 

Setting budgets for individual accounts is also a good way of keeping an 
eye on your expenses. For example, if you spent too much on advertising 
in the past, you can set a stricter budget for your advertising expense 
account and attempt to stay within it. 

You can also set up budget shortcuts for an account so each month 
incorporates a regular increase in budget amounts. BusinessBasics begins 
with the budgeted amount for the first month of your financial year and 
increases it by the amount or percentage you specify for each consecutive 
month. This is a good way of setting a target for your income accounts and 
increasing the goal each month. For example, you can target to make a 
specific dollar amount from retail sales this month and attempt to increase 
this amount by 5% next month. 

Getting ready

Make a note of your budget for your income and expense accounts. You 
could use last year’s profit and loss as the starting point to work out your 
budgets. 

To set budgets for an account

1 Go to the Accounts command centre and click Accounts List. Your 
Accounts List appears. 

2 Click the zoom arrow next to the account for which you want to set 
budgets. The Edit Accounts window appears with details of the account. 

3 Click Budgets. The History and Budgets window appears. This window 
shows you the account’s monthly activity for this year and last year. These 
figures are for your information only and can’t be edited.

4 Choose how you want to enter budgets for your account. If you want to:

# manually enter each month’s budgeted amount in the Budget 
column, go to Step 5.

# use budget shortcuts to make an automatic monthly increase in the 
account’s budgets, see ‘To use Budget Shortcuts to enter an account’s 
budget’ on page 44.

5 Enter the amount of expected activity for the account in the Budget 
column. You should enter the expected activity for the account, and not 
the expected balance of the account at the end of each month. 

For example, if you want to restrict your phone expense budget to $400 
for March, enter $400 in the Budget column for March. If you want to 
reduce your VISA account debt by $250 in May, enter -250 in the Budget 
column for the VISA liability account. 

6 Click OK when you’re satisfied with your entries in the History and 
Budgets window. 
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To use Budget Shortcuts to enter an account’s budget

1 Click Shortcuts in the History and Budgets window. The Budget 
Shortcuts window appears. 

2 Enter the amount and frequency. 

3 Enter a monthly dollar increase or monthly percentage increase. 

4 When you’ve finished making entries in the Budget Shortcuts window, 
click OK. The History and Budgets window appears again with the 
monthly budgets that were calculated in the Budgets column. 

5 Click OK in the History and Budgets window.

Useful reports

BALANCE SHEET [MULTI-PERIOD BUDGET SPREADSHEET] REPORT 

Use this report to view the monthly budgeted amounts for your balance 
sheet accounts (that is, your asset, liability and equity accounts). 

PROFIT & LOSS [MULTI-PERIOD BUDGET SPREADSHEET] REPORT

Use this report to view the monthly budgeted amounts for your profit and 
loss accounts (that is, your income, expense and cost of sales accounts). 
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Entering account historical balances

If you want to generate Balance Sheet and Profit and Loss reports for each 
month before your conversion month, you need to enter account historical 
balances for these months. Historical balances reflect the activity in your 
accounts before you started using MYOB BusinessBasics. 

If you want to, you can also enter historical balances and activity for your 
previous financial year so your reports include the past year’s figures as 
well. This is useful if you want to compare your company’s performance 
this year with last year’s. 

Rest assured that the historical balances you enter are used only for 
reporting purposes; they won’t affect your current account balances.

Before you enter your historical balances, make sure you have entered your 
account opening balances. For more information, see ‘Enter your account 
opening balances’ on page 29. 

To enter historical balances for your accounts 

1 Go to the Accounts command centre and click Accounts List. Your 
Accounts List appears. 

2 Click History. The Account Historical Balances window appears. 

3 Click the Balance Sheet radio button. All your balance sheet accounts 
(that is, your asset, liability and equity accounts) appear in the list. 

4 Using the arrows next to the Month Ending field, select the month for 
which you want to enter historical balances. (The selected month should 
be prior to your conversion month.)

NOTE : Month immediately prior to conversion month You can’t enter 
balances for the month immediately prior to your conversion month 
because they are entered as opening balances. 

5 Enter the closing balance for each of your balance sheet accounts. 

6 If you want to enter historical balances for another month, repeat Step 4 – 
Step 5.

7 Click P&L. All your profit and loss accounts (that is, your income, expense 
and cost of sales accounts) appear in the list. 

8 Using the arrows next to the Month Ending field, select a month (prior to 
your conversion month) for which you want to enter account activity. 

9 Enter the account activity for each of your profit and loss accounts. 

10 To enter account activity for another month, repeat Step 8 – Step 9.

11 Click OK when you have finished.
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Setting up jobs

Businesses that undertake projects which span a period of time will find 
MYOB BusinessBasics’ Jobs function useful for keeping track of their 
income and expenses relating to particular projects. 

Getting Ready

Jot down a list of the jobs that you want to set up in BusinessBasics and the 
current balances of these jobs. 

To create a job

1 Go to the Lists menu and choose Jobs. The Jobs List window appears. 

2 Click New. The Job Information window appears. 

3 Enter a job number, name and a short description. 

4 Enter the customer for whom you have undertaken this job. Click the 
search icon  if you want to view the customer list.

5 Click OK. The job you created appears in the Jobs List window. 

The Jobs List window also tells you at a glance the net profit (or loss) for a 
job and gives you a breakdown of the income and expense incurred. 

Inactivating a job You can inactivate jobs you don’t use frequently to 
keep your jobs list short and up to date. For more information, see 
‘Inactivating a record’ on page 97. 

Changing a job You can edit the details of a job after you have created it. 
For more information, see ‘Changing a record’ on page 93. 

Deleting a job You can delete a job you don’t need. See ‘Deleting a 
record’ on page 95.
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Entering job opening balances

If you’ve been working on a job for some time before you created a record 
for it in BusinessBasics, you can quickly update your job record by entering 
all the activity that has occurred for the job on an account by account 
basis. 

To enter opening balances for a job

1 Go to the Setup menu, choose Balances and then Job Opening Balances. 
The Job Opening Balances window appears. 

2 Enter the job number. The scrolling list displays all of your company’s 
income, expense and cost of sales accounts.

3 Enter any opening balances that apply to the job in the Opening Balances 
column. For example, if you’ve spent $54 on photocopies for the job so 
far, enter 54 against the account that tracks photocopy expenses. 

4 Click OK when you have finished entering the opening balances for this 
job. 

Assigning a transaction to a job

Regardless of whether you’re tracking job expenses for customer 
reimbursement or you’re simply curious about how much revenue you’re 
receiving from your jobs, you need to be sure you’re properly assigning 
transaction activity to your jobs. 

You assign a transaction to a job by entering the job number in the Job 
column of the transaction window. The Job column can be found in the 
Sales, Spend Money, Receive Money and Record Journal Entry 
windows. 

HINT : You can charge for separate jobs on the same invoice Each line 
item on an invoice can be assigned a different job number. So, if you’re 
working on two jobs for a customer, you can charge the customer for the 
separate jobs on the same invoice. 

The Jobs List window displays the revenue from the job so far. The amount 
in the Net Profit column is the income less the expense.

Useful reports

JOB TRANSACTIONS REPORT

Print this report to view all transactions assigned to a job. 

JOB PROFIT & LOSS REPORT

Use this report to determine whether a job is profitable or not. 

JOBS ACTIVITY SUMMARY AND DETAIL REPORTS

Use these reports to view transactions assigned to a job for a specified 
period and account.
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Setting up your bank accounts for reconciliation

To ensure the accuracy of your business data, you should keep the record 
of your bank account balances in MYOB BusinessBasics matched up with 
your bank’s records. This task is called reconciling accounts. 

Before you reconcile your accounts in BusinessBasics (see page 67), it is 
important that you prepare for it by setting up your bank accounts.

As of your conversion date (the date you first started using BusinessBasics), 
it is most likely that you have uncleared cheques and deposits that have 
not appeared on any bank statements.

You will need to manually enter these cheques and deposits in 
BusinessBasics; they will then appear in the Reconcile Accounts window, 
ready to be marked off as they appear on subsequent bank statements. 

Preparing your bank account includes the following steps:

! Step 1—Check the opening balance of the cheque account you want to 
reconcile. 

! Step 2—Enter any uncleared cheques.

! Step 3—Enter any uncleared deposits.

! Step 4—Perform a mock reconciliation of the account.

Getting Ready

Keep your most recent bank statement handy. Make a list of your 
uncleared cheques and uncleared deposits as of your conversion date.

Step 1: Check the opening balance of your cheque 
account

1 Go to the Setup menu, choose Balances, and then Account Opening 
Balances. The opening balances you entered for your accounts appear. 

2 Make sure your cheque account in BusinessBasics shows the correct 
chequebook balance. The amount should be the statement balance less 
uncleared cheques plus any uncleared deposits as at your conversion 
month. 

For example, if the bank statement balance shows $23,500 for your 
cheque account and you have $530 in uncleared cheques and $120 in 
uncleared deposits, your cheque account balance in BusinessBasics should 
show 23,500 – (530 –120) = 23,090. 

CAUTION : DON’T enter your statement balance in this window.
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Step 2: Enter any uncleared cheques

1 Go to the Command Centres menu, choose Banking and then Spend 
Money. The Spend Money window appears. 

2 Enter the cheque account you want to use in the Account field at the top 
of the window. 

3 Enter each uncleared cheque dated as at the first of your conversion 
month. (For example, if your conversion month was November, 
enter 30/9/02.)

The ‘allocation account’ in this instance must be the same as the cheque 
account selected in the Account field in Step 2. This ensures that the 
opening balance you entered for the cheque account remains the same.

4 Click Record.

Step 3: Enter any uncleared deposits

1 Go to the Command Centres menu, choose Banking and then Receive 
Money. The Receive Money window appears. 

2 Click the Deposit to Account radio button and enter the cheque account 
you want to use in the adjacent field. 

3 Enter the uncleared deposit dated as of the first of your conversion month. 
(For example, if your conversion month was November, enter 30/9/02.)

The ‘allocation account’ in this instance must be the same as the cheque 
account selected in Step 2. This ensures that the opening balance you 
entered for the cheque account remains the same.

4 Click Record.
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Step 4: Perform a mock bank reconciliation

In this step, you are not performing an actual bank reconciliation but 
merely completing the setup of your bank account.

1 Go to the Banking command centre and click Reconcile Accounts. The 
Reconcile Accounts window appears. 

2 Enter the account number of your cheque account (for example, 1-1110) 
in the Account field. 

3 Enter the bank statement date as of the first day of your conversion month 
(for example, 1/11/02). 

4 Enter the closing balance from the bank statement (the last statement 
before conversion month) in the New Statement Balance field. 

5 Mark the Deposits side of every uncleared cheque by clicking the X 
column on the left.

6 Mark the Withdrawals side of every deposit by clicking the X column on 
the left.

7 Click Reconcile. Your account should now reconcile. 

8 Click Reconcile again to complete the reconciliation process. 
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4MYOB BusinessBasics is packed with features to help you easily track all your banking 
transactions—it doesn't matter if you are transferring money from one account to another or 
spending or receiving money using your cheque or credit card account.

Tracking your banking transactions is made easier still with BusinessBasics’ ability to import bank 
statements straight from the Internet.

This chapter shows you how to record the cheques you have written and received, your credit card 
purchases, credit card payments, your ATM withdrawals and deposits, petty cash transactions and 
the payments you make to your suppliers.

BusinessBasics can handle as many cheque and credit card accounts and allocate them to as many 
accounts as you like. If you are used to a manual multi-column cashbook system, you can think of 
BusinessBasics as having the capacity to run multiple cashbooks with an infinite number of 
columns. This makes it ideal for handling businesses with multiple cheque and credit card 
accounts as well as those with only one or two accounts.

For example, you pay your phone bill by cheque. You would write the cheque to the phone company, 
using your cheque account, and allocate the transaction to the phone account. If you paid the 
phone company by credit card, you would use your credit card account and still allocate the 
transaction to the phone account.

Simply record where the money is coming from and where it is going and BusinessBasics will do the 
rest. At the end of the month, you can download your bank statements from the Internet or use the 
printed statements your bank sends you, check your transactions against your statements and 
reconcile your accounts.
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Introducing the Bank Register
Before we launch into spending and receiving money, it is a good idea to 
become familiar with the Bank Register, where you will be entering these 
transactions. The versatile Bank Register lets you accomplish a number of 
tasks from one location. You can:

! Enter transactions quickly—this includes cheques, deposits, credit card 
charges, and even sales and payments. 

! View details of the transactions you’ve entered for a selected account, 
for a specific period. 

! Import bank and credit card statements you’ve downloaded from your 
bank’s website into BusinessBasics. You can then add them to 
BusinessBasics or match them with transactions already entered in 
BusinessBasics for easy statement reconciliation.

Entering transactions in the Bank Register

The Bank Register window can be divided into two main sections (see 
Bank Register graphic). The upper section is similar to the bank statement 
you receive from your bank. It lists all the transactions you’ve made for the 
selected account during the specified period.

The lower section of the Bank Register is where you record transactions. 
The Type list lets you switch between and enter different transaction 
types, all in one window. The Bank Register requires that you enter only 
the minimum details about each transaction. There’s no need to complete 
numerous fields—unless of course you want to. You would use Split for 
this purpose.

What does the Split button do? When you click Split, it displays the 
main transaction entry window (for cheques and charges, this is the 
Spend Money window, for sales, the Sales window, and so on). Here you 
can enter additional information about the transaction such as assign it to 

a job, use multiple allocation accounts, or change the tax code or payment 
method. You then record the transaction in this window. 

Importing bank and credit card statements
Another neat feature in the Bank Register is the Get Statement button, 
which lets you import statements you’ve downloaded from your bank’s 
website into BusinessBasics. You can then add the transactions from the 
statement into BusinessBasics with just a few clicks of the mouse—saving 
yourself hours of data entry. See ‘Importing statements into MYOB 
BusinessBasics’ on page 65.

A Enter an account and date range in the Account 
and Dated From and To fields. A list of 
transactions you’ve entered using the account 
during the specified period will appear below. 

B Enter a new transaction here. 

C Click this button to enter more information about 
the transaction. 

D Click this button to import transactions from a 
bank file into BusinessBasics.

A

B

DC
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Day to Day Tasks
This section includes the following topics:

! Spending money 

! Receiving money

! Recording miscellaneous transactions

Spending money

In MYOB BusinessBasics, you record all your expenditures—employees’ 
paycheques, supplier payments, miscellaneous expenses—by entering 
transactions in the Bank Register. Entering your expenses is quite simple. 
You specify the account the money is coming out of, the person you are 
paying, and the amount—it’s just like writing a regular cheque. If you want 
to enter more information for the transaction, for instance allocate the 
amount to different accounts or link it to a job, you can use the Split 
button in the Bank Register. 

Getting Ready

Before you write a cheque, you have the option of creating a card for the 
cheque’s recipient. Although you can write a cheque without assigning it 
to a payee, it’s good practice to keep a record of where your money is 
going. See ‘Creating supplier, employee and personal cards’ on page 41 
for instructions. 

Let’s assume that A-Z Supplies has sent you an invoice for a whiteboard 
and some office stationery you purchased last week. You plan to send 
them a cheque by mail for the total amount of $135.60.

Writing a cheque

Follow the instructions below to write a cheque. If you are recording a 
credit card purchase, see ‘Entering purchases made with the company 
credit card’ on page 55.

To write a cheque

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears.

2 Click the search icon  next to the Account field and select the account 
from which you are writing this cheque. In our example, we are using the 
cheque account. 

3 Select Spend Money as the type of transaction from the Type drop-down 
list. 

4 Change the default cheque number provided if you need to. 
BusinessBasics will increment this number by one for your next cheque.
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5 Enter the date of the cheque. 

NOTE : When entering dates You can’t enter a date prior to your 
conversion month or in a prior financial year.

6 Enter the card of the person or company to whom you are writing this 
cheque. 

7 Enter the amount of the cheque. 

8 Enter a memo for the cheque.

9 Allocate the cheque to the proper account and tax code. 

10 If you need to allocate the cheque to more than one account, click Split 
and assign a job number to the cheque, or print it right away. See ‘To 
record additional cheque details using the Split button’ below.

11 Decide what you want to do with the cheque. If you want to:

# Record the cheque, click Record. 
# Store the cheque as a recurring cheque so that you can use it many 

times in the future, click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click Save 
Template. (For more information about saving and using recurring 
cheques, see ‘Working with recurring transactions’ on page 110.)
If you want to record the cheque as an actual transaction now, click 
Record in the Bank Register. If you don’t want to record the cheque 
at this time, click Cancel. 

To record additional cheque details using the Split 
button

The Spend Money window, which appears when you click Split in the 
Bank Register, contains all the cheque details you’ve entered so far in the 
Bank Register.

1 If you need to allocate your cheque to more than one account, enter the 
allocation account and other details in the scrolling list. In the example 
above, the cheque has been allocated to two accounts. 

2 If you need to assign a line item to a job, enter the job number in the Job 
field.
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3 Decide what you want to do with the cheque. If you want to:

# Record the cheque, click Record. 
# Record the cheque and then print it immediately, click Print. 
# Store the cheque as a recurring cheque so that you can use it many 

times in the future, click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click 
SaveTemplate. (For more information about saving and using 
recurring cheques, see ‘Working with recurring transactions’ on 
page 110.)
If you want to record the cheque as an actual transaction now, click 
Record in the Spend Money window. If you don’t want to record the 
cheque at this time, click Cancel. 

Useful Reports

BANK REGISTER REPORT

Run this report to view every cheque and withdrawal you’ve made for a 
specific account within a given period.

Entering purchases made with the company credit 
card

Before you record credit card purchases, check your Accounts List and 
make sure it contains liability accounts to track the amounts you owe each 
credit card provider such as VISA, American Express and MasterCard. If 
you need to create an account, see ‘To create a new account’ on page 28. 

Follow the procedure below to record purchases you’ve made with your 
company credit card. 

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears. 

2 Click the search icon  next to the Account field and select the credit 
card account you want to use.

3 Select Enter Charge from the Type drop-down list. 

4 Enter the date, amount of the purchase and memo. 

5 Allocate the purchase to the appropriate expense account and tax code.

If you want to allocate the purchase to more than one account, click Split 
and enter the rest of the transaction details in the Spend Money window. 

6 Click Record to record the credit card purchase.
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Receiving money

In MYOB BusinessBasics, the term receiving money refers specifically to 
recording receipts other than payments relating to invoices. These include 
capital injections, interest, adjustments, and so on. 

Remember that BusinessBasics tracks invoicing separately through the 
Sales command centre, so any customer payments need to be entered 
through the Receive Payments window. However, if you use 
BusinessBasics as a cashbook (where you record invoices only after you 
receive payment for them), you can include customer payments through 
the Receive Money function.

Entering a deposit

Follow the instructions below to enter a deposit.

Let’s assume that you, as one of the owners of the business, are depositing 
$5000 as capital into the company’s cheque account. 

To enter a deposit

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears.

2 Click the search icon  next to the Account field and select the account 
into which you are receiving this money. In our example, we are 
depositing it directly to the cheque account. 

If you want to allocate the money temporarily to the Undeposited Funds 
account, select this account instead. 

3 Select Receive Money as the type of transaction from the Type drop-down 
list. 

4 Enter the date of the deposit. 

5 Link the deposit to a card in your cards list (optional).

6 Enter a memo for the deposit. 

7 Allocate the amount to the appropriate account and tax code.

8 If you need to allocate the amount to more than one account or change 
the payment method or details (by default, the payment details entered in 
the card are used), click Split. See ‘To record additional deposit details 
using the Split button’ on page 57.

9 Decide what you want to do with the deposit. If you want to:

# Record the deposit, click Record. 
# Store the deposit as a recurring deposit so that you can use it many 

times in the future, click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click Save 
Template. (For more information about saving and using recurring 
deposits, see ‘Working with recurring transactions’ on page 110.)
If you want to record the deposit as an actual transaction now, click 
Record in the Bank Register. If you don’t want to record the deposit 
at this time, click Cancel.
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To record additional deposit details using the Split 
button

The Receive Money window, which appears when you click Split in the 
Bank Register, contains all the deposit details you’ve entered so far in the 
Bank Register. 

1 If you need to allocate the deposit to more than one account, enter the 
allocation account and other details in the second line of the scrolling list. 

2 If you need to allocate the line item to a job, enter the job number in the 
Job column.

3 If you want to make any other changes such as payment method, enter 
the new details. 

4 Decide what you want to do with the deposit. If you want to:

# Record the deposit, click Record. 
# Store the deposit as a recurring deposit so that you can use it many 

times in the future, click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click Save 

Template. (For more information about saving and using recurring 
deposits, see ‘Working with recurring transactions’ on page 110.)
If you want to record the deposit as an actual transaction now, click 
Record in the Receive Money window. If you don’t want to record 
the deposit at this time, click Cancel.

Useful Reports

BANK REGISTER REPORT

Run this report to view every deposit you’ve made to a specific account 
within a given period.
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Recording miscellaneous transactions

This section includes the following topics:

! Entering an employee’s paycheque

! Entering ATM withdrawals and transfers

! Entering phone banking and Internet transactions

! Entering credit card payments

! Recording a charge credited to your account

Entering an employee’s paycheque

Although BusinessBasics does not include a payroll function,* you can use 
it for recording employee paycheques and tracking the various taxes 
payable. So once you’ve used your existing payroll method to calculate an 
employee’s wages and taxes, follow the steps below to write the 
paycheque in BusinessBasics. 

1 Create a tax code called ‘PAY’ to track PAYG/PAYE Withholdings. Select 
‘Voluntary Withholding’ as the Tax Type and set the rate to 99%. Link the 
tax code to the PAYG Withholdings liability account in both the Account 
for Withholding Credits and Account for Withholding Payable fields. 
See ‘Creating tax codes’ on page 32 for more information about setting 
up tax codes.

2 Go to the Banking command centre and click Bank Register. The Bank 
Register window appears. 

3 Click the search icon  next to the Account field and select the account 
you want to use. 

4 Select Spend Money from the Type drop-down list. 

5 Enter the cheque number and date. 

6 Select the employee’s card. 

7 Click Split. The Spend Money window appears. 

8 Enter the paycheque. Clear the Tax Inclusive checkbox in the Spend 
Money window. Leave the Amount field in the top section of the window 
blank. Use the allocation account for Wages and Salaries and enter the 
gross amount. Type the ‘PAY’ tax code in the Tax column.

9 Click the Tax zoom arrow. The Tax Information window appears. Correct 
the amount displayed in the Tax column and click OK.

10 In the Spend Money window, click in the Amount field in the top section 
of the window. The correct Net Pay will be displayed.

11 Decide what you want to do with the cheque. If you want to:

# Record the cheque, click Record.
# Record and then print the cheque, click Print. 
# Store the cheque as a recurring cheque so that you can use it many 

times in the future, click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click Save 
Template. (For more information about saving and using recurring 
cheques, see ‘Working with recurring transactions’ on page 110.)
If you want to record the cheque as an actual transaction now, click 
Record in the Spend Money window. If you don’t want to record the 
cheque at this time, click Cancel.

* For fully integrated Payroll, consider upgrading to MYOB Accounting, Accounting Plus 
or Premier.
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Entering ATM withdrawals and transfers

When you withdraw cash or make a transfer from the ATM machine, you 
need to enter these transactions in BusinessBasics so that your account 
balances are updated.

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears. 

2 Click the search icon  next to the Account field and select the account 
from which you withdrew or transferred the money.

3 Select Spend Money from the Type drop-down list. 

4 Enter a non-numeric word or phrase in the Cheque # field to describe the 
transaction, for example “w’drawal” or “transfer.” That way, you’ll know 
the transaction isn’t an actual cheque when you view it in a list or on a 
report. This will also let you skip the transaction when you print a range of 
numbered cheques.

5 Enter the date and withdrawal or transfer amount.

HINT : Use a supplier card You can set up a supplier card for ATM 
withdrawals and transfers and use the custom fields to record any reference 
numbers. 

6 Enter the allocation account. If you withdrew cash for an expense, make 
sure you allocate it to the correct expense account. If it was a transfer, 
enter the account to which you transferred the money. If you withdrew 
cash to keep on hand for future cash expenses, allocate it to the Cash on 
Hand account or the Petty Cash account.

7 Use the Memo field to record the receipt number. 

8 Click Record to record the transaction. 

Entering phone banking and Internet 
transactions

If you pay bills or transfer amounts between accounts using phone 
banking or the Internet, you need to enter these transactions in 
BusinessBasics. Follow the steps below: 

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears. 

2 Click the search icon  next to the Account field and select the account 
from which you transferred or withdrew the money.

3 Select Spend Money from the Type drop-down list. 

4 In the Cheque # field, enter a non-numeric word or phrase to describe the 
transaction, for example “transfer.” That way, you’ll know the transaction 
isn’t an actual cheque when you view it in a list or on a report. This will also 
allow you to skip the transaction when you print a range of numbered 
cheques.
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5 Link the transaction to a card if you want. 

HINT : Use a supplier card You can set up a supplier card for Internet or 
phone banking and use the custom fields to record your customer reference 
number, etc. 

6 Enter the date and the transfer (or payment) amount.

7 Enter the correct allocation account. 

8 Use the Memo field to record the receipt number or to enter a detailed 
description such as “transferred to loan account.” 

9 Click Record to record the transaction. 

Entering credit card payments

Follow the steps below to record a payment you’ve made to the credit 
card company. 

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears. 

2 Click the search icon  next to the Account field and select the credit 
card account you are making the payment to. 

3 Select Enter Credit from the Type drop-down list. 

4 Enter the date, amount of the payment and memo. 

5 Enter the allocation account. This is the account from which you are 
making the payment. 

6 Click Record to record the transaction. 
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Recording a charge credited to your account

If you returned an item purchased with your credit card and the supplier 
credited the amount to your card, follow the steps below to record the 
credit. 

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears. 

2 Click the search icon  next to the Account field and select the credit 
card account the money is being credited to. 

3 Select Enter Credit from the Type drop-down list. 

4 Enter the date, amount of the credit and a memo. 

5 Enter the expense account you used originally for the purchase.

6 If you need to use more than one allocation account, click Split and 
continue entering the transaction in the Receive Money window. 
Otherwise, click Record to record the transaction. 

Entering a sale in the Bank Register

While sales are usually recorded in the Sales window (see ‘Entering a sale’ 
on page 73), miscellaneous one-time sales that have been paid for can be 
recorded in the Bank Register. The advantage of using the Bank Register is 
that you can quickly record the sale with minimum detail. Sales recorded 
in the Bank Register use the Miscellaneous layout (see ‘Layouts’ on 
page 72), so you will not be able to print an invoice. Also keep in mind that 
you won’t be able to specify a payment method. The payment method 
entered in the customer’s card is used automatically. If no payment 
method was entered, none will be used. 

1 Display the Bank Register. 

2 Select Enter Sale from the Type drop-down list. 

3 Select a customer card.

HINT : Create a cash sale card If you make many over-the-counter cash 
sales for which you don’t want to set up individual customer cards, you can 
create a single customer card called “Cash Sales” and assign all cash sales to 
this card.

4 Enter the amount and allocate the transaction to the appropriate income 
account. 

5 Enter a tax code.

6 Click Record to record the transaction. 
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Receiving a customer payment in 
the Bank Register

While you would normally enter customer payments in the Receive 
Payments window via the Sales Register (see ‘Receiving payments’ on 
page 80), you can also use the Bank Register for this purpose. 

The Bank Register is a real time-saver if you want to record several 
customer payments but don’t really want to enter detailed information for 
each payment. However, if you change your mind part way through, you 
can use Split to access the Receive Payments window and record 
additional payment details. 

1 Display the Bank Register. 

2 Click the search icon  next to the Account field and select the account 
that will be used to receive the payment. 

3 Select Receive Payment from the Type drop-down list. 

4 Select a customer card.

Note that the customer’s outstanding balance appears under A/R 
Balance. 

5 Enter the payment amount.

If the customer has multiple unpaid invoices, the payment will be applied 
to the oldest invoice automatically. 

6 If you decide you want to enter payment details, click Split and continue 
recording the rest of the transaction in the Receive Payments window. 
Otherwise, click Record to record the transaction. 
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Advanced Tasks
This section includes the following topics:

! Preparing a bank deposit

! Importing statements into MYOB BusinessBasics

! Reconciling your bank account

! Tracking petty cash expenses

! Voiding a cheque number

Preparing a bank deposit

If you use the Undeposited Funds account to temporarily hold customer 
payments and other funds you receive, you can create a batch bank 
deposit that will transfer funds from the Undeposited Funds account to the 
account of your choice as a single transaction. The Prepare Bank Deposit 
window lists all the transactions in the Undeposited Funds account for the 
period you specify. You can then indicate which receipts you want to 
deposit. You also have the option of grouping the receipts by payment 
method. 

For example, you receive cash, cheques and credit card payments from 
customers during the week. You store them temporarily in the 
Undeposited Funds account until you make a trip to the bank, which is 
usually on Friday afternoons. 

When you enter the deposit in BusinessBasics, you group your payments 
separately: cash, cheques, MasterCard and American Express.

To prepare a bank deposit

1 Go to the Banking command centre and click Prepare Bank Deposit. The 
Prepare Bank Deposit window appears. 

2 Enter the account into which you want the funds deposited in the Deposit 
to Account field. 

3 If you want to group receipts by payment method, click the Select 
Receipts by down arrow and choose Payment Method. Specify the 
payment method in the adjacent field, for example Cash. Only payments 
made using that method are listed. 

HINT : (Australia) If the payment was made using the Customer 
Payments Service If the payment was made using the Customer 

Payments Service, select the MYOB Pay Services method and not VISA, 
Bankcard or another payment method.

4 Enter a date in the Date field to display undeposited funds up to and 
including that date.
Advanced Tasks 63User Guide



5 Use the Memo field to record the purpose of the transaction. We 
recommend that you make a detailed comment so you’ll be able to 
identify the transaction when you review your records later on. 

6 Select the receipts you want to include on the bank deposit by marking the 
Deposit column.

7 Click Record. The funds from the receipts you marked will be transferred 
from the Undeposited Funds account to the account you specified in 
Step 2.
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Importing statements into MYOB BusinessBasics

While some businesses record their transactions in BusinessBasics as they 
are made, others prefer to leave them till the end of the month and enter 
them all at once when they receive their bank and credit card statements. 

Regardless of how you choose to do it, BusinessBasics makes transaction 
entry and statement reconciliation really simple. 

If you use online banking, this process is made easier by using the Get 
Statement feature in BusinessBasics. Bank or credit card statement files that 
you have downloaded to your computer from your bank’s website can be 
imported into BusinessBasics simply by clicking Get Statement in the 
Bank Register or the Reconcile Accounts window. 

BusinessBasics will then automatically match transactions on your 
statement with any transactions you have already entered in your 
company file. Matched transactions will be marked as ‘cleared’ for 
reconciliation purposes, making it really easy to reconcile your account at 
month-end. 

If BusinessBasics cannot find a match, you have the option of matching the 
transactions manually, adding them as new transactions or skipping them 
altogether. 

Getting Ready

Before you import your bank or credit card statement into BusinessBasics, 
you will need to download the statement file from your bank. Your bank’s 
website should provide instructions on downloading this file. The 
following file formats are supported by BusinessBasics: OFX, QFX, QIF and 
OFC. Make sure you save the bank file in one of these formats. 

To import your statement

NOTE : If you are importing your statement from the Reconcile Accounts 
window Click Get Statement in the Reconcile Accounts window and 
continue from Step 4 of the following procedure. 

1 Go to the Banking command centre and click Bank Register. The Bank 
Register window appears. 

2 Enter the account in the Account field. 

3 Click Get Statement. The Open dialog box appears. 

Locate and select the statement file that you downloaded.

4 Click Open. 

BusinessBasics will automatically match the transactions in your statement 
with the transactions in your company file, using the cheque number and 
amount as the criteria for matching cheques and the amount as the 
criterion for matching deposits. If:

! there are any unmatched transactions, the Unmatched Statement 
Transactions window appears. Go to Step 5.

! all your transactions match, that’s it! These transactions will be marked 
as cleared in the Reconcile Accounts window. 

5 Choose what you want to do with the unmatched transactions. 
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# If you want to match a transaction, highlight that transaction and 
click Match Transaction. The Match Transaction window appears, 
listing the uncleared transactions in your company file for the 
specified account. Select the transaction that you want to match with 
the statement transaction and click Match. The transaction will be 
marked as cleared. Repeat this step for each transaction that you 
want to match. 

# If you want to add a transaction to your company file, highlight the 
transaction and click Add Transaction. The Spend Money window 
or the Receive Money window (depending upon the type of 
transaction you are adding) will be displayed. Enter the details of the 
transaction and record it. The transaction will be marked as cleared. 
Repeat this step for each transaction you want to add to 
BusinessBasics. 

CAUTION : Match or add all transactions We recommend you finish 
adding or matching every transaction in the unmatched transaction list 
before you click Done. If you open the statement file again, the original 
unmatched statement list reappears.

6 When you have finished matching and adding transactions, click Done. 
Any transactions that were not matched are skipped. A list of all the 
transactions that were cleared are displayed. 
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Reconciling your bank account

You may recall setting up your bank account when you first set up your 
company file. This was to ensure that your bank records matched the 
account balances in BusinessBasics before you started entering 
transactions. (If you haven’t done this already, see page 48.)

Now that you’re entering transactions regularly, it’s a good idea to 
periodically reconcile your accounts and maintain this consistency 
between what the bank says you have, and what your BusinessBasics 
accounts show. 

When reconciling your account, you will be matching transactions in the 
Reconcile Accounts window with those that appear on your bank 
statement. Any fees charged by the bank can be recorded during the 
process. 

This is a straightforward procedure, and as long as you’ve entered your 
transaction amounts in BusinessBasics correctly, your account should 
reconcile without any problem. If, however, you feel more comfortable 
getting the help of your accountant or an MYOB Consultant for this task, 
go ahead. 

Importing bank statements into BusinessBasics If you use online 
banking, you can speed up account reconciliation by importing your bank 
statement into BusinessBasics and having BusinessBasics match the 
transactions in your bank statement with those in the system. Matched 
transactions will automatically appear as “cleared” in the Reconcile 
Accounts window. For instructions, see ‘Importing statements into MYOB 
BusinessBasics’ on page 65.

Getting ready

Keep your most recent bank statement handy.

Before you reconcile your account, you need to make sure that all the 
cheques and deposits that appear on your bank statement are entered in 
BusinessBasics. 

You also need to have set up your bank accounts. For more information, 
see ‘Setting up your bank accounts for reconciliation’ on page 48. 

To reconcile your cheque account

1 Go to the Banking command centre and click Reconcile Accounts. The 
Reconcile Accounts window appears. 

2 Enter the account you want to reconcile in the Account field.

3 Enter the ending balance on your bank statement in the New Statement 
Balance field. 

4 Enter the closing date that appears on your bank statement in the Bank 
Statement Date field. Only transactions dated on or before that date will 
appear in the scrolling list.

5 If you haven’t already imported your bank statement, and want to click 
Get Statement in this window. See ‘Importing statements into MYOB 
BusinessBasics’ on page 65 for instructions.

6 Mark all the cheques and deposits that are on your bank statement by 
clicking in the column on the left in the Reconcile Accounts window.
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If you’ve imported your statement and matched the statement 
transactions with those in BusinessBasics, you will notice that these 
transactions have a mark in the column on the left, indicating that they are 
already cleared. 

7 If you need to record a bank service charge or interest that appears on the 
statement, click Bank Entry. The Record Service Charges and Interest 
Earned window appears. 

a Enter the service charge amount, ID number and date and allocate the 
charge to an expense account. If your Accounts List does not have an 
account for tracking bank charges, you will need to create one (see ‘To 
create a new account’ on page 28). 

b Enter any interest earned, ID number and date and allocate the interest 
to an income account. If your Accounts List does not have an account 
for tracking interest earned, you will need to create one (see ‘To create a 
new account’ on page 28). 

c Click Record to record the interest and bank charges and return to the 
Reconcile Accounts window. 

8 If you have matched all the cheques and deposits on your bank statement, 
click Reconcile. A window appears, indicating whether your account is 
reconciled or out of balance. 

! If your account is reconciled, you have the option of printing the 
Reconciliation report by clicking Print Report (recommended). Once 
the report is printed, the Reconcile Accounts window appears again. 
Click Reconcile again to complete the reconciliation process. 

If you don’t want to print the report, simply click Reconcile. The 
transactions you marked are considered cleared, and won’t appear in 
the Reconcile Accounts window the next time you display it. 

! If your account is out of balance, a dialog box appears, indicating the 
amount by which your account is out of balance, and providing reasons 
why this may have occurred. 

Why doesn’t my account reconcile?

Here are some additional things you might want to verify:

# Are all the cheques and deposits that appear on your bank statement 
marked in the Reconcile Accounts window? Check to be sure the 
deposit and withdrawal amounts that appear on the Total Cleared 
line near the bottom of the Reconcile Accounts window are the 
same as the total deposit and withdrawal amounts on your bank 
statement.

# Did you mistakenly mark a transaction that doesn’t appear on your 
bank statement?

# Did you make the correct entry in the New Statement Balance field? 
(Make sure you entered the ending balance from your statement and 
not your beginning balance.) 

# Are all deposits accounted for? If the bank statement shows a higher 
balance than the balance calculated by BusinessBasics, a previously 
cleared deposit may have been deleted and not re-entered, or re-
entered but not marked as cleared.
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Tracking petty cash expenses

Most businesses keep a small amount of cash handy at the office for 
miscellaneous expenses—postage, pizza Thursdays, and so on. You can 
track this petty cash amount separately in BusinessBasics by creating an 
account and then allocating any miscellaneous expenses to this account. 

1 Create a petty cash account. First check your Accounts List to see if a petty 
cash account has been set up for you already. If not, create an asset 
account (1-), making it a Detail [Postable] Cheque account. For more 
information, see ‘To create a new account’ on page 28.

2 When you spend from your petty cash account, make sure you record 
these expenses in BusinessBasics.

3 To reimburse your petty cash account, write a cheque from your regular 
cheque account, entering your petty cash account as your allocation 
account.

Voiding a cheque number

You may want to void a cheque for any number of reasons—for instance, 
you may find that one of your cheque forms is damaged and can’t be used 
for printing or that you made a mistake when you wrote the cheque 
manually. 

Follow the steps below to void a cheque you have not recorded in 
BusinessBasics. If you want to make changes to a cheque you have already 
recorded, see ‘Changing a transaction’ on page 107. 

1 Use the Bank Register to enter the cheque as you normally do, but don’t 
enter an amount in the Amount field. There is also no need to assign 
allocation accounts or a card. 

2 Enter the cheque number you want to void in the Cheque No. field.

3 Click Record. A message appears, asking you if you want to void this 
cheque number.

4 Click OK to confirm that you want to void this cheque. 
Tracking petty cash expenses 69User Guide



Chapter 4 : Entering Banking Transactions70 MYOB BusinessBasics v1



5It doesn't matter if you are a florist, a graphic designer or an architect—you need sales to make a 
profit. As business becomes more and more competitive, the need for reliable information becomes 
greater.

MYOB BusinessBasics helps keep you fully informed. It can tell you what’s selling, who’s buying 
what and how long they are taking to pay you. You can use this information to tailor your 
marketing and improve your business.

For example, you can find out how well a range of new products is selling to determine whether you 
need to order more stock or run another advertisement. You can find out who’s paying and who’s 
not and decide whether you should increase a customer’s credit limit or change their payment 
terms. 

You can create quotes for customers in BusinessBasics. When the goods or services are delivered, 
these quotes can be converted to invoices. If the need arises, you can follow up the invoices with 
fully customised statements to encourage payment.

And if your statements fail to get a response, you can use BusinessBasics’ reporting features to help 
you follow up any outstanding accounts.

Handling customer payments couldn’t be easier. Payments—including under and 
overpayments—can be deposited to any of your cheque or credit card accounts and even to a 
holding account to help you group small payments together. Customer returns can be applied to 
unpaid invoices or, if the need arises, refunds can be sent to your customers.
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Day-to-Day Tasks
This section includes the following topics:

! Entering sales

! Receiving payments

Entering sales

Entering a sale in MYOB BusinessBasics is simple—it takes only a few 
minutes and doesn’t require any accounting knowledge on your part. To 
take advantage of the flexibility of BusinessBasics’ Sales feature and use it 
to meet the specific needs of your business, you need to know a bit about 
quotes and invoices (the two stages of a sale) and layouts (the different 
types of sales you can record).

QUOTES AND INVOICES

You can enter a sale as a quote or an invoice. 

Quote—A quote is an estimate you provide to a customer. Let’s assume 
you run a florist business. A customer hosting a banquet requests an 
estimate from you for 12 floral arrangements. You enter the quote in 
BusinessBasics, making it as detailed as you want. For example, you can 
give the customer a breakdown of your charges—for flowers, containers, 
fillers, labour, and so on. A quote doesn’t affect your accounts at all as you 
haven’t made the sale yet. 

Invoice—An invoice is what you create when you’ve delivered the goods or 
services and can expect payment. You can either enter an invoice directly 
in BusinessBasics or convert a quote you’ve recorded. Using the previous 
example, let’s assume the customer approved your quote and you 

delivered the 12 arrangements. You can now convert your quote to an 
invoice; all it takes is a few clicks of the mouse. When you record the 
invoice, the relevant accounts in your Accounts List are updated, including 
the receivables account (which keeps track of money you are owed). 

Invoices can be open (customer hasn’t paid you yet), closed (customer has 
paid you in full) or credits (you owe the customer money because they 
overpaid you or returned the goods). 

LAYOUTS

Not all businesses sell the same things. Some, such as advertising agencies 
and consultants are service-based, while most retail stores sell only goods 
(items). Many businesses, such as interior designers charge for both 
services and items. BusinessBasics provides four different sales layouts (or 
views of the Sales window) to meet the needs of a variety of businesses. 
They are: Item, Service, Professional and Miscellaneous. 

# Sale of goods —Use the Item layout to enter the sale of items and 
services you sell regularly. For example, if you own a bookstore, this 
would be paperbacks, magazines, bookmarks, and so on. 
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# Sale of services—Use the Service layout to sell a service. For a graphic 
designer, this would be consultation, the design of a product box or 
user interface, etc. 

# Sale of services to be tracked over a period of time—Use the 
Professional layout when selling services you want to track over a 
certain period. For example, if you are an interior designer, this would 
be a project that includes services provided on different dates. You 
can include the date each individual service was provided, all on the 
one invoice.

# Adjustments, discounts and returns—Use the Miscellaneous layout for 
sales you don’t need to print, such as adjustments or discounts. For 
example, if a customer returns an item, you can record the return 
using the Miscellaneous layout. 

Getting ready 

Create a customer card You can create a customer record or card during 
the sale by clicking New in the customer selection list. However, it’s much 
quicker to enter a sale if you’ve got a card set up for the customer already: 
you won’t need to manually enter the customer’s details in the Sales 
window; it’s filled in for you automatically. 

So create a card for this customer if you haven’t done so already during 
your company file setup. For more information, see ‘To create a customer 
card’ on page 33.

HINT : Create a cash sale card If you make many over-the-counter cash 
sales for which you don’t want to set up individual customer cards, you can 
create a single customer card called “Cash Sales” and assign all cash sales to 
this card.

Create an item record (for item sales) If you are selling an item, set up a 
record for that item before entering the sale. An item record contains 
details of the item, such as selling price, selling unit and income account. 
As with customer cards, you can create an item record while entering a 
sale. However, if speed is what you want when recording a sale, it’s best to 
create the item record first. An item record, like a customer card, once set 

up, can be used repeatedly for any number of sales. For more information, 
see ‘Creating item records’ on page 38. 

Entering a sale

Follow the steps below to enter a sales transaction. As you get to know 
BusinessBasics, the whole process could take just a few seconds. 

! Step 1: Choose the type of sale you want

! Step 2: Enter information about your customer

! Step 3: Enter the items or services you are selling

! Step 4: Enter additional information about the sale

! Step 5: Complete the sale

Step 1: Choose the type of sale you want

In this step, you need to choose the status and layout for the sale you are 
creating. 

1 Go to the Sales command centre and click Sales Register. The Sales 
Register appears. Make sure the All Sales tab is selected.

2 Click New Sale. The Sales window appears. 

3 Choose the status—Quote or Invoice—from the pop-up menu in the 
upper left corner of the window. 

4 If you want to change the layout, click Layout and choose from Item, 
Service, Professional and Miscellaneous. Click OK.

NOTE : Have you selected a layout for this customer in their card? If 
you have, you can skip this step. The preferred layout for this customer will 
appear automatically when you enter the customer’s name in the following 
step.
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Step 2: Enter information about your 
customer

" Complete the customer details using the following table as a guide.

CAUTION : (Australia) Use Numeric/Unique Invoice Numbers If 
you use the Customer Payments Service, do not use invoice 
numbers that contain non-numeric characters. You may want to 
mark the “Warn for Duplicate Invoice Numbers” preference to alert 
you before recording a duplicate Invoice number.

TO CHANGE THE CUSTOMER’S CREDIT TERMS FOR THIS 
TRANSACTION

When you enter a customer’s name in the Customer field, the 
terms you’ve assigned to the customer appear next to the 
customer’s name automatically. If you want to change these terms 
for this particular transaction, follow the steps below.

NOTE : Any changes you make using this procedure will affect 
only the transaction you’re currently entering If you want to 
change the credit terms that will be used for all future sales to this 
customer, you should make that change in the Selling Details tab of 
the customer’s card. 

1 Click the zoom arrow next to the Terms field. The Credit Terms 
window appears. 

2 Make the necessary changes in the Credit Terms window and then 
click OK to close the window. The Sales window appears again, 
with the new credit terms appearing next to the Terms field. 

Step 3: Enter the items or services you are 
selling

The scrolling list in the middle of the Sales window is where you 
enter details of what you are selling. In this area, you’ll enter item 
numbers, selling quantity, descriptions, account names and various 
other information that will serve as the detail for your transaction. 

When you enter information in one row in the scrolling list, you 
enter one line item of the transaction. You can enter as many line 
items on a sale as you want. 

The actual columns that appear in the scrolling list differ, depending 
upon the type of sale you are creating. The illustrations on the 
following page describe the line item entries you can make for each 
type of sale in the Sales window.

A Enter the customer’s name. To select the customer from your 
customer list, click the search icon. 

B The address you entered in the customer’s card appears here 
automatically. If you want to select another address you’ve recorded 
for this customer, click the Ship to arrow.

C If you want to alter the credit terms for this sale only, click the zoom 
arrow. See ‘(Australia) Use Numeric/Unique Invoice Numbers’ 
below. 

D If the customer gave you a purchase order for this transaction, enter 
the purchase order number here.

E Mark the Tax Inclusive checkbox if you are entering prices including 
tax. Clear this checkbox if you are entering prices excluding tax. Do 
not change this setting after you enter an amount in the Amount 
column.

A B C D E
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HINT : Add lines, subtotals and headers to invoices You can add lines, 
headers and subtotals to invoices to make it easy to separate and subtotal 
different categories of sales in one invoice. For more information, see 
‘Inserting lines, subtotals and headers in quotes and invoices’ on page 77.

A Qty Enter the quantity (of the item) being sold. 

B Item Number Press TAB and choose an item from your Items List.

C Description A description of the item appears automatically. 
You can change this description if you want by 
typing over it. 

D Price The selling price of the item that you entered in the 
item’s record appears automatically. You can 
change it for this sale if you want. 

E Total The total price of the items being sold is calculated 
automatically. 

F Job If you want to assign this item to a job, enter the 
job number here. For more information about 
jobs, see ‘Setting up jobs’ on page 46. 

G Tax If this item is taxable, enter the tax code here. 

Item sale

A B C D E F G

A Date Enter the date this service was performed. (The 
Date column is only available in the Professional 
sale layout.)

B Description Enter a description of the service being sold. 

C Account name or 
number

Enter the name (or number) of the account to 
which you want to allocate this sale. Press TAB to 
select an account from your Accounts List. Sales 
are usually allocated to income accounts. You 
should not choose your Accounts Receivable 
account for ordinary sales. 

D Amount Enter the amount of the service. 

E Job If you want to assign this service to a job, enter the 
job number here. For more information about 
jobs, see ‘Setting up jobs’ on page 46. 

F Tax If this item is taxable, enter the tax code here. 

Service, professional and miscellaneous sales

A B C D E F
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Step 4: Enter additional information about the 
sale

Complete the fields that appear in the bottom section of the Sales window 
referring to the table below. Keep in mind that these fields differ, 
depending on the type of sale you’re creating. For example, most of the 
fields described below are not available for Miscellaneous sales. 

Step 5: Complete the sale

Now that you’ve finished entering details of the sale, there are a number of 
tasks you can perform with the transaction. Make sure you review all the 
following options before you choose what to do.

# Record the sale. To record the sale without printing it, click Record. 
# Record and print the sale. If you are using either the Item, Service or 

Professional layout, you can print and record the transaction at the 
same time. Click Print. For more information about printing invoices, 
see ‘Using Forms’ on page 127.

# Record and email the sale. If you have an email program such as 
Eudora (5.0 or later) or Outlook Express (5.0 or later) , you can 
prepare an email containing the sale directly in BusinessBasics. Click 
Send To and choose E-mail. Review and make entries in the E-mail 
window and click Send. The email will be sent to your default email 
program’s Outbox; send it from your email program as you normally 
do. 

# Record and fax the sale. Click Send To and choose Fax. A dialog box 
from your fax program appears. Send the fax using your fax program 
as you normally do. 

NOTE : (Australia) If you use the Customer Payments Service If you use 
the Customer Payments Service and allow payments to be made using the 
Postbillpay in person option, do no fax the invoice– the barcode may not be 
clear enough to scan.

# Record and save the sale to disk as a PDF file. You can save the sale as 
a PDF (Portable Document Format) file which you can attach to an 
email. Click Send To and choose Disk. In the dialog box that appears, 
enter a file name and location for the file and click Save. 

# Store the sale as a recurring sale so that you can use it many times in 
the future. Click Save Recurring. Complete the Save Recurring 
Template window and click Save Template. (For more information, 
see page 110.)
If you want to record the sale as an actual transaction now, click 
Record in the Sales window. If you don’t want to record the sale at 
this time, click Cancel. 

A Comment Select a comment by clicking the search icon.

B Ship Via Select a shipping method by clicking the search 
icon. 

C Already Printed or 
Sent

Mark this checkbox if you don’t intend to print this 
sale. 

D Promised Date Enter the date you promised the goods or services 
to your customer. 

E Journal Memo The journal memo is generated automatically. You 
can change it if you want. 

F Freight Enter any charges for freight. 

G Tax Click the zoom arrow if you want to view or 
change the tax amounts assigned to the sale. 

H Paid Today Enter an amount here to indicate how much the 
customer paid you at the time of the sale. 

I Payment Method Enter the payment method that the customer used 
to pay you. Click Details to enter details of the 
payment method. 

J Tax code If the freight is taxable, enter a tax code here. 

A B C D E F G H I J
Chapter 5 : Entering Sales and Payments76 MYOB BusinessBasics v1



Inserting lines, subtotals and headers in quotes 
and invoices

You can insert lines, headers and subtotals in the scrolling list area of the 
Sales window, making it easy to separate and subtotal different categories 
of a sale on one invoice or quote. For example, an advertising agency 
invoices a client for a brochure. The line items can be grouped and 
subtotalled to show separate costs for copywriting, graphics, 
photography, and so on. 

To insert a blank line

1 In the scrolling list area of the Sales window, position the mouse pointer 
anywhere on the line item above which you want the blank line to appear. 

2 Go to the Edit menu and choose Insert Line. 

To insert a header

1 In the scrolling list area of the Sales window, position the cursor on the line 
item above which you want the header to appear. 

2 Go to the Edit menu and choose Insert Header. A blank line appears in 
the scrolling list with the cursor positioned in the Description column. 

3 Type the text for the header. The text appears in grey, as shown below. 

To insert a subtotal

1 In the scrolling list area of the Sales window, position the mouse pointer 
on the first line below the items to be subtotalled. 

2 Go to the Edit menu and choose Insert Subtotal. As shown below, a line 
appears, displaying the subtotal of all the line items above it.

To delete a blank line, line item, header or subtotal

1 In the scrolling list area of the Sales window, position the mouse pointer 
anywhere on the blank line, line item, header or subtotal you want to 
delete. 

2 Go to the Edit menu and choose Delete Line.
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Converting a quote to an invoice

1 Go to the Sales command centre and click Sales Register. The Sales 
Register appears. 

2 Click the Quotes tab.

3 Locate the quote you want to convert in the scrolling list and select it.

If you’ve got a long list of quotes, you can narrow your search using filters. 
Choose Customer in the Search By field and enter the customer’s name in 
the adjacent field. In the Dated From and To fields, enter a range that 
includes the date the quote was entered in BusinessBasics. 

4 Click Change to Invoice. The Sales window appears, with three 
additional fields: Paid Today, Payment Method and Balance Due.

5 Make any changes you want to make to the details of the sale and click 
Record.

HINT : Do you want to delete quotes once you’re done with them? 

Set the Delete Quotes Upon Changing to and Recording as an Invoice 
preference in the Sales view of the Preferences window. BusinessBasics will 
automatically delete a quote after it’s converted to an invoice. 

Recording customer orders

Although BusinessBasics does not track customer orders separately, you 
can use the Sales window to record details of an order just as you would a 
standard invoice. 

Let’s assume customer J. P. Fastidiuz wants a rare jazz CD. You normally 
don’t stock this item but decide to get it for him anyway. You record the 
order as you would a standard sale, entering the customer’s $20 deposit in 
the Paid Today field. 

You enter the word “Order” in the Customer PO # field to distinguish it 
from a regular sale. (This, incidentally, will also make it easier for you to 
find the transaction later—simply use Find Transactions with the 
Customer PO# field as the filter.)

When you receive the item and the customer pays you the outstanding 
balance, record the payment as you normally would, in the Receive 
Payments window.
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Useful Sales reports

SALES REGISTER QUOTES REPORT

Run this report to view a list of quotes you have created for customers for a 
given period. 

SALES REGISTER OPEN INVOICES REPORT

This is a useful report for viewing your unpaid invoices for a given period. 

SALES REGISTER CLOSED INVOICES REPORT

Run this report to view a list of invoices that have been paid in full. 

In addition to these reports, there are several advanced sales reports that 
you can use to analyse your sales information and the effect of it on your 
business. For more information, see ‘Reviewing your sales information’ on 
page 88.

Working with Sales transactions

HOW DO I FIND A SALE I HAVE ENTERED?

BusinessBasics provides several methods you can use to quickly retrieve a 
sale you have recorded. For instructions, see ‘Finding a transaction’ on 
page 104. 

HOW DO I MAKE CHANGES TO A SALES TRANSACTION I HAVE 
ALREADY RECORDED?

Depending on your preference settings, BusinessBasics allows you to make 
changes to a sale you have recorded. For instructions, see ‘Changing a 
transaction’ on page 107. 

HOW DO I DELETE A SALES TRANSACTION?

You can delete a sale although some restrictions apply. For more 
information, see ‘Deleting a transaction’ on page 108. 

HOW DO I CHANGE THE EFFECTS OF A SALE I HAVE RECORDED 
WITHOUT DELETING IT?

You can reverse a sale you have recorded, thereby reversing the effects of it 
in your books. For more information, see ‘Reversing a transaction’ on 
page 109. 
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Receiving payments

Receiving payment for sales you’ve made is always a welcome part of 
doing business. When a customer pays you for the goods or services 
they’ve purchased, you record the payment in the Receive Payments 
window. You can apply the payment to a specific sale or, if the customer 
has more than one unpaid invoice, split it among several invoices. 

Using customer credits as payment If the customer has a credit, you can 
use it as payment towards one of their outstanding sales to reduce the 
amount they owe you (see ‘Settling customer credits’ on page 86). If you 
want BusinessBasics to remind you of any outstanding credits before you 
apply a payment, make sure you mark the Warn if Customer has an 
Outstanding Credit before Applying a Payment checkbox in the Sales 
view of the Preferences window.

To receive payments

1 Go to the Sales command centre and click Sales Register. The Sales 
Register appears. 

2 Click the Open Invoices tab. 

3 Select Customer from the Search By list and enter the customer’s name in 
the adjacent field. Enter the appropriate date range. A list of open invoices 
for the customer appears. 

4 Click Receive Payments. The Receive Payments window appears. 

5 Choose the account that will be used to receive the customer payment. 

# Deposit to account. Choose this option if you want the payment to be 
deposited directly into a specific account. Click the search icon 
and select the account from the cheque accounts you’ve set up.

# Group with Undeposited Funds. Choose this option if you want the 
payment to be recorded in the Undeposited Funds account. This is an 
account that temporarily ‘holds’ all your customer payments and 
other deposits until you are ready to make a bank deposit. (For more 

information about bank deposits, see ‘Preparing a bank deposit’ on 
page 63.) 
(Australia) Select this option if the payment was made using the 
Customer Payments Service. This will enable you to easily record a 
bank deposit for the Customer Payments Service payments.

6 Enter the amount received and the payment method. Click Details to 
enter details of the payment. If you have set up payment details in the 
customer’s card, they will appear in this window automatically. 

(Australia) If the payment was made using the Customer Payments 
Services, select the MYOB Pay Services method and not VISA, Bankcard or 
any other payments.

7 Adjust the memo and payment date if you want. 

You can change the ID# that is automatically generated, but we 
recommend you use the default to prevent duplicate journal numbers. 

8 Apply the amount received to one or more of the outstanding invoices. To 
do this, either type the amounts you want to apply to each sale manually 
in the Amount Applied column or keep pressing the TAB key until 
BusinessBasics allocates the amounts to the invoices.
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HINT : Automatically apply payment to oldest invoice If you want 
BusinessBasics to apply the payment to the oldest invoice first, mark the 
Apply Customer Automatically to Oldest Invoice First checkbox in the 
Sales view of the Preferences window (go to the Setup menu and choose 
Preferences).

9 Check the Total Applied and Out of Balance fields. Before you can record 
the transaction, the Total Applied amount must equal the amount that 
appears in the Amount Received field in the top half of the window and 
the Out of Balance amount must be zero. If the amounts don’t match, 
and you think the customer has overpaid you by mistake, see ‘If the 
customer overpaid you’ below. 

10 Click Record to record the customer payment. 

Don’t forget to prepare a bank deposit of the undeposited funds 
transactions If you chose to group the payment with other undeposited 
funds, you will need to create a transaction within BusinessBasics to reflect 
the deposit of these funds in the bank. You would normally do this after 
you have physically deposited the money in the bank. For more 
information, see ‘Preparing a bank deposit’ on page 63.

If the customer overpaid you

If a customer overpaid you by mistake, it is very important that you enter 
the entire payment you received in BusinessBasics. The full payment 
should be entered in the Amount Received field and in the Amount 
Applied column in the scrolling list. When you record the payment, 
BusinessBasics will automatically create a credit for the overpaid amount. 
This can either be refunded to the customer or applied to a future invoice 
using Settle Returns & Credits. For more information, see ‘Settling 
customer credits’ on page 86.

If you want to give the customer a discount for early 
payment

If you want to give a customer a discount as an incentive for paying their 
invoices early, you can do so by entering a special miscellaneous sale. This 
creates a customer credit that the customer can use towards a subsequent 
purchase. 

After you have recorded the customer payment in the Receive Payments 
window, follow the steps below to enter the discount. 

1 Open the Sales window and select the Miscellaneous layout. 

2 Enter the customer’s details. 

3 Type “Discount for early payment” in the Description field.

4 Allocate the sale to the Discounts Given account. This is an expense 
account. (If this account doesn’t exist in your Accounts List, you will need 
to create it first. See ‘To create a new account’ on page 28.)
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5 Enter the discount as a negative amount in the Amount field.

6 Record the transaction. BusinessBasics automatically creates a credit for 
this amount. This amount can either be refunded to the customer or 
applied to a future invoice using Settle Returns & Credits. See ‘Settling 
customer credits’ on page 86 for more information. 

Useful reports

CUSTOMER PAYMENTS [CLOSED INVOICES] REPORT

This report shows every fully paid sale within the selected date range and 
calculates the days it took before it was paid in full. It then calculates the 
average number of days for each customer.
This report helps you separate late payers from prompt payers—useful 
when deciding whether to increase a customer’s credit limit. 
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Handling bounced cheques

Let’s assume you received a cheque in the mail from customer Laggard 
and Co. as payment. You deposited the cheque in your bank and then 
entered the payment in BusinessBasics. 

A week later, you receive a letter from your bank—the customer’s cheque 
has bounced and you now owe the bank $20 as penalty! 

To fix your records in BusinessBasics, you first need to reverse the customer 
payment, and then invoice the customer for the $20 bank fee. 

To reverse the customer payment

1 Check your security preferences and make sure you have turned on the 
Transactions CAN’T be changed; they must be reversed preference. 
(Go to the Setup menu, choose Preferences and click the Security tab.)

2 Find the customer payment and display it in the Receive Payments 
window. See ‘Finding a transaction’ on page 104 if you need help. 

3 Go to the Edit menu and choose Reverse Payment. A reverse transaction 
is created. 

4 Record the reverse transaction. The original customer payment is reversed; 
as the payment is removed from the original invoice, the closed invoice 
becomes an open invoice. 

To bill the customer for the bank fee

1 Display the Sales Register and click New Sale. 

2 Enter the customer’s name. 

3 Click Layout and choose Miscellaneous. 

You will not be able to print this invoice separately but it will appear on the 
customer’s statement. 

4 Enter an appropriate description.

5 Enter your cheque account as the allocation account because you want 
your bank account to be reimbursed for the bank fee.

6 Record the transaction.
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Advanced Tasks
This section includes the following topics:

! Creating customer credits

! Reviewing your sales information

Creating customer credits

In MYOB BusinessBasics, a customer credit is a transaction that indicates 
you owe money to a customer. This can happen for a number of reasons. 
For example, the customer returned all or some of the goods, the 
customer overpaid you when settling an invoice, you gave the customer a 
discount, and so on. (See page 81 for more information on customer 
discounts and overpayments.)

Recording credits

You can create a customer credit in one of the following ways:

! Reverse an existing sale. Use this method if the customer returned all the 
items in an invoice and you are crediting the customer for the entire 
sale.

! Manually create a credit. Use this method if you are crediting the 
customer for part of a sale. (See ‘To manually create a credit’ on 
page 85.)

To reverse an existing sale

Use this method if you want to credit a customer for the entire sale and not 
just part of it. 

Before you can reverse a sale, your company file must be set to 
“unchangeable;” that is, the Transactions CAN’T be changed; they must 
be reversed preference should be turned on in the Security view of the 
Preferences window. (See ‘Some preferences in BusinessBasics’ on 
page 23 for more information.)

1 Display the Sales Register, click the Closed Invoices tab and find the sale 
you want to reverse. If you need help finding the sale, see ‘Finding a 
transaction’ on page 104.

2 Once you’ve found the sale, click the grey zoom arrow next to it to display 
the Sales window. 

3 Go to the Edit menu and choose Reverse Sale. After a few moments, a 
customer credit appears in the Sales window.
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Note that the amounts appear as negative, indicating that this is a sale 
reversal.

If you want, you can make a few changes to the customer credit such as 
the date and memo, but you can’t change the accounts, amounts and 
quantities that are associated with the credit. 

4 Click Record Reversal. 

5 See ‘Settling customer credits’ on page 86 for instructions on settling the 
customer credit. 

To manually create a credit

Manually create a credit if you want to credit the customer for part of a 
sale. Follow the appropriate method below. 

REFUND FOR A NON-ITEM SALE

Choose this method of creating a customer credit if a customer wants a 
refund for part of a non-item sale. For example, a customer paid you in 
advance for a seminar and workshop but attended only the seminar. You 
want to return the payment for the workshop portion of the sale. 

1 Create an account in your Accounts List to track your refunded sales. This 
is normally an expense account called Sales Refunds. For more 
information, see ‘To create a new account’ on page 28. 

2 Display the Sales Register and click the All Sales tab. 

3 Click New Sale. 

4 Enter the customer details and choose the Miscellaneous layout.

5 Enter a description of the refunded sale and select the account to be 
credited. This should be the Sales Refunds account you created in Step 1.

6 Click Record. 

RETURN OF AN ITEM SALE

Choose this method of creating a customer credit if you want to credit the 
customer for a returned item. 

1 Display the Sales Register and click the All Sales tab. 

2 Click New Sale. 

3 Enter the customer’s name, date and other details. 

4 Choose the Item layout. 

5 Enter negative quantities in the Ship column for the items being returned.  
For example, if a customer is returning two of the five wreaths you sold 
them, enter -2 in the Ship column. The price of the wreaths appears as 
negative in the Total column.

6 Click Record. 
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Settling customer credits

When you create a customer credit, it remains in the system until it is 
settled; you don’t need to settle credits immediately. You can find 
outstanding customer credits in the Returns & Credits view of the Sales 
Register. 

You can choose from two ways of settling a customer credit:

! By applying the customer credit to one or more of the customer’s unpaid 
sales, thereby reducing the amount of money the customer owes you. 

! By writing a refund cheque for the amount of the customer credit (see 
‘To write a refund cheque’ on page 87).

To apply customer credits

Follow the steps below to locate the customer credit you want and then 
apply the credit to one or more of the customer’s sales balances.

1 Display the Sales Register and click the Returns & Credits tab.

2 Click the Search By down arrow and choose Customer. Enter the 
customer’s name in the adjacent field. The customer’s list of credits 
appears. 

3 Select the credit you want to apply and click Apply to Sale. 

The Settle Returns & Credits window appears, listing all open sales 
assigned to the customer.

If you marked the Apply Customer Payments Automatically to Oldest 
Invoice First preference in the Sales view of the Preferences window, 
amounts will appear next to the oldest invoices in the Amount Applied 
column. BusinessBasics is suggesting that you apply the credit to the 
customer’s oldest open sales; but you can apply the credit amount to any 
one transaction—or divide it among many transactions—in the list. Keep 
in mind though that the total amount you apply in the Amount Applied 
column must equal the amount that appears in the Credit Amount field.

4 Enter the amounts you want to apply to each open sale in the appropriate 
field in the Amount Applied column. 

5 Click Record. 

If the transaction is unbalanced... If the transaction is unbalanced, that 
is, if the total amount entered in the Amount Applied column doesn’t 
equal the amount displayed in the Credit Amount field at the top of the 
window, a message will appear. Click OK to close the message. Then check 
that the amounts you have applied to the various transactions are correct. 
If you change the amount in the Credit Amount field, keep in mind that 
you can only enter an amount less than the original customer credit 
amount. If you choose to do this, the customer credit won’t be fully 
applied; the remaining amount will continue to appear as a credit.

6 Click Record to apply the customer credit.
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To write a refund cheque

You can choose to pay the customer for the amount of a customer credit 
using the Pay Refund function in the Sales Register. 

1 Display the Sales Register and click the Returns & Credits tab.

2 Click the Search By down arrow and choose Customer. Enter the 
customer’s name in the adjacent field. A list of credits for that customer 
appears. 

3 Highlight the credit you want to refund and click Pay Refund. A refund 
cheque for the amount of the customer credit appears in the Settle 
Returns & Credits window. 

4 Make any necessary changes to the information in the window.

If you change the amount in the Orig Amount field, keep in mind that you 
can only enter an amount less than the original customer credit amount. If 
you choose to do this, the customer credit won’t be fully settled; the 
difference will continue to appear as a customer credit.

5 Click Record to record the refund cheque or click Print to print and record 
the refund cheque. For more information about printing cheques, see 
‘Using Forms’ on page 127. 

Useful reports

SALES REGISTER RETURNS & CREDITS REPORT

Run this report to view a list of credits for a customer or all customers for a 
specific period.
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Reviewing your sales information

An important part of managing your business involves collecting your sales 
data and understanding its effects on your overall financial picture. MYOB 
BusinessBasics contains the tools that you can use to view your sales 
information so you can make better decisions about your business. 

! Sales reports—they can help you keep track of your sales activity. 

! Sales history—you can view seven years of sales history for an item or a 
customer: for the past five years, the current year and the next year. 

! Analyse receivables—you can view detailed information about the 
customers who owe you money and how long they’ve owed you.

Viewing sales reports 

There are several sales reports in BusinessBasics that can help you track 
your sales activity. Listed below are some of them. 

For information about displaying and printing reports, see ‘Using Reports’ 
on page 113.

CUSTOMER ANALYSE SALES [SPREADSHEET] REPORT

This report displays total sales for the selected customers within a range of 
accounting periods, based on recorded invoices, not including quotes.

This report gives you the relative value of each customer to your business. 
Be sure to run this report before important conferences with a customer. 

INVOICE TRANSACTIONS REPORT

View details of a single invoice or multiple invoices.

ITEM SALES SUMMARY AND DETAIL REPORTS

These reports can tell you what’s selling and what’s not, useful for deciding 
whether you need to re-order a particular item. 

ANALYSE RECEIVABLES SUMMARY AND DETAIL REPORTS

Next to keeping your customers satisfied, getting them to pay you in a 
timely manner is one of the most important tasks in running a small 
business.

Run these reports to find out who owes you money and for how long.

Viewing sales history

Find out at a glance what items have been selling and who’s been buying, 
using the History view of your item and customer records. 

! To view sales history for a customer, simply display the customer’s card 
and click the History tab. BusinessBasics keeps track of what the 
customer has spent on a monthly basis. You can also check the 
customer’s last payment date, highest invoice amount, and other useful 
information. 

If you’ve entered the customer’s sales figures for previous years, use the 
arrow keys for a quick month by month comparison between previous 
years’ sales and this year’s.

! To view sales history for an item, display the item record and click the 
History tab. For each month of your financial year, BusinessBasics tracks 
the number of units you’ve sold of the item and the revenue from the 
sales. If you entered the item’s sales figures for previous years, you can 
view these figures as well by clicking the arrows in the upper right 
corner of the window. 

Analysing receivables

You can use the Analyse Receivables window to view detailed information 
about the customers who owe you money and how long they’ve owed 
you. 
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1 Go to the Sales command centre and click Analyse Receivables. The 
Analyse Receivables window appears.

2 Click Filters and set the criteria for how information about the customers 
who owe you money will appear in the Analyse Receivables window. 

a Choose how you want the overdue amount to be calculated. Choose:

# Calculate Overdue Since Invoice Date if you want to view information 
about the money owed to you based upon the number of days that 
have passed since sales were recorded.

# Calculate Overdue Using Invoice Terms if you want to view 
information about the money owed to you based upon the number 
of days payments are overdue, as determined by customers’ credit 
terms.

b Enter a date from which BusinessBasics can base the number of days 
since the invoice date in the Receivables As Of field.

c If you want to include closed invoices in the analysis, mark the Include 
$0.00 Balance Invoices checkbox. (This function can be handy if you’re 
searching for a particular sale and you’re not sure whether its entire bal-
ance is paid.) Click OK. 

The Analyse Receivables window appears. Three views are available for 
this window: Summary, Customer Detail and Sale Detail.

3 Select the appropriate view. Select:

# Summary to view all the money owed to you, totalled by customer. 
# Customer Detail and enter a customer’s name in the adjacent field to 

display all the money that’s owed to you by this customer.
# Sale Detail and select a sale (using the search icon ) to view all the 

transactions assigned to the sale, such as payments and credits.

The scrolling list area of the Analyse Receivables window displays the 
information you want based on your selections. 

In this example, the outstanding invoices for customer A-Z Stationery 
Suppliers are displayed. 

The ageing columns (1–30, 31–60, 61–90, 90+) display the number of 
days the amount in the Total column has been due. 
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6In MYOB BusinessBasics, the records you create—for customers, items, jobs, tax codes, etc.—are 
stored in lists. For example, your Accounts List contains all your accounts; your Tax Codes List all 
your tax codes and your Cards List, records of your customers, suppliers, employees and personal 
contacts. These lists can be accessed from the Lists menu. 

While lists are useful in themselves for maintaining all your records in one location, their main 
purpose in BusinessBasics is to make transaction entry easier for you. For example, when you enter 
a sale, you use lists to retrieve the record of the customer you’re selling to, the item you’re selling, 
and the account, job and tax code you’re using for the sale.

As you keep adding new records to your lists, you may find it takes more time to locate the record 
you need. That's why BusinessBasics gives you the ability to categorise, make inactive (archive) 
and delete records from your lists. It also provides useful search functions to find a record easily.

You can modify records in lists so they contain the most up to date information. For example, a 
customer record can be updated easily to include the customer’s new shipping address, and an item 
record can be changed to reflect the new price.

If you want to enter additional details in a card or item record, such as an employee’s employment 
status or an item’s brand, you can use the custom lists and fields that BusinessBasics provides; this 
chapter shows you how to set them up.
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Finding a record

As you continue to use BusinessBasics and keep adding records of new 
customers, accounts, jobs and items, you may find search lists that were 
once short and manageable growing quite lengthy and locating a record 
taking longer than it used to.

Fortunately, BusinessBasics provides you with the tools to help you locate a 
record quickly; use them and save time. 

HINT : Inactivate records you rarely use and keep lists short Did you 
know you can temporarily inactivate records you don’t use often? This is an 
ideal way of keeping search lists short and manageable. See ‘Inactivating a 
record’ on page 97.

Tabs

Some lists are divided into separate views or tabs. For instance, the 
Accounts List is divided by account type into six tabs, making it easier for 
you to find an account. If you are looking for an expense account, simply 
click the Expense tab. Within the tab, you can use the scroll bar to find the 
record.

Search fields

The Cards List and Items List have a Search field that you can use to locate 
a record quickly. Simply type a few characters of the card name or item 
number in the Search field and press TAB.

If you have specified in the Preferences window that you want to select 
items by item name and cards by card ID, enter part of the item name or 
card ID instead and press TAB. The record that most closely matches your 
entry will be highlighted in the list.
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Look for fields
Look for fields can be found in selection lists that appear when you search 
for a record from a transaction window, such as the Bank Register. They 
work just like Search fields. In the following example, locating an expense 
account is made easy by entering the prefix of expense accounts, which is 
1, and pressing TAB. 

Changing a record

In BusinessBasics, you can easily and conveniently update information you 
initially entered for your records. You can, for instance, update contact 
details for a card or the selling price of an item by displaying the record 
and typing in the changes.

WHAT HAPPENS WHEN I CHANGE A RECORD THAT HAS BEEN USED 
IN A TRANSACTION?

BusinessBasics keeps it simple. If you change the name, number or detail of 
a record that has no impact on a transaction’s balance, then all of the 
transactions you’ve entered using that record are updated to reflect the 
change. 

For example, if your customer’s company name changes from Design Tech 
to Redac Inc., all transactions already made to Design Tech are updated 
automatically to reflect the name change. This saves you the confusion of 
maintaining two separate records for the same customer. 

On the other hand, if you make changes to a record that does affect a 
transaction’s balance (such as an item’s selling price or the rate of a tax 

code) transactions you’ve entered previously using that record are not 
updated. 

For example, if you change an item’s selling price from $6 to $8, 
transactions you’ve recorded with the old price will retain that price. The 
new price applies to any new transactions you enter. 

To make changes to a record

The steps for changing a record are the same for all types of 
records—accounts, cards, items, jobs and tax codes. You display the 
record in the original window, make your changes by typing in the new 
details and click OK. It’s that easy. 

Let’s assume that you’ve increased the rate you charge for initial 
consultation from $18 to $22 an hour and want to update the item record. 

1 Display the list the record belongs to using the Lists menu. In our example, 
this is the Items List. 
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If you were updating a tax code, you would display the Tax Code List; if it 
were a card, the Cards List, and so on. 

2 Locate the record you want to change in the list and click the zoom arrow 
next to it. (Use a search method described in ‘Finding a record’ on page 92 
if necessary.)

The record details are displayed in the Information window. In our 
example, this is the Item Information window.

3 Make the necessary changes by typing over the existing details and click 
OK to save your changes. 

Changing the level of an account

The level an account takes in your Accounts List depends on whether it is a 
Header or Detail account and on the account number you assign to it. (See 
‘What are account levels?’ on page 27 for more information.)

If you want to change the level of an account in your Accounts List in order 
to change its hierarchy, you can do so from the Accounts List window.

NOTE : Some account levels can’t be changed A Detail account can’t be 
changed to a Header account if you have assigned transactions to that 
account. 

To change the level of an account

1 Go to the Accounts command centre and click Accounts List. Your 
Accounts List appears. 

2 Highlight the account. 

3 If you want to move the account up a level, click Up. If you want to move 
the account down a level, click Down. (If either button is grey, the account 
cannot be moved to that level.)
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Deleting a record

If you are partway through creating a new record and want to delete it, 
simply go to the Edit menu and choose Delete.

You will find it much harder to delete a record once it has been created and 
you’ve used it in a transaction. This is BusinessBasics’ way of protecting the 
accuracy of your accounting data since records once deleted are 
permanently removed from your company file. This section details the 
criteria records must meet before they can be deleted.

HINT : Inactivate a record rather than delete it If you are deleting a 
record that you think you might use again in the future, why not 
temporarily inactivate it instead? See ‘Inactivating a record’ on page 97.

Deleting an account

You can remove an account from the BusinessBasics system if the account 
meets the following criteria:

! The account isn’t a Level 1 (header) account.

! The account has a zero balance.

! No journal entries are assigned to the account.

! None of your recurring transactions use the account.

! The account has not been used in any transactions, that is, you have not 
allocated a transaction to the account.

! The account isn’t linked to any of the items you’ve entered in the Item 
Information window. 

! The account isn’t linked to a tax code (in the Tax Code Information 
window) or to a customer card (in the Selling Details view of the Card 
Information window).

To delete an account

1 Make a backup of your company file. See ‘Backing up your company file’ 
on page 155.

2 Go to the Accounts command centre and click Accounts List. The 
Accounts List window appears.

3 Click the zoom arrow next to the account you want to delete so that the 
account details are displayed in the Edit Accounts window.

4 Go to the Edit menu and choose Delete Account.

Deleting a card

You can delete a card from the BusinessBasics system if the card meets the 
following criteria:

! The card has not been used in a transaction. The only way you can 
delete a card that has been used in transactions is by first deleting these 
transactions. See ‘Deleting a transaction’ on page 108.

! The card has not been used in a quote or a recurring template.

! The (customer) card is not linked to a job. 

To delete a card

1 Go to the Lists menu and choose Cards. The Cards List window appears.

2 Find the card you want to delete in the list and click the zoom arrow next 
to it. The Card Information window appears. 

3 Go to the Edit menu and choose Delete Card. 
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Deleting an item 

You can delete an item from the BusinessBasics system if the item meets 
the following criterion:

! The item has not been used in a transaction in the current financial year. 
The only way you can delete an item that has been used in transactions 
is by first deleting these transactions. See ‘Deleting a transaction’ on 
page 108.

To delete an item

1 Go to the Lists menu and choose Items. The Items List window appears.

2 Find the item you want to delete in the list and click the zoom arrow next 
to it. The Item Information window appears. 

3 Go to the Edit menu and choose Delete Inventory Item.

Deleting a tax code

You can delete a tax code from the BusinessBasics system if the tax code 
meets the following criteria:

! The tax code has not been used in a transaction in the current financial 
year. The only way you can delete a tax code that has been used in 
transactions is by first deleting these transactions. See ‘Deleting a 
transaction’ on page 108.

! The tax code has not been used to create a consolidated tax code. 

To delete a tax code

1 Go to the Lists menu and choose Tax Codes. The Tax Codes List window 
appears.

2 Find the tax code you want to delete in the list and select it. 

3 Go to the Edit menu and choose Delete Tax Code.

Deleting a job

When you delete a job that has been used in transactions, the job is also 
removed from the transactions in which you’ve used it. 

To delete a job 

1 Go to the Lists menu and choose Jobs. The Jobs List window appears.

2 Find the job you want to delete in the list and click the zoom arrow next to 
it. The Job Information window appears. 

3 Go to the Edit menu and choose Delete Job.
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Inactivating a record

Inactivating records you use infrequently is a great way of keeping your 
selection lists short and up to date, and at the same time keeping these 
records handy for future use. 

For example, Worzel’s Gift Shop sells mostly seasonal items such as 
Mother’s Day cards, graduation bears and Halloween costumes; Worzel is 
also in the habit of hiring the same temp staff to work during the busy 
holiday season. Rather than deleting these item and employee records, he 
inactivates them when they are not being used. 

By inactivating records, you remove them temporarily from your selection 
lists (not the main List window). This keeps your selection lists down to 
only the records you use regularly. If you ever need to re-use an inactive 
record, you can either enter the record name manually in a transaction 
window or re-activate it with just a click of the mouse. 

Regardless of the status of a record—active or inactive—transactions 
recorded using it will still affect all of your financial records. 

To inactivate a record 

1 Display the list the record belongs to. For example, if you are inactivating 
a card, display the Cards List window. You can do this by using the Lists 
menu. 

2 Locate the record you want to inactivate and click the zoom arrow next to 
it. The record details are displayed. For cards and items, make sure the 
Profile tab appears. 

3 Mark the Inactive checkbox. In the example below, the Inactive Item 
checkbox is marked. 

4 Click OK to clear the message that appears and then click OK again. The 
record will no longer appear in selection lists. 

To re-activate a record 

1 Display the list the record belongs to. For example, if you are reactivating 
an item, display the Items List window. You can do this by using the Lists 
menu. 

2 Locate the record you want to re-activate and click the zoom arrow next to 
it. The record details are displayed. For cards and items, make sure the 
Profile tab appears. 

3 Clear the Inactive checkbox and click OK. The record now re-appears in 
selection lists. 

Displaying inactive records in reports

When you view or print a report listing your records—for example, the 
Jobs List report, the Card List report or the Accounts List report—you can 
set the filters to include or exclude your inactive records in that report. 
Simply mark the Include Inactive <Records> checkbox in the Report 
Customisation window. For more information about filtering reports, see 
‘Determining the amount of information included on a report’ on 
page 115.
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Adding a picture to a record

In addition to maintaining detailed descriptions of your records, 
BusinessBasics can store pictures of your cards and items—ideal for those 
employee ID photos, and for keeping a pictorial record of the items you 
sell. Pictures are displayed in the Card Information window or the Item 
Information window.

BusinessBasics supports BMP and a variety of other popular graphic 
formats.

The pictures are stored in the Graphics folder within your MYOB 
BusinessBasics program folder. If you move your company file, you must 
also move the Graphics folder to the same location to continue displaying 
the pictures. 

To link a picture to a card or item

1 Display the card in the Card Information window (or item in the Item 
Information window). 

2 Click the Card Details (or Item Details) tab and double-click the picture 
file area. The Picture Information window appears.

3 Click Link. The Open dialog box appears.

4 Locate the graphic file you want to display for this card or item and then 
click Open. The Picture Information window appears, with the selected 
picture appearing on the right.

5 Click OK. The picture appears in the Card or Item Details tab.

To change the picture

1 Display the Card Details view of the Card Information window (or the 
Item Details view of the Item Information window) and double-click the 
existing picture. The Picture Information window appears. 

2 Click Link. The Open dialog box appears.

3 Locate the new graphic file you want to use and click Open. The new 
picture appears in the Picture Information window. Click OK. 

To remove a displayed picture

1 Double-click the picture in the Card Details or Item Details tab.

2 Click Unlink and then click OK. The graphic disappears from the Card 
Details or Item Details tab but remains in the Graphics folder.
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Creating custom lists and fields

If you need to record additional information about your items and cards 
that may be specific to your business, you can use the custom lists and 
fields that BusinessBasics provides. 

Custom fields allow you to enter any information you like—for example, 
they can be used to indicate an employee’s last review date or a supplier’s 
credit terms. You can then use the Report Design feature to display that 
information in your reports. 

Custom lists enable you to create lists of pre-defined attributes that 
remain standard over time and can be used to sort your cards and items. 
For example, a shoe store can use custom lists to record the colour, size 
and brand of shoes they sell. Then, using BusinessBasics’ report filters, they 
can run a report to determine the profit from sales of size 12, black, 
Monteo Sabatini boots—great for deciding whether to re-order any more 
pairs from the supplier or discontinue the product. 

Creating custom fields

There are three custom fields for items and for each card type. They appear 
in the Card Details view of the Card Information window for cards and in 
the Item Details view of the Item Information window for items.

1 Go to the Lists menu and choose Custom Lists and Field Names and then 
choose the type of record for which you want to create custom fields. For 
example, to create custom fields for employee cards, choose Employees. 

2 Enter the new field names in the Name of Custom Field fields.

3 Click OK. Depending on the type of record you selected in Step 1, these 
field names will now appear either in the Item Details view of the Item 
Information window for all items, or in the Card Details view of the Card 
Information window for the specific card type.
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In our example, the custom fields with their new labels appear in the 
employee’s card.

You can now use these fields to record the relevant information.

PRINTING CUSTOM FIELDS ON YOUR INVOICES

You can customise your invoices to include custom fields. For example, if 
you’ve got a customer loyalty program and use the custom field to record 
customers’ reward points, you can include these points on their invoices. 
For more information on customising forms, see ‘Customising forms’ on 
page 131. 

Creating custom lists

You can create three custom lists for items and for each card type. Custom 
lists can be used to sort and group your items and cards. 

Creating custom lists includes the following steps:

# Step 1—Name the custom list
# Step 2—Create custom list entries
# Step 3—Assign a custom list entry to a record

Step 1—Name the custom list

1 Go to the Lists menu, choose Custom Lists and Field Names, and then 
choose the record for which you want to create custom lists.

2 Enter labels for the custom lists in the appropriate fields. In our example, 
we have labelled the three custom lists belonging to items.

3 Click OK. These custom list names will now appear in the Item 
Information window for all items or the Card Information window for 
the selected card type, depending on the type of record you selected in 
Step 1.

Now that you have labelled the custom lists, the next step is to create 
custom list entries. Follow the instructions below. 
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Step 2—Create custom list entries

1 Go to the Lists menu, choose Custom Lists and then the record for which 
you want to create custom list entries. The Custom Lists window appears. 

2 Click the Custom List drop-down list and choose the list for which you 
want to make entries.

3 Click New and enter the name of the list entry.

4 Repeat Step 3 until you have created all your list entries. Click OK and then 
click Close.

Step 3—Assign a custom list entry to a record

1 Display the Item Details view of the Item Information window for items 
or the Card Details view of the Card Information window for the card. 

2 Click the search icon  next to a custom list and select an entry. Click OK.

HINT : Easy-Add an entry To quickly add an entry to a custom list, type 
the entry in the field and press ENTER. In the Select From List window that 
appears, click Easy Add. The entry is added to your custom list. 

The many uses of custom lists

USE CUSTOM LISTS TO FILTER REPORTS

You can generate reports using custom lists as filters to include only those 
records with a certain list entry. For more information on setting report 
filters, see page 115.

USE CUSTOM LISTS AS FILTERS WHEN EXPORTING CARDS

You can export your cards from MYOB BusinessBasics to another software, 
using custom lists as filters. For more information, see ‘Exporting data from 
MYOB BusinessBasics’ on page 168.

PRINT CUSTOM LISTS ON YOUR INVOICES

You can customise your invoices to include custom lists. See ‘Customising 
forms’ on page 131 for more information. 
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Customising sales information lists

BusinessBasics provides you with standard lists of comments, shipping 
methods and payment methods to choose from when you enter a sale. 
You can customise these lists to suit the needs of your business. 

To add a comment, payment method or shipping 
method

1 Go to the Lists menu, choose Sales Information and then either 
Comments, Shipping Methods or Payment Methods, depending on the 
type of record you want to add. The Sales Information window appears. 

2 Click New.

3 Type the new comment, shipping method or payment method. If you are 
adding a payment method, also specify the method type. Click OK. 

In the example below, we are adding the MasterCard to the list of 
payment methods.

HINT : Easy-Add an entry during a sale You can quickly add a comment, 
payment or shipping method during a sale by typing it in the appropriate 
field in the Sales window and pressing TAB. In the Select From List window 
that appears, click Easy Add. The entry is added to your list. 

To change a comment, payment method or shipping 
method

1 Display the Sales Information window using the Lists menu.

2 Find the record you want to change and click the zoom arrow next to it. 

3 Make the necessary changes to the record and click OK.

To delete a comment, payment method or shipping 
method 

1 Display the Sales Information window using the Lists menu.

2 Find the record you want to delete and select it. 

3 Go to the Edit menu and choose Delete.

CAUTION : (Australia) Don’t delete the MYOB Pay Services payment 
method If you use the Customer Payments Service, do not delete the 
MYOB Pay Services payment method. This payment method is required 
when entering payments that were processed using the Customer 
Payments Service.
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7Occasionally, you may need to locate and review a cheque, sale, or other type of transaction you’ve 
entered in BusinessBasics. For example, you may need to fix the odd error, reprint an invoice for a 
customer or review your sales. BusinessBasics provides search tools that make it easy to locate a 
transaction. 

Transactions can be located using various search criteria. For example, you can perform a simple 
search to find all cheques you’ve entered for a particular period or, you can use additional search 
criteria to find, say, a particular cheque for the amount of $200 where the memo contains the 
words “Telephone”.

Once you have found the transaction you need, you can view it in detail in the window in which 
you originally entered it. Here you can change the details of the transaction or delete it altogether. 
If you prefer not to alter a transaction once you’ve entered it, BusinessBasics gives you the option of 
reversing the transaction instead. This way the transaction remains unchanged but has no effect 
on your accounts. This keeps your audit trail complete. 

Given that businesses have many repetitive transactions that occur weekly, monthly or yearly, 
BusinessBasics allows you to set up recurring transactions. You can tell BusinessBasics to 
remember and remind you about important transactions such as rent, wages and utility bills. If 
you need to, you can even set up recurring journal entries to record depreciation of your assets such 
as your motor vehicle and computer on a monthly basis.
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Finding a transaction 

The transactions you enter day to day in BusinessBasics—sales, payments, 
cheques, deposits—are all saved in your company file in one convenient 
location. If you need to retrieve a transaction for whatever reason, 
BusinessBasics provides you with the tools to find it quickly. 

Let’s assume that one of your customers, Chelsea Mosset, has misplaced 
the invoice for some items she purchased from you several months ago. 
She has requested another copy of it for tax purposes. 

Before attempting to find a transaction in BusinessBasics, first ask yourself 
two questions: what type of transaction am I looking for (sale, cheque, 
receipt, etc.) and what information do I have at hand (the customer’s 
name, invoice number, deposit date, etc.). This usually determines the 
search tool you will use. The four search tools—Find Transactions, Sales 
Register, Bank Register and Transaction Journal—are described in detail 
below. 

FIND TRANSACTIONS

Find Transactions has been designed to help you do just that—find any 
type of transaction you have recorded in BusinessBasics, including General 
Journal entries, invoices, cheques, deposits and customer payments. 
Numerous search filters in the Find Transactions window make the task 
easier—you can search for a transaction using date ranges, account 
numbers, cards, job numbers, invoice numbers and much more. And if the 
search yields too many results, you can narrow it further using advanced 
filters such as source journal, transaction ID, amount and memo. So even if 
all you remember about a cheque you wrote is that it was for 
approximately $300, you can still locate it using Find Transactions.

SALES REGISTER

The Sales Register keeps all your sales transactions in one handy location, 
ready to be retrieved with a few mouse clicks. The Sales Register is your 
best bet for finding any type of transaction relating to sales: open invoices, 
closed and recurring invoices, quotes, credits and returns. The search is 
quicker if you know the transaction date or the customer’s name. 

BANK REGISTER

One of the many uses of the versatile Bank Register is as a search tool for 
locating cheques, deposits, sales and payments. Although you may not 
use it as your main search tool, the Bank Register can be quite handy for 
looking up a transaction on the fly. The search is quicker if you know the 
date the transaction was entered or the account that was used. 

TRANSACTION JOURNAL

You may rarely need to use the Transaction Journal as a search tool. 
However, just be aware that you can search for transactions by source 
journal using the Transaction Journal. You can also see what accounts were 
credited and debited for a particular transaction. 
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To find a transaction using Find Transactions

1 Click Find Transactions from any command centre. The Find 
Transactions window appears. 

2 Click the appropriate tab—for example, the Account tab to search by 
account, the Jobs tab to search by job, and so on. 

3 Filter your search using the Search By and Dated From and To fields. 

4 If you want to use more advanced search filters or narrow the results of 
your initial search further, click Advanced. This window presents 
additional filters that you can use.

For example, if you want to trace a deposit you made for approximately 
$80 but can’t remember the account or the deposit date, choose to search 
by all accounts and enter 70 – 90 in the Amount range fields. 

5 When the transaction(s) that fit your search criteria are displayed in the 
Find Transactions window, click the zoom arrow next to the transaction 
you want to view in detail.

NOTE : No zoom arrow If a transaction doesn’t have a zoom arrow next 
to it, this indicates that you have purged the entire transaction. For more 
information about purging transactions, see ‘Purging information that is no 
longer needed’ on page 161. 

To find a transaction using the Sales Register

The Sales Register gives you easy access to transactions relating to sales.

1 Go to the Sales command centre and click Sales Register. The Sales 
Register appears. 

2 Click the appropriate tab—for example Open Invoices.

3 Filter your search using the Search By and Dated From and To fields. 

4 When the transaction(s) that fit your search criteria are displayed in the 
Sales Register, click the zoom arrow next to the transaction you want to 
view in detail.
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To find a transaction using the Bank Register

You can use the Bank Register to find cheques, deposits, invoices and 
customer payments.

1 Go to the Banking command centre and click Bank Register. The Bank 
Register appears. 

2 Specify the cheque or credit card account you used for the transaction in 
the Account field. 

3 Enter the date range within which the transaction was recorded in the 
Dated From and To fields. All transactions between (and including) these 
dates will be listed.

4 Locate the transaction you want using the scroll bar and then click the 
zoom arrow to the left of the transaction to view it in its original window.

To find a transaction using the Transaction Journal 

The Transaction Journal groups all your accounting entries into one of five 
journals: General, Disbursements, Receipts, Sales and All.

1 Click Transaction Journal from any command centre. The Transaction 
Journal window appears.

HINT : Use the Journal button You can also display the Transaction 
Journal window by clicking Journal in a transaction window such as Sales.

2 Click the appropriate tab—for example, the Sales tab to find a sales 
invoice, the Disbursements tab to find a cheque, and so on.

3 Enter the date range within which the transaction was recorded in the 
Dated From and To fields. All transactions between (and including) these 
dates will be listed. 

4 Locate the transaction you want using the scroll bar. Then click the zoom 
arrow next to the transaction to view it in its original window.

NOTE : No zoom arrow If a transaction doesn’t have a zoom arrow next 
to it, this indicates that you have purged the entire transaction. For more 
information about purging transactions, see ‘Purging information that is no 
longer needed’ on page 161.
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Changing a transaction

You can edit the transactions you’ve recorded only if transactions in your 
company file are changeable. What this means is that you’ve turned off the 
Transactions CAN’T be changed; they must be reversed security 
preference which prevents transactions from being altered. A changeable 
transaction is distinguished in lists by a white zoom arrow next to it.

CHECK WITH YOUR ACCOUNTANT FIRST

If your accountant requires that you maintain a strict audit trail of your 
accounting records, you should consider leaving this security preference 
on and reversing the transaction instead (see page 109).

If, on the other hand, your accountant has advised you to make the 
necessary changes, you can turn this preference off from the Security view 
of the Preferences window (go to the Setup menu, choose Preferences 
and then click the Security tab).

When you make any changes to a transaction, your records are 
permanently altered. Consider this carefully before you change any 
transaction details.

SOME TYPES OF TRANSACTIONS CAN’T BE CHANGED

Regardless of your security preference setting, there are some types of 
transactions that can’t be edited. They are customer payments, refund 
cheques and bank deposits. If you want to remove the effects of these 
transactions from your books, you can either delete them (see ‘Deleting a 
transaction’ on page 108) or reverse them (see ‘Reversing a transaction’ 
on page 109).

To change a transaction

1 Find and display the transaction in its original transaction window.

To do this, use one of the search methods described in ‘Finding a 
transaction’ on page 104. Once you have found the transaction, click the 
zoom arrow next to it to display the transaction in the main transaction 
window. For example, if you want to change a quote, locate the quote 
using the Sales Register; then click the zoom arrow next to it to view the 
quote in the Sales window. 

2 Make the necessary changes to the transaction by typing over entries 
you’ve made or by making different selections from lists.

3 Click OK when you’re done. The transaction is recorded with the new 
details you entered. 
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Deleting a transaction 

If you are part way through entering a transaction, you can erase your 
entries and start again by choosing Erase from the Edit menu.

Occasionally though, you may need to delete a transaction you’ve already 
recorded—for instance you entered the same transaction twice by 
mistake. In order to be able to delete transactions, the Transactions 
CAN’T be changed; they must be reversed security preference must be 
turned off. 

CHECK WITH YOUR ACCOUNTANT FIRST

If your accountant requires that you maintain a strict audit trail of your 
accounting records, you should consider leaving this security preference 
on and reversing the transaction instead (see page 109).

Otherwise, you can turn this preference off from the Security view of the 
Preferences window (go to the Setup menu, choose Preferences, and 
then click the Security tab).

When you delete a transaction, it is permanently removed from your 
records. Consider this carefully before you delete a transaction.

NOTE ABOUT DELETING TRANSACTIONS

In BusinessBasics, transactions must meet certain criteria before they can 
be deleted. 

Sales You can only delete a sale that does not have a payment applied to 
it. If you have recorded a customer payment for a sale, you must first 
delete the payment before deleting the sale. 

If you applied a customer credit towards the sale, the customer credit must 
be deleted before the sale can be deleted.

Receipts grouped in the Undeposited Funds account If you want to 
delete an individual receipt that was included in a bank deposit 
transaction, you must first delete the bank deposit. When you delete a 
bank deposit, all receipts included in the bank deposit are returned to the 
Prepare a Bank Deposit window. You can then delete the receipt from 
this window. 

Reconciled transactions Keep in mind that if you delete a reconciled 
transaction, your bank reconciliation will be out of balance. 

To delete a transaction

1 Find and display the transaction in its original transaction window. For 
example, if you want to delete a cheque, locate the cheque using Find 
Transactions; then click the zoom arrow next to it to view details of the 
cheque. If you need help finding a transaction, see ‘Finding a transaction’ 
on page 104 for instructions.

2 Go to the Edit menu and choose Delete. The transaction is removed 
permanently from your records.
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Reversing a transaction

If your accountant requires that you maintain an audit trail of all your 
accounting entries, you should reverse a transaction rather than change or 
delete it. 

When you reverse a transaction, a new transaction is created that reverses 
the effects of the original transaction. For example, you accidentally 
entered a cheque for $130 from your cheque account and allocated it to 
your electricity expense account. When you reverse this transaction, a new 
transaction is created, which refunds $130 to your cheque account and 
reduces $130 from your electricity expense account. After you create a 
reverse transaction, you have two transactions (the original and the 
reverse), but the current account balances appear as if the original 
transaction never happened. 

You can only reverse a transaction if it is unchangeable, that is, if the 
Transactions CAN’T be changed; they must be reversed preference is 
turned on in the Security view of the Preferences window. An 
unchangeable transaction is distinguished in lists by a grey zoom arrow 
next to it.

NOTE : Making changeable transactions unchangeable You can make a 
changeable transaction unchangeable at any time simply by turning on this 
preference in the Security view of the Preferences window (go to the 
Setup menu, choose Preferences and then click the Security tab).

When you reverse a transaction, remember that you can’t change the 
accounts or amounts. Also be aware of the date of a reverse transaction. If 
you use the current date when you reverse a transaction from a prior 
month, the month-end financials for the prior month will not reflect the 
reverse transaction. If you use the original date for the reverse transaction, 
your prior month financials should be reprinted because they would have 
changed. 

To reverse a transaction 

1 Check that the Transactions CAN’T be changed; they must be reversed 
preference is turned on in the Security view of the Preferences window 
(go to the Setup menu, choose Preferences and then click the Security 
tab). 

2 Find and display the transaction in its original transaction window. For 
example, if you want to reverse a sale, locate the sale using the Sales 
Register; then click the zoom arrow next to it to view details of the sale. If 
you need help finding a transaction, see ‘Finding a transaction’ on 
page 104 for instructions.

3 Go to the Edit menu and choose Reverse. After a few moments, a new 
transaction appears, with a correspondng negative value in the the 
amount in the original transaction.

If you want, you can make a few changes to the new transaction, such as 
the date and memo, but you can’t change the accounts and amounts that 
are associated with it. 

4 Click Record to save the reversed transaction. At this point, the transaction 
is reversed and all account balances are returned to their previous levels. 
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Working with recurring transactions

If you have a transaction that must be written time and time again—for 
example, a rent cheque or an employee paycheque—you can save it as a 
recurring transaction. 

When you save a transaction as recurring, BusinessBasics puts a copy of it 
in a separate list of recurring transactions. Any time you need to use one, 
all you need to do is simply click Use Recurring, select the appropriate 
transaction, verify the details and record it. 

You can make sales, cheques, deposits and General Journal entries 
recurring.

For example, Worzel pays his office rent on the fifth of every month. Rather 
than enter the cheque details manually each month, he creates a recurring 
cheque labelled “Rent cheque,” sets the frequency to Monthly and a 
reminder for every fifth day of the month.

To create a recurring transaction

1 Enter the details of the transaction in a transaction window, for example 
the Sales window or the Bank Register. Then, instead of clicking Record, 
click Save Recurring. The Save Recurring Template window appears.

2 Enter a name to identify the transaction, such as “Journal Subscription” or 
“Chuck Berry–Paycheque.” 

3 Specify the frequency of the transaction and a reminder date. 

If you specify the frequency and a reminder date, BusinessBasics will keep 
track of when the transaction is next due. These due dates will appear in 
recurring transaction reports (see ‘Useful reports’). You can run these 

reports regularly—say, fortnightly or at the beginning of the month—to 
keep on top of the transactions you need to enter for that period. 

4 Click Save Template to record the recurring transaction template.

Useful reports

RECURRING TRANSACTIONS GENERAL JOURNAL ENTRIES REPORT

Run this report to view a list of your recurring General Journal Entries and 
the dates they are next due. 

RECURRING TRANSACTIONS CHEQUES REPORT

View your recurring cheques and the dates they are next due.

RECURRING TRANSACTIONS DEPOSITS REPORT

View your recurring deposits and the dates they are next due.
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RECURRING SALES TEMPLATES REPORT

View your recurring sales and the dates they are next due. (You can also 
view a list of your recurring sales templates in the Recurring Templates 
view of the Sales Register.)

To use a recurring transaction

1 Click Use Recurring in a transaction window such as Sales, Record 
Journal Entry or Bank Register.

If you want to select a recurring sales template, click the Recurring 
Templates tab in the Sales Register.

A list of recurring templates that you’ve created appears. 

2 Select the template and click OK (click Use Recurring instead if you are in 
the Recurring Templates view of the Sales Register). The transaction 
appears, ready to be modified (if needed) and recorded.

3 Verify the date, amount, account and other details and make any 
necessary changes.

4 Click Record.

To change a recurring transaction

! To change a recurring transaction’s name or frequency, display the 
Recurring Templates view of the Sales Register (for recurring sales) or 
click Use Recurring in a transaction window. Select the transaction and 
click Edit Frequency. 

! To change the detail (memo, accounts, amounts, etc.) of a transaction, 
wait until the next time you need to use it. When the transaction 
appears, make the necessary changes before you record it. The next 
time you use the recurring transaction, the new detail will be displayed.

To delete a recurring transaction template

1 Display the Recurring Templates view of the Sales Register (for recurring 
sales templates) or click Use Recurring in a transaction window. A list of 
recurring transaction templates appears. 

2 Select the recurring transaction template you want to delete and click 
Delete.

Deleting a template only removes it from your list of recurring transaction 
templates. All actual transactions recorded previously using the template 
are not affected.
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8You've worked hard to keep your business records up to date! Now it's time to see how your business 
is really performing by looking at your reports.

BusinessBasics lets you see your business from nearly 60 different perspectives because that’s how 
many reports you have at your fingertips. These reports provide you with comprehensive 
information about your business, from a detailed profit and loss and balance sheet to a highly 
summarised sales by customer report.

You can access all your reports from one location—the Index To Reports. Each report has a 
description beside it, briefly summarising what the report contains. If you want to view the 
contents of a report and see how the information is presented, you can view a sample of it onscreen. 

You can display a report onscreen, print the report, and even fax it or attach it to an email message. 
You can also save the report as a text file readable by most programs, as an HTML report suitable 
for the Internet and as a PDF file.

BusinessBasics lets you customise the look and content of many reports to suit the needs of your 
business. For instance, you can filter a report to limit the information it contains to a particular 
period, account or customer. Reports can be designed to include or exclude specific details such as a 
customer’s credit limit or an item’s description. You can also modify the appearance of reports so 
that, for instance, the reports you print for your clients look more professional and formal than 
those you print for general company use. 

Make sure you spend some time looking at the reports. You will be amazed by the information 
BusinessBasics makes available to you about your business.
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Index To Reports

The Index To Reports window provides a single location where you can 
locate and work with your BusinessBasics reports. Using the Index To 
Reports window, you can:

! View lists of the reports available in BusinessBasics and read a short 
description of each report

! View an onscreen version of each report

! Choose the information you want to include on a report

! Change the appearance of a report

! Save a report as a PDF, HTML or text file on your hard disk or other disk

! Prepare to print a report 

! Prepare to email or fax a report

A Click a tab to view the reports associated with that tab. Click Custom to 
view your custom reports.

B Highlight a report and click View Sample to view a report sample and 
more detailed information about that report.

C Click Print to print the selected report.

D Click Send To to send the selected report by fax or email, or to save the 
report to disk as a PDF file, HTML file or text file.

E Click Customise to choose the information you want to appear on the 
selected report and to choose how you want that information to appear. 
See ‘Customising reports’ on page 115.

F Read a short description of the report you have selected here.

G Click Display to view an onscreen version of the selected report.

B DA GC E F
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Customising reports

MYOB BusinessBasics gives you the flexibility of changing almost every 
aspect of a report. You can customise your reports by:

! changing the amount of information included on a report 
(see page 115).

! changing the type of information included on a report (see page 117).

! changing the appearance of a report (see page 118).

You can use any combination of these three methods to customise a 
report. If you want, you can customise a report, print it immediately and 
then revert it back to its original settings. Or, if you want to retain a report’s 
modifications, you can customise the report and save the changed report 
as a custom report.

The following pages contain detailed information about customising 
reports and saving them. 

Reports are customised in the Report Customisation window (see 
screenshot). Some fields in this window differ, depending on the report 
you have chosen to customise. 

HINT : If you always customise your reports before printing or displaying 
them You can save time by turning on the Always Display Report 
Customisation Option Before Printing Reports preference in the Reports 
& Forms view of the Preferences window. The Reports Customisation 
window will be displayed automatically when you click Print or Display. 

Determining the amount of information included 
on a report

While reports are an invaluable tool for your business, they are of little use 
if they contain too much or too little information. This is why 
BusinessBasics gives you control of the amount of information you want 
included on a report. 

Using filters, you can tell BusinessBasics exactly what data you want 
included on a single report and for what period. A typical example is 
BusinessBasics Customer Sales Summary report. You can filter this report 
to view all your sales made to a customer’s for your entire financial year or 
limit it to just view quotes made to a customer in the first week of a 
particular month and year. This way, you don’t waste time or paper going 
through long reports containing unnecessary information. 
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To filter a report

1 Click Reports from any command centre. The Index to Reports window 
appears.

2 Using the tabs, find the report you want to view and select it.

3 Click Customise at the bottom of the window. The Report Customisation 
window appears. The filters in this window vary, depending upon the 
report you’re filtering.

4 Make the necessary entries and selections in the Report Customisation 
window.

5 Click OK to close the window. You can now print or display the report with 
the filters you selected. To print the report, see ‘Printing reports on your 
printer’ on page 121. To display the report, see ‘Displaying reports on your 
computer screen’ on page 121.

NOTE : Filters aren’t saved Filters you set for an individual report are used 
only if you print or display the report immediately after you set the filters. If 
you don’t print or display a report after you set its filters, and then change 
the filters of another report, the first report’s filters won’t be saved.

In the example below, the Customer Sales Summary report is being filtered 
to display open invoices for customer Chelsea Mosset for February 2002.

The filters above results in the following report.

HINT : Including currency symbols in reports You can display currency 
symbols next to amounts on your reports by marking the Include Currency 
Symbols in Reports checkbox in the Preferences window (go to the Setup 
menu, choose Preferences and then click the Reports & Forms tab). 

Using wildcards to filter reports

Wildcards are special characters that give you more flexibility in selecting 
various records, such as accounts and items, to print on reports that use 
that type of information.

You can use two wildcard characters, the asterisk (*) and the question mark 
(?), when filtering some reports.

THE ASTERISK

Using the asterisk in the Report Customisation window allows you to 
print a report for a specific group of records. For example, when filtering 
the Account Transactions report, if you want to select only the accounts 
whose numbers begin with 1, enter 1* in the Selected field in the Report 
Customisation window.

This will generate a report containing only accounts that begin with 1, 
which are all your asset accounts. 
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THE QUESTION MARK

Using the question mark wildcard, you can limit some reports to elements 
that contain only a specific number of characters. For example, to limit the 
Price Summary report to three-character item numbers that begin with C, 
enter C?? in the Selected field in the Report Customisation window.

Changing the type of information included on a 
report

You can control the type of information you want to include on a report by 
choosing the fields that appear on the report. For example, if you want to 
print a customer’s credit limit on a sales report, you can design the report 
so it includes the Credit Limit field. You can also choose the order in which 
information is printed on your reports.

HINT : Check out the existing reports before you design new ones

BusinessBasics reports are already set up to be comprehensive enough for 
most businesses. Before you design a report, try displaying it onscreen or 
printing it to check if the report already contains the information you want. 
You can also view a sample of a report by selecting it in the Index to 
Reports window and then clicking View Sample. 

To design a report

1 Click Reports in any command centre. The Index to Reports window 
appears.

2 Locate the report you want to design and highlight it.

3 Click Customise. The Report Customisation window appears. 

4 Click Design at the bottom of the window. The Report Design window 
displays the fields that are available to be printed on the report you’ve 
selected.

5 Mark the Display column next to the fields that you want to display on the 
report. 

6 Drag the fields around the window to indicate the order in which you want 
the fields to be printed on the report. The fields at the top of the Report 
Design window will appear at the left most end of the report.

7 Click OK when you have finished

In the example below, the Sales Register Quotes report has been designed 
to include just five fields. Date, Invoice #, Customer Name, Amount and 
Promised Date.

As shown below, only the information specified in the Report Design 
window appears on the report.

A This column contains the fields available for the selected report. 

B Fields marked with an X in this column are set to be printed on the 
selected report.

BA
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Changing the appearance of a report

Not only can you control the content of a report, you can also dramatically 
change a report’s appearance by using different font styles, sizes, colours, 
alignments and effects. Perhaps you prefer an easy to read large font with 
minimum design for reports you print for office use; reports you print for 
clients, on the other hand, are more formal, with the company name 
appearing in the correct font and colour. 

HINT : Changing the look of all your reports at once If you want all 
your reports to be identical in appearance, there’s a shortcut you can use to 
format all your reports in one go. See ‘To choose default fonts for reports 
and forms’ on page 125. 

To format a report

1 Click Reports from any command centre. The Index to Reports window 
appears. 

2 Locate the report you want to format and select it.

3 Click Customise. The Report Customisation window appears.

4 Click Format. The Report Format window appears. 

5 Click the Report Line drop-down arrow and select the section of the 
report you want to format (for example, select Report to format the report 

name, Company to format the company name, and so on). Notice the 
corresponding section is highlighted on the right side of the window. The 
default format settings of the section you chose appear in the Font & Style 
area of the window.

6 Make selections from the lists and checkboxes in the Font & Style area. 
You can set a variety of font styles, sizes, colours, alignments and effects. 
The selections you make here alter the appearance of the report section 
you chose in Step 5.

NOTE : Reverting to default settings If you’ve formatted a report section 
and want to revert it to its original format, click Use Default.

7 Repeat Step 5 – Step 6 for each section of the report you want to format. 

8 Choose from the Negative drop-down list how you want negative 
amounts to appear on the report. 

9 If you want to change the report’s margins, enter the amount of space you 
want to include in the Margins fields. Make other selections as necessary 
and click OK when you have finished. . 
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Notice that the headers in the report below reflect our format 
specifications.

Saving custom reports

If you plan to use a specific report’s design and format many times in the 
future, you can customise the report once and save the changes so you 
can use the modified report whenever you want.

When you save a report’s changes, you create a custom report. Custom 
reports appear in the Custom view of the Index to Reports window and 
can be printed, displayed and saved as files just like any other 
BusinessBasics report. 

To save a custom report 

1 Customise your report using the filters and design and format tools 
available in the Report Customisation window. (See ‘Customising 
reports’ on page 115.) When you’ve finished in each window, make sure 
you click OK to record your changes.

2 Click Display. The Screen Report window displays your report with your 
customisation. 

3 Take a look at the report to be sure it includes the changes you want; if 
you’d like to make any changes, click Customise at the bottom of the 
window. (This button performs exactly the same action as the Customise 
button in the Index to Reports window.)

4 When you’re happy with the customised report, click Save As. The Save 
As dialog  appears.

5 Enter a name and a brief description of the custom report and click OK. 
The Screen Report window appears again. 

6 Click Close. The Index to Reports window appears.

7 Click the Custom tab. Your custom report is listed here.

You can perform the same tasks with custom reports as you do with any 
other BusinessBasics report, including printing them, displaying them on 
your computer screen and saving them as files on disk. See ‘Working with 
reports’ on page 121 for more information.
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Where are my custom reports stored?

When you save a custom report using the steps above, the report is stored 
in a separate folder in your computer’s hard disk. This folder is named 
CUSTOM and is located in the folder in which your MYOB BusinessBasics 
program is located. For example, if BusinessBasics is installed in the MYOB 
BusinessBasics v1 folder, the Custom folder is located in the MYOB 
BusinessBasics v1 folder. Each report you’ve customised and saved appears 
in this folder.

Be very careful when you use Windows Explorer with the CUSTOM folder; 
if you delete or rename this location, you won’t be able to use your custom 
reports in the Index to Reports window. For information about backing 
up your Custom folder, see ‘Backing up customised forms and reports’ on 
page 156.
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Working with reports

Once you’ve chosen the report you want and customised it, you’re ready 
to see the finished product. In BusinessBasics, there are five ways to work 
with a report:

! Print the report on your printer

! Display the report on your computer screen

! Save the report as a file on disk (see page 122)

! Send the report by email (see page 123)

! Send the report by fax (see page 123)

NOTE : If you have problems viewing or printing reports See ‘Preparing 
to print reports and forms’ on page 124.

Printing reports on your printer

Before you can print a report, you need to make sure your computer, 
printer and MYOB BusinessBasics system are properly set up for printing. 
For more information, see “Preparing to print reports and forms” on 
page 124.

Once you’ve set up your computer, printer and MYOB BusinessBasics 
system, printing reports is a simple task of clicking Print in the appropriate 
window. 

HINT : Save paper by displaying reports on your computer screen first

If you’re not sure whether a particular report is the report you want, you 
should display the report on your computer screen first before you attempt 
to print it.

Displaying reports on your computer screen

Using Display in the Index to Reports window, you can display an 
onscreen version of any report in the MYOB BusinessBasics system. 
Displaying a report onscreen is also a good way of previewing a report 
before you print it. 

To display a report

1 Go to the Reports menu and choose Index to Reports. The Index to 
Reports window appears. 

2 Locate the report you want to display and select it.

3 Click Display. The Screen Report window appears, with the report you 
want to view.

4 If you want to make changes to the report that appears, click Customise in 
the Screen Report window. (See ‘Customising reports’ on page 115 for 
more information.)

IF YOU WANT TO VIEW THE REPORT IN MORE DETAIL 

If you want to view more detail about a particular report, you can “zoom” 
to the detail from the Screen Report window. (This feature is available in 
most BusinessBasics reports.)

Move your mouse pointer over the area you want to see in more detail. 
The mouse pointer will change to a magnifying glass.

Now click your mouse button; the window used to enter the information 
appears. When you’ve finished viewing the details, close the window to 
return to the Screen Report window.
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Saving reports as files on disk

When you save a report as a file on your computer’s hard disk, you have 
the flexibility to do whatever you want with the report—you can further 
modify it using a word-processing program, move it to another computer 
for printing or simply save it for your permanent records.

To save a report as a file on disk

1 Click Reports from any command centre. The Index to Reports window 
appears.

2 Locate the report you want to display and highlight it.

3 Click Send To and choose one of the following formats:

# PDF (Portable Document Format) file. If you save a report as a PDF file, 
the person who receives the report must have a program capable of 
opening a PDF file. To view a PDF file, you need Adobe Acrobat 
Reader, a free program distributed by Adobe Systems. You can install 
Acrobat Reader from your MYOB BusinessBasics CD-ROM.

# HTML File. When you save a report in HTML (Hypertext Markup 
Language) format, the report can be viewed in Internet browsers 
such as Netscape Navigator and Internet Explorer. This is useful for 
posting a report such as your item price list on a website. 

# Tab-Delimited Text File. When you save a report in tab-delimited 
format, the individual bits of information in the report are separated 
by tab characters. For example, if the last name Fothergill and the 
address 500 Maple Street appear in a report of customer names, a tab 
character will appear between Fothergill and 500 Maple Street in the 
file. This format has been designed for exporting a file to a 
spreadsheet program.

# Comma-Separated Text File. When you save a report in comma-
separated format, the individual bits of information in the report are 
separated by commas. For example, if the last name Fothergill and 
the address 500 Maple Street appear in a report of customer names, 
a comma will appear between Fothergill and 500 Maple Street in the 
file. (Individual bits of information that actually contain commas are 
surrounded by quotation marks.) This format has been designed for 
exporting a file to a spreadsheet program. 

# SimpleText File. When you save a report in text format, the individual 
bits of information are separated by spaces so the appearance of the 
report is as similar as possible to a printed version of the report.

When you select the format you want to use, the Save As dialog appears.

4 Specify a name and location for the file you’re creating and click Save.
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Sending reports by email

If you have an email program such as Eudora (5.0 or later) or Outlook 
Express (5.0 or later) , you can email a report as an attachment. This is 
really convenient for sending periodic reports to your accountant or the 
occasional item price list to a customer. 

When a report is saved using the Email feature, it’s saved as a PDF (Portable 
Document Format) file. The person who receives the email must have a 
program that is capable of opening a PDF file. To view a PDF file, you need 
Adobe Acrobat Reader, a free program distributed by Adobe Systems. You 
can install Acrobat Reader from your MYOB BusinessBasics CD-ROM.

To send a report by email

1 Click Reports from any command centre. The Index to Reports window 
appears. 

2 Locate and select the report you want to email. 

3 Click Send To and choose E-mail. The E-mail window appears.

4 Enter the email address of the person to whom you are sending the report 
in the E-Mail Address field. Complete the other fields as needed.

5 Click Send. The email is sent to your default email program’s Outbox with 
the report attached as a PDF file. 

6 Send the email from your email program as you would normally.

Sending reports by fax

If you’ve installed fax software on your system, you can fax a report using 
BusinessBasics. When you select the Fax option, BusinessBasics will access 
your fax program.

To send a report by fax

1 Click Reports from any command centre. The Index to Reports window 
appears. 

2 Select the report you want to fax. 

3 Click Send To and choose Fax. A dialog  from your fax program appears.

4 Use your fax program as you normally would to send the fax. Refer to the 
documentation included with your fax software for more information.
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Preparing to print reports and forms

If you’ve properly set up your printer and computer, printing reports and 
forms in MYOB BusinessBasics usually takes only a few clicks of your 
mouse. This section contains important information about setting up your 
printing environment so you can successfully print your BusinessBasics 
information.

Preparing your printer

If you plan to print documents on paper using a printer, bear in mind that 
your printer must be configured properly before the information can be 
printed. BusinessBasics is compatible with most popular printers, but each 
type of printer on the market today is different from the next. If you’re 
unsure about how your computer works with your printer or if you’ve had 
printing problems in the past, make sure you understand the capabilities 
of your printer before you attempt to print BusinessBasics documents.

1 Make sure that your printer is properly connected to your computer.

2 Turn your printer on.

3 Load the paper you want to use and make sure it’s loaded properly.

Preparing your computer

A great deal of the printing process is controlled by software used to send 
information to your printer. This software, commonly known as printer 
driver software, is normally supplied by your printer’s manufacturer. Printer 
drivers play a large part in determining how—and whether—information 
is printed using your printer. In many cases, printer drivers are already 
installed on your computer when you purchase it, or are supplied on disks 
when you purchase your printer. Printer drivers are not included in the
MYOB BusinessBasics package.

Printing problems

Printer drivers are often the cause of printing problems such as missing 
pages, incorrect-looking documents, the inability to print multiple copies 
of a document and the inability to print altogether. 

Occasionally, printer manufacturers update their printer driver software. 
BusinessBasics is designed to take advantage of the most recent printer 
drivers; as a result, if you experience printing problems, your printer’s 
printer driver may not be up to date. 

Preparing MYOB BusinessBasics for printing

You’ve got a number of options within BusinessBasics for personalising 
your printed documents and determining the process by which you print 
reports and forms. This section describes those options.

To choose page setup options

The selections you make in the Print Setup window determine how your 
documents will look on paper.

The Print Setup window varies, depending upon the printer and printer 
driver software you use. Usually, however, these windows allow you to 
choose options such as your page orientation, paper size and print quality.

NOTE : Page orientation All BusinessBasics reports are designed to be 
printed using portrait orientation on your printer. If you change some 
report settings, such as page orientation, font or font size, a message may 
appear, explaining that you can’t print the report using the current report 
settings. To print the report, you must make changes to the report. Usually, 
this situation is remedied by changing the page orientation in the Print 
Setup window. 

1 Go to the File menu and choose Print Setup.
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2 Review your page setup information before you attempt to print a 
BusinessBasics document.

To choose default fonts for reports and forms

Every report and form in BusinessBasics is assigned a default font, that is, a 
font that’s automatically designated for your use by BusinessBasics when 
you begin using your company file. Until you change it, the font assigned 
when you created the company file will be the default font for all your 
reports and forms. 

Font problems If you experience any font problems when printing or 
viewing a report or form, try changing the default font to a font you 
normally use on your computer. 

Note that the changes you make in the Change Default Font windows 
won’t affect any reports or forms you have already customised. 

1 Go to File menu and choose Default Fonts. The Default Font Selection 
window appears. 

2 Click either Reports or Forms, depending on the type of document for 
which you want to change the default font. If you selected:

! Reports, the Report Format window appears. Choose the fonts and 
styles for the various sections of your reports. (This window performs 
the same actions as the Report Format window you access via the 
Report Customisation window; see page 118.) Note, though, that 
your selections here will affect all your reports except those already 
saved as custom reports.

! Forms, choose the font style and size for the printed characters on your 
forms. Use the sample text below the fields to preview how the font 
looks.

3 Click OK. 
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9In MYOB BusinessBasics, forms refer to the invoices, statements and cheques that you send your 
customers and suppliers. 

BusinessBasics provides you with standard forms templates for each type of form. You can use 
them as is, or customise them to bear your own distinctive style. For example, you can change the 
size of a form, change fonts, include text, and add your own logo and graphics to your forms. 
BusinessBasics has several customisation tools you can use for this purpose.

You can also create multiple forms of one type. You might, for example, create an invoice with your 
logo and another without it. You can save the forms you customise to be used as many times as you 
need. BusinessBasics stores your custom forms safely in a separate folder within the MYOB 
BusinessBasics folder. 

BusinessBasics gives you the option of printing an invoice, statement or cheque as you record the 
transaction, or later as a batch. If you choose to print forms as a batch, you can use filters to locate 
the forms you need. For example, you can choose to print only unpaid service invoices or only 
unprinted cheques within a particular date and cheque number range.

If you choose to send invoices to your customers as you record sales in BusinessBasics, you have the 
option of printing the invoices on paper, faxing them or emailing them as attachments. You can 
also save these invoices to disk as PDF files. 
 Chapter 9
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Introducing forms

There are three kinds of forms in MYOB BusinessBasics: Invoices, 
Statements and Cheques.

! Invoices—In BusinessBasics, invoice forms can be used for open and 
closed invoices as well as your quotes and customer credits. You can 
print an invoice as you record it by clicking Print in the transaction 
window or print several invoices at once at the end of the day through 
the Print Invoices function. 

! Statements—BusinessBasics has two types of statements, each serving a 
different purpose. The invoice statement lists a customer’s outstanding 
invoices and the total amount due—ideal for sending as a reminder to 
slow-paying customers. The activity statement shows, for a given 
period, all activity for the customer’s account including any payments 
made, credits and refunds given, and any outstanding 
invoices—providing your customer with a summary of their account. 

! Cheques—These are the cheques you entered in BusinessBasics. As with 
invoices, you can print a cheque as you record it in the transaction 
window or print several cheques as a batch through the Print Cheques 
function. 
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Printing forms

Before you begin printing any forms, make sure your printer is set up 
properly. See ‘Preparing to print reports and forms’ on page 124 for more 
information. 

In general, there are five steps you need to follow to print a form:

! Step 1—Choose the information you want to print

! Step 2—Choose the form layout

! Step 3—Customise the form (optional)

! Step 4—Review the forms you’ve selected for printing

! Step 5—Print the forms

Step 1: Choose the information you want to print

1 Find the form you want to print. To print:

# an invoice, go to the Sales command centre and click Print Invoices. 
# a statement, go to the Sales command centre and click Print 

Statements.
# a cheque, go to the Banking command centre and click Print 

Cheques. 

The Forms Selection window appears. The filters in this window vary 
slightly, depending upon the kind of form you want to print. 

2 Using the filters provided, choose the information you want to appear on 
your forms. Use the examples on the right as a guide. 

In the following example, the filters are set to print all open service invoices 
that haven’t been sent or printed as yet. 

In the following example, the filters are set to print an activity statement 
for customer Chez Jules for the months of January to June.

You can also use custom lists as filters to limit the statements you print to 
only a group of customers. For more information, see ‘Creating custom 
lists and fields’ on page 99.

In the example below, the filters are used to print unprinted regular 
cheques (not refund) between numbers 34–50, written from the cheque 
account.
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Step 2: Choose a form layout

You can choose the layout you want to use from the Selected Form list in 
the Forms Selection window. BusinessBasics provides a number of layout 
choices, depending upon the type of form you’re currently working with.

! Pre-printed form layout: Select this layout if you’re printing statements 
or invoices and want to print a form’s information onto paper that 
already contains lines, columns and headings. The pre-printed layout is 
designed to match most commonly used forms provided by third-party 
forms suppliers.

! Plain paper form layout: Select this layout if you’re printing statements 
or invoices and want to print a form’s information onto blank paper. 
Lines, columns and headings are automatically printed with the form’s 
information. 

! User-customised form layout: Select this layout if you want to print a 
form you’ve customised using the Customise window. See page 135 
for more information about BusinessBasics’ forms-customisation tools.

! Continuous Feed Cheque or Laser Cheque: If you’re printing cheques, 
choose one of these layouts or a custom form you’ve created. The 
Continuous Feed Cheque form lets you print cheques on connected 
sheets of cheque forms; the Laser Cheque form lets you print cheques 
one page at a time on a laser printer. The Laser Cheque form is also set 
up so two cheque stubs are printed after the cheque form.

! (Australia) Customer Payments Service forms: If you use the Customer 
Payments Service, you can choose to send an invoice using one of the 
pre-customised forms that contain the “How to Pay” section. There are 
a number of forms to choose from, and you can identify them by the 
“PS” prefix. See the MYOB Payment Services User Guide for more 
information about customising these forms.

Step 3: Customise the form (optional)

If you want to customise the form, see ‘Customising forms’ on page 131 
for more information.

Step 4: Review the forms you’ve selected

Before you begin printing, you can review the information that will be 
printed on your forms. 

" Click OK in the Forms Selection window. The Review Before Printing 
window appears, with the information that fits the criteria you specified in 
the Forms Selection window.

Step 5: Print the forms

When you’ve finished reviewing the information that appears in this 
window, you’re ready to print. Click Print in the Review Before Printing 
window.

A A transaction is selected for printing when a mark appears next to it 
in this column. If you don’t want to print a form for a transaction, 
click in this column next to the transaction to remove the mark. 
Click All to mark all transactions in the window for printing. Click 
None to unmark all transactions in the window. 

B Click the zoom arrow to view more information about a transaction.

C Enter the number of copies you want to print.

A B C
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Customising forms

Each of BusinessBasics’ forms is unique in the information it provides and 
the specific layouts it reflects. Depending upon the needs of your business, 
the forms that are already set up when you begin using BusinessBasics may 
fully serve your needs. 

You may, however, occasionally find the need to make changes to specific 
forms to better accommodate your business needs. You can modify the 
look and content of individual forms in many ways. You can design the 
way you want your forms to look, add graphics, change fonts and styles, 
draw lines and shapes, and select the size of the paper you’ll print your 
forms on. In other words, there’s little you can't do if you’re customising 
your forms.

CAUTION : (Australia) If you use the Customer Payments Service, there 
are certain restrictions that you must be aware of when editing the “How to 
Pay” section. See your MYOB Payment Services User Guide for more 
information about customising these forms.

You can save your customised forms and simply select the form you need 
as the occasion demands.

What are data fields and text fields?

The default BusinessBasics form consists of data fields and text fields. 

Data fields These fields are distinguished by a dotted border around 
them and display information taken directly from your company file, such 
as the company name, amount due and billing address. Each data field has 
a label which indicates the information it will contain when the form is 
printed. You can’t create any new data fields but you will find that 
BusinessBasics provides you with sufficient fields. Data fields you don’t 
need can easily be inactivated so they don’t appear on the printed form. 

Text fields You can add any text you want to a form—for example, a 
greeting, special conditions—by entering it in a text field. Unlike data 
fields, text fields can be added, deleted and edited. 
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Step 1: Display the form in the Customise window

1 Display the Forms Selection window for the form you want to customise 
and make the necessary selections. (See ‘Step 1: Choose the information 
you want to print’ on page 129.)

2 Click Customise. The Customise window appears. 

Step 2: Set up form properties 

1 Go to the Form menu and choose Forms Info. The Forms Information 
window appears. 

2 Specify the number of forms you want to print per page.

3 Choose the type of paper from the Paper drop-down list.

4 Enter the margins for the page. 

5 Specify the width and length of the form (not the paper) in the Form Size 
fields. For example, if you are printing four cheques per page, enter the 
width and length of a single cheque. Click OK.

Step 3: Customise the form using the Tool palette

" Customise the form according to your needs. For more information, see 
“Adding elements to a form” on page 135. If you are customising a 
cheque, also see ‘Customising cheques’ on page 133.

Step 4: Preview the customised form 

At any time during the customisation process, you can display an onscreen 
preview of your work. 

1 Click Preview in the Customise window. The Print Preview window 
displays the form.

2 If you want to view the form in more detail, click the zoom buttons on the 
left side of the Print Preview window.

3 If you want to check your current printer and page settings, click Page 
Setup.

4 When you’ve finished previewing the form, click OK in the Print Preview 
window.

A Preview Provides a preview of your form on your computer 
screen.

B Tool palette Provides you with customisation tools for your 
forms. 

C Inactive data fields They are shown in dimmed text and won’t be 
printed on your form unless activated. To hide 
inactive data fields, choose Hide Inactive Fields 
from the Form menu. To redisplay them, choose 
Show Inactive Fields from the Form menu.

D Active data fields They are ready to be printed on a form. You can 
inactivate active data fields so they don’t appear 
on your form.

E Text fields Text fields don’t have surrounding boxes like data 
fields do. What you see in a text field is what 
actually gets printed.

C DA EB
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Step 5: Save the customised form

When you’re satisfied with the changes you’ve made to the form, you 
should save the customised form.

! If you want to save changes to a custom form you created previously, 
click Save Form.

! If you want to create a new custom form layout that contains the 
changes you’ve made, click Save Form As. The Save As dialog box 
appears; enter a name and a brief description for the new layout and 
click OK.

Where are the custom forms stored? Your custom forms are saved in a 
separate folder in your computer’s hard disk. This folder is called Forms 
and is located in the folder in which your MYOB BusinessBasics program is 
located. 

For information about backing up your Forms folder, see ‘Backing up 
customised forms and reports’ on page 156.

Step 6: Print the customised form

Printing a customised form is the same task as printing an unchanged 
MYOB BusinessBasics form. 

1 Display the Forms Selection window for the form you customised.

2 Select the Customise form you want to print from the Selected Form list in 
the bottom section of the window.

3 Click OK to begin printing.

Customising cheques

Cheques differ slightly from other BusinessBasics forms because the entire 
cheque form is composed of two forms—the cheque and the stub. Stubs 
typically contain data fields that summarise the information that appears 
on the main part of the cheque.

Some companies prefer to include two cheque stubs with each cheque. If 
you want two stubs to be printed, you simply need to choose the Laser 
Cheque layout from the Selected Form for cheques list at the bottom of 
the Forms Selection window. 

There are two types of cheque stubs in BusinessBasics:

! Regular Stub—This layout is automatically assigned to cheques that are 
written using the Spend Money window.

! Refund Stub—This layout is automatically assigned to cheques that are 
written using the Settle Returns & Credits window.

To customise the entire cheque, you’ll need to customise the stub form 
and the cheque form separately.

To customise the cheque form

1 Display the cheque form you want to modify in the Customise window. 
Notice that only the fields for the cheque, not for the stub, appear in the 
window. 

2 Go to the Form menu at the top of your computer screen; notice that the 
Cheque Layout is selected. This indicates that you’re currently viewing the 
layout for the cheque form only. 

3 Make any changes you want to the cheque form (see ‘Adding elements to 
a form’ on page 135). Customising the cheque form is the same process as 
customising any other form: you can move, activate and inactivate data 
fields and add, remove and change the characteristics of text fields, lines, 
rectangles and pictures. 
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To customise the stub form 

1 If it’s not already displayed, open the cheque form you want to modify in 
the Customise window. Notice that only the fields for the cheque, not for 
the stub, appear in the window. 

2 Go to the Form menu and choose the type of stub you want to customise. 
When you select a stub type, the cheque form’s fields will be dimmed, and 
the appropriate stub form’s fields will appear at the bottom of the 
Customise window. (You may need to use the scroll bar on the right of the 
Customise window to view the stub’s fields.)

3 Make any changes you want to the stub form. Customising the stub form 
is the same process as customising any other form. If you are using two 
cheque stubs and want your changes to appear on both, you need to 
make the changes twice—once for each stub. 

NOTE : Getting back to the cheque form When a stub form appears in 
the Customise window, the fields and other items that make up the cheque 
form aren't accessible. If you need to make changes to the cheque form 
again, choose Cheque Layout from the Form menu.

4 When you’ve finished making changes to the cheque form and stub forms, 
click Save Form in the Customise window. If you’re making changes to a 
custom layout, all changes you’ve made will be saved. If you’re working 
with one of BusinessBasics’ predefined form layouts, the Save As dialog 
box appears; enter a name and description for your new form layout and 
click OK. 

HINT : Don’t waste your cheque forms After you’re happy with the 
changes you’ve made to your cheques and cheque stubs, consider printing 
some alignment cheques to verify whether the changes you made print 
correctly on your printer (click Print Alignment Form in the Forms 
Selection window). When printing alignment forms, don’t waste the 
valuable pre-printed paper forms you normally use for cheques; use plain 
paper instead. You should be able to easily compare the alignment text on 
the plain paper with a pre-printed form. 
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Adding elements to a form 

You can add new elements to your form—data fields, text fields, lines, 
rectangles and pictures—using the Tool palette in the Customise window.

The Tool palette

To add an element, click the icon in the palette and then click the area in 
the form where you want the element to appear.

To add a text field to a form

1 Click the text tool and then click the location on the form where you want 
the new text field to appear. A new text field, labelled “Text Field”, 
appears.

2 Double-click the new field. The Field Information window appears.

3 Type the text you want to appear in the new field you created, in the Text 
field of the Field Information window.

4 If you want to change the font and style of the text, use the lists and 
checkboxes in this window.

5 Click OK to close the Field Information window. The new field containing 
the text you typed appears in the Customise window.

If the text you entered is longer than the size of the new text field, you may 
need to change the size of the text field. For more information, see “To 
change the size of a data field, text field, rectangle or picture” on 
page 137. 

To draw a line on a form  

1 Click the line tool and then click the location on the form where you want 
the line to begin; a cross appears on your computer screen. 

2 Drag the cross to where you want the line to end and then release the 
mouse button. 

To draw a rectangle on a form  

1 Click the rectangle tool and then click the location on the form where you 
want the top left corner of the rectangle to appear; a cross appears on your 
computer screen. 

2 Drag the cross to where you want the bottom right corner of the rectangle 
to appear, and then release the mouse button. 
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To add a picture or logo to a form  

You can load a graphic file to a BusinessBasics form or copy the graphic 
onto the clipboard and then paste it directly on the form. BusinessBasics 
can display nearly any picture that appears on the clipboard, regardless of 
its original format. 

1 If you want to paste the graphic on the form (rather than load it), copy the 
graphic to the clipboard using your graphic program.

2 Click the picture tool in the Customise window in BusinessBasics. Then 
click the location on the form where you want the picture to appear. A 
picture field appears.

3 Double-click the picture field. The Field Information window appears.

# If you want to load a graphic, click Load Picture. The Open dialog 
box appears. Select the graphic file and click Open. The graphic 
appears in the Field Information window. 

# If you’ve copied a graphic to the clipboard, click Paste Picture. The 
graphic appears in the Field Information window.

4 Click OK to close the Field Information window. The picture appears on 
your form in the Customise window.

To activate a data field

1 Double-click the data field you want to activate in the Customise window. 
The Field Information window appears.

2 Mark the Field is Active checkbox.

3 Click OK.

To copy and paste a data field

1 Click the data field once to select it.

2 Go to the Edit menu and choose Copy.

3 If you want to paste the data field onto another form, display that form in 
the Customise window.

4 Go to the Edit menu and choose Paste. A copy of the data field appears in 
the Customise window.
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Changing elements on the form

You can make changes to the data fields, text fields, lines, rectangles and 
pictures on your form in the Customise window. 

To change the size of a data field, text field, rectangle or 
picture 

1 Highlight the field you want to change; a solid line appears around it.

A small square, called a “handle,” appears in the bottom right corner of 
the field.

2 Simply drag the handle to change the size of the field.

To change the length of a line

1 Select the line you want to change.

Two small squares—called “handles”— appear on each end of the line. 

2 Drag either handle so that the line is the length you want.

To change the font characteristics of several fields at 
once

1 Holding down the SHIFT key, click those fields for which you want to 
change the font, so that they are all selected.

2 Go to the Form menu at the top of the screen and choose Change Fonts. 

3 Change the font type and size and click Apply to Selected.

HINT : Changing the default font used in all forms If you want to 
change the default font used in all BusinessBasics forms, see ‘Changing the 
default font on all forms’ on page 139.

To change the font characteristics of a single data field 
or text field

1 Double-click the field you want to change. The Field Information window 
appears.

2 Make your choices in the Justify, Font, Size and Style fields in this window 
and click OK.

To change the text in a text field

1 Double-click the text field in the Customise window. The Field 
Information window appears.

2 Type the new text in the Text field of the Field Information window and 
click OK.

To change the thickness of a line or rectangle

1 Double-click the line or rectangle in the Customise window. The Field 
Information window appears.

2 Choose a thickness in the Line Size or Frame Size section of the Field 
Information window. Click OK.
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Moving elements around on the form 

You can change the position of the data fields, text fields, lines, rectangles 
and pictures on your form in the Customise window. 

There are two ways to move an element in the Customise window: 

! Use the pointer to select the element you want and drag it to the new 
location.

! Change the element’s exact coordinates. 

To drag an element to a new location

1 Click the element—data field, text field, etc.—and hold down the mouse 
button. Notice that the cursor turns to a hand. 

2 Drag the element to the desired location. In the example below, the 
Invoice # field is being dragged below its original position.

To change an element’s coordinates

1 Double-click the element you want to move. The Field Information 
window appears.

2 Enter in the Field Location boxes the distance from the top and left edges 
of the form where you want the element to begin.

3 Click OK.

Removing elements from the form

If you don’t need a text field, line, rectangle or picture on your form, you 
can remove it in the Customise window. 

To remove a text field, line, rectangle or picture from a 
form 

1 Select the text field, line, rectangle or picture you want to remove in the 
Customise window.

2 Press the DELETE key. 

To inactivate a data field 

You can’t remove data fields from a form. If you don’t want a particular 
data field to be printed on a form, you can inactivate it instead. 

1 Double-click the field you want to inactivate in the Customise window. 
The Field Information window appears.

2 Clear the Field is Active checkbox.

3 Click OK.

To hide inactive data fields

1 Go to the Form menu at the top of the screen and choose Hide Inactive 
Fields. All inactive data fields are hidden.

2 To display these fields again, choose Show Inactive Fields from the Form 
menu.
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Including the currency symbol in forms

You can choose to include the currency symbol next to financial amounts 
on statements, invoices and cheques. 

1 Go to the Setup menu and choose Preferences. The Preferences window 
appears. 

2 Click the Reports & Forms tab. 

3 Mark the Include Currency Symbols in Forms checkbox and click OK. 
The currency symbol will appear on forms you customise in the future and 
on the standard (uncustomised) forms that are provided with 
BusinessBasics. Forms you have previously customised will not be affected 
by this setting.

Changing the default font on all forms

You can change the default font used in MYOB BusinessBasics forms so 
that all forms you customise in the future and the standard (uncustomised) 
forms provided with BusinessBasics will have this font. Forms you have 
previously customised will continue to use the fonts you have selected for 
them. 

1 Go to the File menu and choose Default Fonts. The Default Font 
Selection window appears. 

2 Click Forms. The Change Default Font window appears. 

3 Make the necessary changes in this window and click OK. Your changes 
will take effect for all forms you customise in the future. 
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10Although MYOB BusinessBasics has been designed to help you run your business on a day-to-day 
basis and to provide you with valuable management information, it is not in any way meant to be 
a substitute for your accountant. It can free your accountant from tedious bookkeeping so more of 
their time can be spent more effectively helping you with business strategies and tax advice.

If you run a small business, you probably deal briefly with your accountant a few times through the 
year, for example to prepare your activity statements, and do your books to the best of their ability. 
At the end of the year you probably meet with your accountant who reviews your books, and helps 
with your tax and other statutory returns.

Regardless when you choose to meet with your accountant, you can give them the information they 
need using the BusinessBasics company file. This chapter lists the information your accountant 
may require from you; it also shows you how to check your BusinessBasics accounting records so 
that the financial and activity statement information you provide your accountant is up to date 
and complete. 

This chapter also shows you how to adjust your BusinessBasics company file to agree with the 
accountant’s final figures after their adjustments for depreciation, tax, errors and omissions. This 
doesn't mean you are keeping two sets of books, but adjusting yours to agree with the accountant’s 
after their job is done. Once you’ve made the adjustments, you can back up your company file and 
start a new financial year in BusinessBasics.
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Sending company information to your accountant

This section lists the BusinessBasics reports and other accounting 
information that your accountant may require from you and suggests 
what checks you should perform to make sure this information is up to 
date and complete. 

What to check before providing company 
information to your accountant

While your accountant will check your company file information in detail 
either using the reports you provide or a copy of your BusinessBasics 
company file, it’s good practice to make a few checks yourself. Follow the 
steps below to make sure that the information you send your accountant is 
accurate and complete. If you find a problem that you can’t resolve, make 
a note of it and let your accountant know. 

Step 1: Reconcile your bank accounts

The bank account reconciliation process ensures that your bank records in 
BusinessBasics match those of your financial institution. When you 
reconcile your bank account, you’ll be able to spot any old cheques that 
haven’t been cleared yet and any bank charges or interest you may have 
forgotten to record. You should reconcile your bank account to the last 
day of your financial year. 

For more information, see ‘Reconciling your bank account’ on page 67.

Step 2: Reconcile your customer records

When you make a sale to a customer and enter it in BusinessBasics, two 
things happen: the customer’s record is updated to reflect the receivable 
amount and the Accounts Receivable account in your Accounts List is 
updated.

The Accounts Receivable account stores the total receivable amount from 
sales made to all customers. You should reconcile this balance with your 
customer records to make sure they are equal.

Follow the steps below to reconcile your Accounts Receivable account. 

1 Make sure you have already entered all sales and customer payments for 
the year.

2 Display the Index to Reports window and select the Receivables 
Reconciliation (Summary) report. 

3 Click Customise and set the Receivables As of date to the last day of the 
financial year. 

4 Click Display to display the report.

5 Check the Out of Balance Amount at the bottom of the report. If an 
amount other than zero appears here, your account is out of balance by 
that amount. See the following section for reasons why this may have 
occurred. 
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Possible causes for an out of balance amount 

# Sales or Receive Money transactions have been allocated to the 
Accounts Receivable account instead of the appropriate income 
account.

# Customer payments have been entered with a date prior to the date 
on the invoices to which they relate.

To help you find the transactions that may be causing the out of balance, 
try changing the filter date of the Receivables Reconciliation report. For 
example, if your financial year is from July to June 2002, change the 
Receivables As of date in the Report Customisation window to say, 
December 31. 

If there is no out of balance amount for this period, then you know that the 
transaction(s) causing the out of balance was entered between January 1 
and the last day of the financial year. Try different date ranges to narrow 
your search further. 

Then use the Find Transactions tool to view all transactions for the 
Accounts Receivable account for the period that has been determined (see 
‘To find a transaction using Find Transactions’ on page 105 if you need 
help). Click the zoom arrows beside the transactions to view them in detail 
and identify the problem. 

Step 3: Review other reports

Print or display the following reports and review them:

! Standard Balance Sheet report.

! Standard Profit and Loss report.

! Accounts List Summary report. (Make sure you set the filters to print 
account balances in the Report Customisation window.) 

! GST reports (see below).

When reviewing these reports, check for amounts that appear incorrect or 
out of the ordinary. For example, you thought you spent approximately 
$500 on advertising, but the Advertising expense account shows $5000 
instead. 

Use the Find Transaction tool to analyse the transactions for the accounts 
that seem to have unlikely balances.

GST reports 

Ask your accountant if the reports should be generated on an accrual basis 
(when the sale is “booked”) or on a cash basis (when the merchandise is 
paid for). BusinessBasics offers reports for each situation.

For a summary overview of tax collected and paid, use the GST Summary 
report. For a detailed view, use the GST Detail report. 

NOTE : Note: If you  remit GST on a cash basis (remit tax only on money 
received, not on sales booked), use the “Cash” versions of the above 
reports.
Sending company information to your accountant 143User Guide



What company information to give your 
accountant 

When you meet with your accountant, you can pass on your accounting 
information in one of the following ways: 

! If your accountant uses BusinessBasics, you can give them a copy of 
your company file and let them create their own reports. They can then 
either enter any adjustments directly into your file, or send you the 
adjustments in a text file that you can import. See ‘If your accountant 
makes adjustments in your company file’ below for more information.

! If your accountant uses MYOB Accountants Office, you can send them a 
special file that contains the necessary transaction and activity 
statement information in a format that can be imported directly into 
their practice software. They can then create the required reports in the 
format they require. See ‘If your accountant uses MYOB Accountants 
Office’ on page 145 for more information about this option.

! If your accountant uses an accounting package such as Solution 6, 
Ceedata, Handiledger or Caseware, you can export information in 
formats accepted by these programs using AccountantLink. See the 
Import/Export topic MYOB Help for information about exporting to 
other accounting systems.

! If these options are not possible, there are a number of reports you 
should prepare for your meetings. 

The reports we recommend you print include:

# Profit and Loss [Year to Date] 
# Balance Sheet 
# Trial Balance Summary 
# Receivables Reconciliation Summary
# GST reports 
# Account Transaction (only if your accountant wants to review each 

and every transaction you’ve entered in the company file during a 
particular period)

In addition to these, print any other report your accountant may 
request. Any adjustments that need to be made can be entered for the 
relevant financial year, as long as you haven’t completed the Start a 
New Year procedure. See ‘Starting a new financial year’ on page 149 for 
more information.

If your accountant makes adjustments in your company 
file

If your accountant plans to enter end of year adjustments directly in your 
BusinessBasics company file that you have sent, you won’t be able to make 
any entries until you receive the company file back from your accountant.

A better alternative would be to send the file and then request the 
adjustments as a text file that you can directly import into BusinessBasics. 
This way, you can start entering transactions in the following financial year 
in BusinessBasics although you may not have closed the year on which 
your accountant is working.

For example, you have just completed the year 2002 and given your 
accountant a copy of your company file. You can enter transactions for the 
2003 financial year while the accountant works on your books for 2002. 
Once the accountant hascompleted their work, you can import any 
adjustments to the 2002 financial year without affecting the 2003 year. 
This means you don’t need to wait for your accountant to “close the 
books.”

Remember to ask your accountant if the import file is in comma-separated 
or tab-delimited format and if the first record is a Header record. For more 
information about importing data into BusinessBasics, see ‘Importing 
data’ on page 164.
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If your accountant uses MYOB Accountants Office

MYOB Accountants Office is a complete accounting practice solution that 
integrates easily with BusinessBasics via a feature called AccountantLink. 
Using AccountantLink, you can export financial information to MYOB 
Accountants Office or import an accounts list and journal entries provided 
by your accountant.

1 Go to the Accounts command centre and click Send to MYOB 
Accountants Office. The Reporting Period window appears.

2 Select the period of the transactions you want to export.

CAUTION : Choose the reporting period carefully It’s important not to 
include dates you’ve included in a previous export since this would result in 
double-counting your transactions. As a precaution, we recommend that 
you tell your accountant the period you’ve selected.

3 Choose whether you want to send financial information only or to also 
include BASlink information if this has been set up by selecting the 
appropriate option in the Information required drop-down list.

4 Choose the method you want to use to send the information.

! E-mail—If you want to e-mail the file as an attachment to an e-mail 
message, first enter your accountant’s card in the Linked Card for 
Accountant field and then click E-mail. The e-mail address entered on 

the card will be used when the e-mail is created in your e-mail program. 
The default name for the export file is ‘companyname.mye’.

! Disk—If you want to save the file to disk, click Disk. Enter a name and 
location for the export file in the dialog that appears. The default file 
name is ‘companyname.mye’. You can change the file name if you 
want, but you muse use the .mye extension. Click Save.

IMPORTING ADJUSTMENTS FROM YOUR ACCOUNTANT

If you have sent your data to an accountant that uses MYOB Accountants 
Office, you may receive adjustments in a file that you can import into your 
BusinessBasics file.

NOTE : AccountantLink Codes must be entered first. If you want to 
import journal entries using the procedure below, you must have already 
entered the appropriate MYOB Accountants Office code in each account of 
your account list. See ‘Some preferences in BusinessBasics’ on page 23 for 
information on setting up the AccountantLink code preference ‘Review your 
Accounts List’ on page 25 for information on entering the AccountantLink 
account numbers.

1 Go to the File menu, choose AccountantLink, Receive from MYOB 
Accountants Office, and then choose Journal Adjustments. The Open 
dialog appears.

2 Locate and select the file containing the adjustments sent by your 
accountant.

3 Click Open to open the file and begin the import process.

The journals are imported and a message appears giving you the results of 
the import. If there are any errors, refer to the log file for a list of errors and 
warnings encountered. See ‘The Import Log report’ on page 166 for more 
information.
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Recording journal entries for adjustments

Once your accountant has completed the adjustments, it is your turn to 
adjust your books to agree with theirs. Some accountants will come to 
your premises and make the adjustments for you. Others will send you the 
information, allowing you to make your adjustments. If your accountant 
uses MYOB Accountants Office, you can easily import adjustments they 
send to you. See ‘Importing adjustments from your accountant’ on 
page 145 for more information.

If your accountant provides you with the information on disk, you can 
import these transactions by using the Import Data - General Journal 
Entries option in the File menu (see ‘Importing data’ on page 164 for 
more information). If the adjustments have been provided on paper, you 
can manually enter them using the Record Journal Entry function in the 
Accounts command centre (see below).

NOTE : This procedure requires accounting knowledge 
You should be aware that making your own adjustments does require 
accounting knowledge. If you'd rather not handle this yourself, ask your 
accountant or see a local MYOB Consultant for help.

To record adjustments manually (Australia)

If your company file is set to 13 accounting periods in the financial year, 
assign your adjustments to the 13th period by entering an asterisk (*) 
before the date, for example, *31/03/2002.

1 Go to the Accounts command centre and click Record Journal Entry. The 
Record Journal Entry window appears. 

The General Journal number and transaction date appear automatically. 
You can change them if you want. 

2 Enter a comment in the Memo field to describe the transaction, for 
example, “Depreciation–Motor Vehicle.”

3 Enter details of the adjustment in the scrolling list section of the window. 
For field help, click Help.

Each row of information entered in the scrolling list is called a line item. You 
can enter as many line items as you want, but you must have at least two 
line items—a debit entry and a credit entry to offset it. The entry cannot be 
recorded until the debit and credit totals displayed beneath the scrolling 
list are equal. 
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4 Click Record to record the journal entry. 

Once you’ve made the adjustments requested by your accountant, you 
can start a new financial year. See ‘Starting a new financial year’ on 
page 149.

To record adjustments manually (New Zealand)

If your company file is set to 13 accounting periods in the financial year, 
assign your adjustments to the 13th period by entering an asterisk (*) 
before the date, for example, *31/03/2002.

1 Go to the Accounts command centre and click Record Journal Entry. The 
Record Journal Entry window is displayed. The General Journal number 
and transaction date appear by default. You can change it if necessary.

2 Enter a comment in the Memo field to describe the transaction. For 
example, Depreciation–Motor Vehicles.

3 Enter details of the adjustment in the scrolling list section of the window. 
For field help, click Help. 

Each row of information entered in the scrolling list is called a line item. 
You can enteras many line items for a Record Journal Entry transaction as 
you want, but you must have at least two line items—a debit entry and a 
credit entry to offset it. The entry cannot be recorded until the debit and 
credit totals displayed beneath the scrolling list are equal.

A Enter the accounts that are affected by the transaction in the Acct # 
field. 

B Enter the amounts by which you want to debit and credit the 
accounts in this transaction in the Debit and Credit fields.

C Enter the tax code that applies to the amount.

D If the transaction should be reflected in the GST reports or the GST 
section of your activity statement, choose whether the transaction is 
a Supply or Acquisition by clicking the appropriate radio button in 
the Display in GST (BAS) Reports as section. Your accountant may 
be able to help you with this decision.
This section will only be active if a tax code has been entered.

E The Out of Balance field must be zero before you can record the 
transaction. 

A CB

D

E
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4 Click Record to record the Record Journal Entry transaction.

5 Make a backup of your company file after you have finished entering 
adjustments and store it in a safe location. See ‘Backing up your company 
file’ on page 155. Make sure you verify the company file as part of the 
backup process. See ‘Checking your company file for errors’ on page 158.

A Enter the accounts that are affected by the transaction in the Acct 
No. field.

B Enter the amounts by which you want to debit and credit the 
accounts in this transaction in the Debit and Credit fields.

C If you want to assign line items to specific jobs, enter the job number 
in this column.

D The Out of Balance field must be zero before you can record the 
transaction.

A B C
D
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Starting a new financial year

This section refers to the Start a New Financial Year procedure that is 
accessed from the File menu in BusinessBasics. This annual procedure 
involves closing off or permanently locking the financial year just gone, 
automatically clearing the company file of old data and setting the 
company file’s financial year to the new year. 

Why should I start a new financial year?

This process has a few benefits. For example, your company file and 
register lists will reduce in size, helping to improve 
performance—especially if you have a high volume of transactions. You 
may need to start a new year if you want to enter account budgets for the 
new year. 

Eventually, you would need to start a new year because history of 
customer and items sales are stored for five years only (the previous three 
financial years, the current and the next).

When should I start a new financial year?

You don’t have to rush into starting a new financial year because 
BusinessBasics allows you to make entries in the following year. For 
example, your company file might be set to financial year 2002 but you 
can make entries for the year 2003 and beyond. In fact you can make 
entries for the year 2020 or later if you want to.

You should only start a new financial year when you have completely 
finished making entries in the current financial year. This means you have 
made adjustments for depreciation and all other adjustments suggested 
by your accountant so that your books now agree with your accountant’s.

What happens when I start a new financial year?

Here is a summary of what happens when you start a new financial year. 
For the purposes of this summary, let’s say that you have a calendar 
financial year (January to December) and you are ending 2002 and 
beginning 2003:

! BusinessBasics replaces last year’s (2001) historical monthly totals with 
the monthly totals of the year just completed (2002).

! BusinessBasics purges journal entries and sales prior to the new financial 
year (2003), except:

# Entries attached to sales or open invoices.
# Unreconciled transactions in the accounts you reconcile, such as your 

cheque and credit card accounts.

! BusinessBasics moves the balance of current year earnings to retained 
earnings. The balances of your income, cost of sales and expense 
accounts are returned to zero. 

! BusinessBasics does not touch any entries made in the new financial 
year. If your new financial year ends in a different month from your last 
financial year, you can change it when you start a new year.

NOTE : If you want to check your financial year If you want to check 
what financial year your company file is set to, choose Company 
Information from the Setup menu. 
Starting a new financial year 149User Guide



Getting ready

Given that the Start a New Year command in BusinessBasics is irreversible, 
it is essential that you make a backup of your company file. For more 
information, see ‘Backing up your company file’ on page 155. 

In addition to the backup, you can also make a copy of your company file, 
rename it to indicate the financial year and store it in a folder called Old 
Data. For example Wiggins Inc. might rename their file Wiggins02 Data to 
indicate the file relates to the 2002 financial year. Although this is an 
optional step, it makes it easy to find old data if needed.

To start a new financial year

1 If you haven’t done so already, print all the reports that you want to keep 
that show the previous year’s transaction activity. You might consider 
printing a copy of each journal because they show all transaction activity 
for a specified period.

2 Make a backup of your company file. See ‘Backing up your company file’ 
on page 155. 

3 Go to the File menu and choose Start a New Year. The Start a New 
Financial Year Assistant appears. Click Continue.

4 Read the information in the window that appears. Click Continue. 

5 Enter the new financial year. 

When selecting your new financial year, remember that in BusinessBasics 
and according to the standard used by most accountants, financial years 
take the name of the calendar year in which they end. For example, if your 
financial year is from July 1, 2002, to June 30, 2003, that year is referred to 
as “financial year 2003.”

If you want to change the last month of the financial year, you can do so in 
this step (make sure you’ve already consulted your accountant about this 
change). 

6 Click Continue. Place a mark next to the accounts for which you don’t 
want BusinessBasics to purge unreconciled transactions. Click Continue. 

7 Click Start a New Financial Year.

8 Verify and optimise your company file (recommended).

Optimising your company file reduces your company file’s size and makes 
your company file more efficient. See ‘Optimising your company file’ on 
page 159 for instructions. 

The Verify Company File function checks your company file for errors and 
ensures that your company file is in “healthy” working condition. See 
‘Checking your company file for errors’ on page 158 for instructions.
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Preparing your activity statement for the ATO

(Australia)

Many businesses are required by the government to submit their activity 
statement monthly, others quarterly. Regardless of your reporting 
frequency, you can use MYOB BusinessBasics’ BASlink function to quickly 
and conveniently fill out your Business Activity Statement (BAS) or 
Instalment Activity Statement (IAS). 

HINT : If your accountant prepares your activity statements See ‘If your 
accountant uses MYOB Accountants Office’ on page 145 for information on 
sending your activity statement details to your accountant. If your 
accountant does not use MYOB Accountants Office, use one of the 
alternative methods listed at ‘What company information to give your 
accountant’ on page 144.

There are a few tasks and checks you should make in preparation to lodge 
your activity statement. These are detailed below. 

Once you have completed the tasks listed above, you can start completing 
your activity statement.

To prepare your activity statement

1 Go to the Accounts command centre and click BASlink. The Reporting 
Period window appears. 

2 Select the last month of your reporting period from the table. 

3 If you have set up your company file with 13 periods, and want to include 
13th period transactions in your return, mark the Include 13th Period 
Transactions in Report checkbox. 

4 Click Prepare Statement. Your activity data may take a few moments to 
be prepared. Then the Welcome window appears.

! If you are using BASlink for the first time, click Setup. A Help window 
appears. Read the information in this window to find out the steps you 
need to take to set up and complete your BAS.

! If you have used BASlink before and have already linked your tax codes 
to the relevant fields, click Complete. A Help window appears. Read the 
information in this window to find out the steps you need to take to 
complete your activity statement.

The Calculation Sheet of the BAS appears. 

5 Complete the Calculation Sheet and the Summary Sheet.

Remember, help is at your fingertips— click Help in the Calculation Sheet 
or Summary Sheet windows for detailed information on filling out the BAS; 
click a field label, for example G1, for a description of that field. 

Step Action

1 Review your tax codes. Given that BASlink relies on the tax codes in your 
company file to complete the activity statement fields, you must make sure 
you are using the correct tax code for the correct transaction. Use the 
various GST reports in MYOB BusinessBasics to help you do this. For 
example, the Tax Code Exceptions reports show you transactions that do 
not have tax codes allocated to them.

2 Set up your activity statement information. You need to specify how you 
intend to lodge your BAS, your accounting basis, reporting frequency, and 
so on in the BAS Information window (go to the Setup menu, choose 
Company Information and click BAS lnfo). Click Help in the BAS 
Information window for detailed help.
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Lodging your GST Return to the IRD

(New Zealand)

Many businesses are required to submit their GST returns monthly, two-
monthly or six-monthly. Regardless of your reporting frequency, you can 
use MYOB Accounting’s GST Return function to quickly and conveniently 
fill out your GST Return. Using the Prepare GST Return function that is 
accessible from the Accounts command centre, you can print a report that 
will assist you in completing the form provided by the IRD.

HINT : If your accountant prepares your activity statements See ‘If your 
accountant uses MYOB Accountants Office’ on page 145 for information on 
sending your activity statement details to your accountant. If your accountant does 
not use MYOB Accountants Office, use one of the alternative methods listed at 
‘What company information to give your accountant’ on page 144.

There are a few tasks and checks you should make in preparation to lodge 
your return. These are detailed below.

Once you have completed the tasks listed above, you can print your GST 
return.

To print your GST Return

1 Go to the Accounts command centre and click Prepare GST Return. The 
Reporting Period window appears. 

2 Select the last month of your reporting period. 

3 If you have set up your company file with 13 periods, and want to include 
13th period transactions in your return, mark the Include 13th Period 
Transactions in Report checkbox. 

4 Review the rest of the GST Return setup information and then click 
Prepare Report to print a sample copy of the report.

Step Action

1 Review your GST codes. Given that the GST Return 
function relies on the tax codes in your company file to 
complete the fields, you must make sure you are using 
the correct tax code for the correct transaction. You 
also need to ensure that you mark the GST Code is 
Reported on GST Return checkbox for zero-rated tax 
codes, but clear the checkbox for Exempt tax codes.

2 Set up your GST Return information. You need to 
specify your accounting basis, reporting frequency, and 
so on in the Prepare GST Return window. You also 
need to set up and then specify the accounts that you 
use to track tax adjustments (for boxes 9 and 13 on the 
return).
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11This chapter is about maintaining and protecting your accounting data. Learn how to set up 
password protection so only you and your authorised staff can have access to your vital company 
information. Also learn how to back up and restore your company file, check your company file for 
errors and optimise it for maximum performance.

We can’t stress enough the importance of making regular backups (copies) of your company file. It 
doesn't always take a bolt of lightning to corrupt your data. Day to day problems like static, a 
simple bump of the computer, or a power surge can cause a computer to restart at just the wrong 
time and corrupt a company file. Company files can also be lost by hard disk failures and theft. In 
all cases, the only protection is a backup. 

BusinessBasics’ Backup command makes it easy to create up to date copies of your company file. 
You can even set a backup reminder in BusinessBasics so that backing up becomes part of your 
daily work routine. You should back up your company file to an external storage device such as a 
floppy disk or zip disk and keep this disk somewhere safe, preferably away from your office. 

Sometimes you might not realise you have a problem. Company file corruptions can hide in the file 
until you attempt to access that part of the file with the error. That's why BusinessBasics provides 
the Verify Company File function. We recommend that you check your company file for errors 
before you back up, and when you open it in the morning.

Please read this chapter carefully and regularly verify and back up your company file.
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Setting up a password

Your company file contains your company’s confidential financial 
information and it’s important that you protect it accordingly. 

MYOB BusinessBasics has an effective security system based on a master 
password to help keep prying eyes away from your sensitive financial data. 
The password controls access to your company file and the entire 
BusinessBasics system. 

To set up the password

1 Go to the Setup menu and choose Preferences. The Preferences window 
appears. 

2 Click the Security tab.

3 Click Password. The Set up Passwords window appears.

4 Enter your password and click Record New Password. You can type in 
upper or lowercase; passwords are not case-sensitive.

5 Review the password you typed and click OK. 

6 Make sure you memorise your password or write it down in a safe place. 

To change the password

1 Go to the Setup menu and choose Preferences. The Preferences window 
appears. 

2 Click the Security tab.

3 Click Password, enter your current password and click OK. A dialog box 
appears. 

4 Click Edit. 

5 Enter the new password in the Edit Master Password field and click 
Record Changes. 

To delete the password

1 Go to the Setup menu and choose Preferences. The Preferences window 
appears. 

2 Click the Security tab.

3 Click Password, enter your current password and click OK. A dialog box 
appears. 

4 Click Delete. A warning appears, reminding you that deleting the 
password removes all password protection from your company file. 

5 If you are certain you want to delete the password, click OK.
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Backing up your company file

As reliable as computers are these days, they can’t be fully trusted to 
provide you with trouble-free recordkeeping. As is the case with all 
machines, computers too are capable of failure. This is why it’s vital that 
you back up (make copies of) your BusinessBasics data on a regular basis.

Backing up, or the copying of computer files to a storage device, is quite 
simple in BusinessBasics. If you have a relatively small company file, you 
can simply copy the BusinessBasics company file to a separate floppy disk. 
Otherwise, you can use BusinessBasics’ automatic backup feature to create 
a compressed version of your company file.

When making backups...

! Don’t put your backups on the same hard drive as MYOB 
BusinessBasics—a single disaster can wipe out all your records.

! Make multiple backups. Sometimes disks fail in subtle ways. A disk 
failure can corrupt a big chunk of your data in such a way that you may 
not notice it during a session. Once you copy the damaged data onto 
your only backup, you’re stuck: you won’t have a valid backup and will 
need to re-create your company file. Multiple backups give you a 
greater degree of protection.

! Keep a set of backups away from the office. If there’s a break-in or a fire 
at the office, at least you can rest assured that your company records are 
safe.

When should I back up my company file?

We recommend:

! Daily backups—Rotational. If you use BusinessBasics every day, make a 
backup disk for each day of the week. If you use BusinessBasics on a 
more sporadic basis, make two backup copies and rotate them. Label 
them clearly each time to keep track of which is your most recent 
backup.

! Monthly backups—Archival. After completing all entries for a month, 
make an archive copy and label the disk—for example, MYOB 
BusinessBasics September 2002 Archive. 

! Yearly backups—Archival. After completing all entries for a year, make 
an archive copy and label it, for example, MYOB BusinessBasics 2002-03 
Yearly Archive. Make this backup immediately before starting a new 
financial year.

Put your monthly and yearly backups in a safe place, preferably away from 
your office. Don’t use these disks again. You can reload these backups to 
look at information you may have purged later on or to produce certain 
backdated reports.

Need a backup reminder?

If you forget to make routine backups, set BusinessBasics to display a 
backup reminder. Go to the Setup menu, choose Preferences and click 
the Security tab. Mark the Prompt for Data Backup When Closing 
checkbox and click OK. When you close your company file at the end of a 
session, a message will appear, reminding you to back up. 
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To make a backup of your data

BusinessBasics’s Backup command creates a backup of the company file 
you’re currently using and compresses it to a smaller, more manageable 
size.

The Backup command only creates a backup of your company file. If you 
have customised any forms or reports, these should be backed up 
separately. See ‘Backing up customised forms and reports’ below.

1 Select the correct disk for the backup (daily, monthly, yearly, as specified in 
‘When should I back up my company file?’ on page 155). If this is the first 
time you are doing this type of backup, select a newly formatted disk and 
label it clearly. Insert the disk into the disk drive.

2 Go to the File menu and choose Backup. The BusinessBasics Company 
File Backup dialog  appears. 

NOTE : If the backup process does not work When you installed MYOB 
BusinessBasics, special software used for the backup process was also 
installed. If a message appears when you try to use the Backup command, 
this software may have been removed from the location where it needs to 
exist. You may need to re-install BusinessBasics to use this feature.

3 Decide the type of backup you want.

! - To backup your company file and templates, mark the Backup all 
data checkbox.

! - To backup your company file only, mark the Backup Company File 
only checkbox.

4 Choose whether you want to check for errors before making your backup 
and whether you also want to back up your customised forms, reports and 
other files and then click Continue. We recommend backing up all files 
and checking for errors, so that if you need to revert to a backup, data 
integrity is ensured. The Backup dialog  appears.

5 Specify the location on your disk drive where you want to store the backup 
file. 

6 Name the backup file or accept the default name. Make sure the file is 
saved with the extension ‘.zip’.

7 Click OK or Save to begin creating your backup file. 

If you get a message saying that the file exists, make sure you are not 
overwriting another backup you want to keep. 

Label all your backups with enough information to tell you when they 
were done and where you were up to in data entry—for example, 
‘Monday 4/11/02’ or ‘Backup as of 4/11/02’.

Backing up customised forms and reports

If you have customised any reports or forms, they should be backed up 
separately because they are not part of your company file.

Forms you have customised and saved can be found in the Forms folder 
within your MYOB BusinessBasics program folder.

Reports you have customised and saved can be found in the Custom 
folder, also within your MYOB BusinessBasics program folder.

Make sure you back up the Forms and Custom folders by copying them to 
a floppy diskette or a zip disk. 
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Restoring a backup of your company file

Let’s assume there was an unexpected power surge at Worzel’s Gift Shop 
which corrupted Worzel’s company file beyond repair. Fortunately, he’d 
backed up at the end of the previous day and was able to revert to the 
previous day’s company file using the Restore command. 

HOW DOES THE RESTORE COMMAND WORK?

The Restore command closes the company file you’re currently using, 
decompresses the backup file and opens it so that you can start using it. 

While the Restore function will not let you restore a file with the same 
name as one already in the location to which you are restoring, you should 
always be aware of the risks with restoring files and the possibility of 
overwriting a file you need. If you aren’t careful, this is one area which 
potentially can cause you many hours of lost work. When in doubt, take an 
additional backup before restoring. Be sure to label all backups with 
enough information to indentify when they were done and where you 
were up to in data entry.

1 Select the disk from which you want to restore and insert it in the disk 
drive.

2 Go to the File menu and choose Restore. If a company file is currently 
displayed, it will need to be closed before you can restore your file. The 
Select File to Restore dialog appears.

3 Choose the backup file you want to restore. The current folder being 
accessed appears at the top of the dialog box. Select the disk in which you 
stored your backup file. A list of all files on the disk appears. Select the file 
you need with the mouse and click Open. Choose the destination for 
the restored file. You should restore the company file to the same folder 
which contains your MYOB BusinessBasics program (usually the MYOB 
BusinessBasics folder). Choose the drive and then the folder to which you 
want to restore the company file, and then click Save. 

A message appears, letting you know where the backup file will be saved.

4 Click OK to complete the restore.
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Checking your company file for errors

By checking your company file for errors, you can catch minor 
inconsistencies in the file before they cause serious problems.

In addition to having BusinessBasics automatically check your company 
file for errors before a backup, you can check your company file any time 
you choose. This process is also known as data verification. 

HINT : Set a data verification reminder You can have BusinessBasics 
remind you to check your file for errors when you open your company file. 
Choose Preferences from the Setup menu. Click the Security tab in the 
Preferences window and mark the Prompt for Data Verification when 
Opening checkbox.

If you’ve got a large company file, the data verification process may take 
some time. 

To check your company file for errors

1 Go to the File menu and choose Verify Company File. A dialog  appears. 

2 Click OK to confirm that you want to verify your company file. 
BusinessBasics will scan your company file for errors.

When the file verification process is complete, a message appears, 
describing the results of the process. 

# If no errors were found, congratulations! Click OK to end the 
company file verification process. 

# If your company file is corrupted, you will need to restore from your 
most recent backup. See ‘Restoring a backup of your company file’ 
on page 157.
Chapter 11 : Maintaining Your Company File158 MYOB BusinessBasics v1



Optimising your company file

Over time, your BusinessBasics company file will grow considerably in size. 
As you enter transactions, then remove or purge them, the file will have 
unused areas that once contained these transactions. These unused areas 
can affect the efficiency with which BusinessBasics works with the 
company file and they consume space on your hard disk that can be used 
for other purposes. We recommend that you use the MYOB BusinessBasics 
Optimisation Assistant to remove the unused areas in the company file and 
keep your accounting software running in top form.

When do I need to optimise my company file?

You should optimise your company file after starting a new financial year 
(see ‘Starting a new financial year’ on page 149) and after purging sales 
and journal entries (see page 161). You may also want to optimise your 
company file on a regular basis if the transactions you enter are 
changeable and you make frequent changes to transactions after you’ve 
recorded them.

To optimise your company file

When you installed BusinessBasics, the Optimisation Assistant was also 
installed on your computer. The Optimisation Assistant can be accessed 
from the MYOB BusinessBasics program folder in the Windows Start 
menu. 

1 Locate the  program folder in the Windows Start menu and choose MYOB 
Optimisation Assistant. The Optimisation Assistant starts. 

2 Click Next in the Welcome to the MYOB BusinessBasics Optimisation 
Assistant window to begin. 

3 Click Find File. The Open dialog box appears. This dialog box works 
exactly like other Open dialog boxes do. Use it to locate the company file 
you want, highlight the file’s name and click OK. The file name appears 
beneath Find File. 

4 Click Next. A window appears, explaining the optimisation process. Read 
the information carefully and click Next when you’re ready to begin 
optimising your company file. 

The Optimisation Complete window appears when your company file 
has been optimised. 

5 If you keep accounting records for more than one company and you want 
to optimise another company file, click Next. Otherwise, click Finish to 
exit the Optimisation Assistant. 

6 Verify the optimised company file to ensure it’s in proper working 
condition. See ‘To check your company file for errors’ on page 158.
Optimising your company file 159User Guide



Closing accounting periods

Generally, each month of the financial year is considered an accounting 
period, and many businesses update their books at the end of each month. 
Once the books have been updated, they close that month before moving 
on to the next accounting period. 

While you are not required to close an accounting period in BusinessBasics, 
you can if you want to. The Lock Periods feature lets you specify the 
month you want to close or “lock” and prevents you from making entries 
in that month. This protects your data from being changed inadvertently. 

To close an accounting period

1 Go to the Setup menu and choose Preferences. The Preferences window 
appears. 

2 Click the Security tab.

3 Mark the Lock Periods: Disallow Entries Up to and Including checkbox 
and choose the relevant month from the drop-down list.

This selection merely places a temporary lock on the month you selected 
and all months before it. If, at a later time, you need to make an entry in a 
locked month—for example, you locked May and now want to make an 
entry in April—you can change your selection in the Preferences window 
so that month is “unlocked.” For example, if you choose March as your 
locked month, April becomes available for transaction entry again.
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Purging information that is no longer needed

Purging is the process of removing data you no longer need from your 
company file.

After you’ve used BusinessBasics for a long time, you’ll notice that the size 
of your company file has grown considerably. When your company file has 
grown larger than you want it to, you can remove the parts of the data 
that are no longer needed from the file. 

You can purge closed invoices (invoices that have been paid in full) and 
journal entries that have been reconciled from your company file. 

Purging closed invoices

Before purging closed invoices, make sure you do the following:

! Close the months for which you plan to purge closed invoices. See 
‘Closing accounting periods’ on page 160.

! Print all the reports you want to keep that show the closed invoices 
you’ll be purging. Consider printing a copy of the Sales & Receivables 
Journal, which contains detailed information about all sales.

! Make a backup of your company file. See ‘To make a backup of your 
data’ on page 156. Mark this backup clearly and put it in storage as part 
of your permanent records.

To purge closed invoices

1 Go to the Sales command centre.

2 Go to the File menu and choose Purge Closed Invoices. The Purge 
Closed Invoices window appears. 

3 Select the month prior to which you want to remove closed invoices, from 
the Purge Invoices Closed BEFORE list. For example, if you want to purge 
all closed invoices prior to April, select April from this list. 

Be careful when you select a month—don’t include an accounting period 
that isn’t completely closed. 

4 Specify if you want to purge detailed information about closed invoices 
only or to purge entire closed invoices. If you choose to:

# purge detail only, the information in the scrolling list section of the 
invoice will be purged.

# purge entire closed invoices, all information about the closed invoices 
will be removed.

5 Click Continue. Your customer cards list appears. 

6 Select the customers whose closed invoices you want to purge. If you want 
to keep closed invoices for any customers, remove the mark that appears 
next to each of the customer’s names by clicking it. 

7 Click Purge Closed Invoices. The closed invoices for the time frame you 
specified and for the customers you selected are removed. 
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Viewing purged invoices

If you purged only the detailed information about your closed invoices, 
you can still view the remaining information about each closed invoice in 
the Sales Register or Transaction Journal. When you click a zoom arrow 
next to a closed invoice, the original window in which the transaction was 
entered will display just the information that was not purged. This 
information is display-only; you can’t make any changes to it. 

If you purged entire closed invoices, you can still use the Transaction 
Journal to view the transactions that were previously assigned to the closed 
invoices. Since these transactions’ sales records have been removed, 
however, you won’t be able to view any details about the transactions 
(other than those that appear in the Transaction Journal). 

Purging outdated journal entries

Before you purge journal entries, make sure you do the following:

! Close the months for which you plan to purge journal entries. See 
‘Closing accounting periods’ on page 160.

! Print all the reports that you want to keep that show the transactions 
you’ll be purging. 

! Make a backup of your company file. See ‘To make a backup of your 
data’ on page 156. Mark this backup clearly and put it in storage as part 
of your permanent records. (If you’ve just purged closed invoices and 
made a backup before it, it’s not necessary to make another backup for 
journal entries.)

To purge journal entries

1 Go to the Accounts command centre.

2 Go to the File menu and choose Purge Journal Entries. The Purge 
Journal Entries window appears. 

3 Select the month prior to which you want to remove journal entries, from 
the Purge Journal Entries BEFORE list. For example, if you want to purge 
all journal entries before April, select April from this list. 

Be careful when you select a month—don’t include an accounting period 
that isn’t completely closed. 

4 Click Continue. Your Accounts List appears. 

5 Mark the accounts whose unreconciled journal entries you don’t want to 
purge. Typically, you should select the accounts you regularly reconcile in 
the Reconcile Accounts window. 

CAUTION : Be careful when marking accounts Make sure you mark the 
accounts that have unreconciled journal entries you don’t want to remove. 
Don’t make the mistake of marking the accounts you want to remove, even 
though that’s what you may have done if you purged closed invoices. 

6 Click Purge Journal Entries. The journal entries for the time frame you 
specified and for the accounts you did not select in this window are 
purged. 
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12You can save hours of data entry time by importing data into MYOB BusinessBasics. 
BusinessBasics can accept data from spreadsheet and database programs and other accounting 
applications such as Quicken, and MYOB Accountants Office as well as from other BusinessBasics 
company files. 

Many businesses already have computer-generated lists of their customers, suppliers, employees 
and items. You could, for example, import your list of customers from a word processor or database 
file that you currently use for marketing.

You can also import transactions such as sales, cheques, deposits and journal entries. For example, 
your accountant can provide you with year-end adjustments on disk, and you can import them into 
BusinessBasics as journal entries. 

You can also export information from BusinessBasics to other programs. For example, you could 
export your list of customers and use it in a mail merge program to generate personalised letters. If 
you started a new business, you could save time by exporting your current Accounts List, items list, 
and customer and supplier lists and importing them into a new company file.
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Importing data

If you have your business information in other programs, you can import 
that information into your company file—rather than enter it manually in 
MYOB BusinessBasics—saving yourself many hours of data entry. You can 
also incorporate information entered in one MYOB software company file 
into another MYOB software company file. This process is called importing 
data.

You can import the following records into BusinessBasics:

# Accounts list
# Items list
# Customer, supplier, employee and personal contact cards
# Sales
# Spend Money entries 
# Receive Money entries
# General Journal entries
# Bank and credit card statements (see ‘Importing statements into 

MYOB BusinessBasics’ on page 65)

NOTE : Importing from MYOB Accountants Office If your accountant 
uses MYOB Accountants Office, you can import an accounts list and journal 
entries from a file that your accountant provides you with. For information 
on importing an accounts list, see ‘Review your Accounts List’ on page 25. 
For information on importing journals, see ‘If your accountant uses MYOB 
Accountants Office’ on page 145.

Getting ready

Before you start the import process in BusinessBasics, you will need to 
export the data you want from the program you’ve used to create it. For 
example, if you’ve used Microsoft Excel to maintain your customer 
records. You should use Excel to export that information as a text file in the 
format required by BusinessBasics.

IMPORTANT : It is important that the file you’re importing is formatted to 
match BusinessBasics requirements. There are rules that govern which fields 
are mandatory and how the information contained in each field must be 
formatted. To learn more about these requirements, launch MYOB Help and 
click Importing/Exporting in the contents panel. When the table of contents 
appears on the right, click a topic under the heading Import/Export fields.

When you save the exported file, choose a name and location for the file 
that you can remember and find easily since you’ll be asked to find the file 
during the import process. Also remember which file format you select 
because you’ll be asked to select one file format during the import process 
(see the following section for more information). 

ABOUT IMPORT FILE FORMATS

The data you want to import must be stored as a text file that uses either 
the tab-delimited or comma-separated file format. These formats are 
described below:

! Tab-delimited files contain fields that are separated by tab characters. 
For example, if a tab character appears between Brewster and 300 
Roundhill Drive in a file of customer information, the file counts Brewster 
and 300 Roundhill Drive as two separate fields in a record. Tab-delimited 
files are often used by popular spreadsheet and worksheet programs. 

! Comma-separated files contain records that are separated by commas. 
For example, if a comma appears between Brewster and 300 Roundhill 
Drive in a file of customer information, the file counts Brewster and 300 
Roundhill Drive as two separate fields in a record. Comma-separated files 
are often used by popular database programs.
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What are header, data and duplicate records?

Read the following information before you start importing data. 

Header records

Header records are usually used as titles in import files; for example, some 
header records in an export file of customers might be titled “Customer 
Name,” “Address” and “Telephone Number.” During the import process, 
you will be asked if the first record is a header record or data record.

Data records

Data records are actual information that you want to include in your 
BusinessBasics company file. If you indicate that your import file’s first 
record is a data record, that record and all other records will be imported 
into BusinessBasics.

Duplicate Records

Duplicate records are records in your import file that have the same name 
or number as records already in your company file. You can specify during 
the import process if you want to reject duplicate records, add them to your 
company file (some records only) or update existing records.

REJECT DUPLICATE RECORDS

If you choose to reject duplicate records, the following will happen during 
the import process:

! Items or accounts in the import file that have the same numbers as items 
or accounts already existing in BusinessBasics will be rejected. 

! Cards in the import file that have the same names as cards already 
existing in BusinessBasics will be rejected.

! Spend Money and Receive Money entries that are duplicates of 
transactions in BusinessBasics will be rejected. 

Rejected duplicate records will be listed in the Import Log report, which is 
created at the time you import. (See ‘The Import Log report’ on 
page 166.)

ADD RECORDS

If you choose to add duplicate records, the following will happen during 
the import process:

! Duplicate cards (that is, cards with the same name) will be added to 
your company file. For example, if a record for Eileen Martin already 
exists in your company file and you choose to add a record of another 
Eileen Martin, this record will be added during the import process.

! Duplicate Spend Money and Receive Money transactions will be added 
to your company file. 

You can’t add items or accounts with the same number. 

UPDATE EXISTING RECORD

If you choose to update duplicate records, the following will happen 
during the import process:

! An account or item in your company file that has the same number as an 
account or item in the import file will be updated during the import 
process. For example, if Item #100 already exists in your company file 
and you import a different Item #100, the information about Item #100 
in your company file will be updated to reflect the information that’s in 
the import file. 

! A card in your company file that has the same name as a card in the 
import file will be updated during the import process. For example, if a 
record for Eileen Martin already exists in your company file and you 
import a record about another Eileen Martin, the information about 
Eileen Martin in your company file will be changed to reflect the 
information that’s in the import file. 
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To import data into MYOB BusinessBasics

NOTE : If you are using the Easy Setup Assistant If you are importing 
accounts or customer cards as part of your company file setup, click Import 
in the Easy Setup Assistant and begin from Step 3 of the following 
procedure. 

1 Make a backup of your company file. See ‘Backing up your company file’ 
on page 155 for more information. 

2 Go to the File menu, choose Import Data and choose the type of 
information you want to import. The Import File window appears. 

3 Select the format of the file you are about to import: comma-separated or 
tab-delimited. 

4 Select whether the first record in the import file is a header record or a data 
record. 

5 Choose how you want to deal with duplicate records (available only for 
some kinds of records). 

6 Click Continue. A dialog box appears.

7 Locate the file you want to import, select it and click Open. The Import 
Data window appears. 

8 Match the import fields with the corresponding fields in BusinessBasics. To 
do this, highlight the name of a field in the Import Fields column. Then 
match it with a field in the BusinessBasics column by clicking that field. 
When you click the BusinessBasics column, the import field you selected 
will appear in the Matching Import Field column. 

NOTE : Some fields must be imported MYOB BusinessBasics fields that 
have asterisks (*) next to them must have matching import file fields 
assigned to them. 

If you want to remove an import field from the Matching Import Field 
column, simply click it. If all the fields in the import file match the fields in 
the BusinessBasics column, you can match all the fields at one time by 
clicking Match All at the bottom of the window. 

9 After you have matched the fields, click Import. The file is imported into 
BusinessBasics. 

A dialog box appears with the results of the import. If you get a warning or 
an error message indicating that the import was not successful, refer to the 
import log report (see below).

The Import Log report

During the importing process, the Import Log report is created. This report 
lists information about any problems that occurred during the import 
process, as well as information about rejected duplicate records. This 
report can be opened in a text editor such as Notepad. It is located in the 
same place as your company file. The errors and warnings that occurred 
during the import process are listed at the bottom of the report and 
correspond to the number in front of each record. Each time you import, a 
new Import Log report is created and replaces the previous Import Log 
report if one exists.
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Importing data from Quicken

You can import banking information (account names and journal 
transactions) from Quicken into MYOB BusinessBasics. 

NOTE : Importing bank statements If you want to import bank or credit 
card statements that are in QIF file format, use Get Statement in the Bank 
Register or Reconcile Accounts window instead. See ‘Importing statements 
into MYOB BusinessBasics’ on page 65.

Getting ready

Before you begin the import process, use Quicken to export the data you 
want to use in BusinessBasics. Refer to your Quicken documentation for 
instructions. 

To import data from Quicken 

1 Make a backup of your MYOB BusinessBasics company file. 

2 Go to the File menu, choose Import Data and then Quicken (QIF) File. A 
dialog box appears.

3 Locate the QIF file you want to import, highlight it and click Open. The 
import process begins. 

NOTE : If you receive a message during the import process Only 
banking information from Quicken (account names and journal entries) can 
be imported. If other information, for example investments, was included in 
the import file, the import process will be cancelled. 

When BusinessBasics determines that the QIF file contains valid data, one 
of the following occurs: 

# If all your QIF account information corresponds with BusinessBasics 
accounts, a dialog box appears, describing the number of records 
that were imported. The import process is complete. (Note that this 
dialog box probably won’t appear the first time you import a QIF file.) 

# If your QIF account information doesn’t correspond with 
BusinessBasics accounts, the Choose an Account dialog box appears. 
You are required to specify an account in BusinessBasics that will 
match the account in the QIF file. Continue with Step 4. 

4 Enter in the MYOB Account field the BusinessBasics account that best 
matches the account displayed in the QIF Account field or QIF Category 
field. Click OK. 

If additional QIF accounts need to be matched with BusinessBasics 
accounts, the Choose an Account dialog box appears for each of these 
QIF accounts. Repeat this step for each QIF account until all the accounts 
are matched.

If you don’t specify an account, BusinessBasics will create a new 
corresponding account for you automatically. 

When all QIF accounts are matched to BusinessBasics accounts, a dialog 
box appears, describing the number of records that were imported. If 
some records were skipped during the import process or imported with 
warnings, check the Import Log report. See ‘The Import Log report’ on 
page 166. 
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Exporting data from MYOB BusinessBasics

You can take information you have entered in MYOB BusinessBasics and 
use it in other programs or in other MYOB software company files. This 
process is called exporting data. You can export the following records: 

# Accounts list
# Items list
# Records of your customers, suppliers, employees and personal 

contacts
# Sales
# Spend Money entries 
# Receive Money entries
# Journal entries

NOTE : Exporting to MYOB Accountants Office If your accountant uses 
MYOB Accountants Office, you can easily export financial and activity 
statement information using AccountantLink. See ‘If your accountant uses 
MYOB Accountants Office’ on page 145 for more information.

When you export information from BusinessBasics, you can export in a 
tab-delimited or comma-separated file format. These formats are 
described below:

! Tab-delimited files contain fields that are separated by tab characters. 
For example, if a tab character appears between Brewster and 300 
Roundhill Drive in a file of customer names, the file counts Brewster and 
300 Roundhill Drive as two separate fields in a record. Tab-delimited files 
are often used by popular spreadsheet and worksheet programs. 

! Comma-separated files contain records that are separated by commas. 
For example, if a comma appears between Brewster and 300 Roundhill 
Drive in a file of customer names, the file counts Brewster and 300 
Roundhill Drive as two separate fields in a record. Comma-separated files 
are often used by popular database programs.

If you’re exporting the data from BusinessBasics for use in another 
program, use the format that is accepted by that program. (If you’re not 

sure which format is accepted, check the documentation that came with 
the program.) If you’re exporting data for use in another MYOB software 
company file, you can choose either one since we accept either file format.

To export data

1 Go to the File menu, choose Export Data, and then choose the type of 
data you want to export. The Export File window appears. 

2 Select the export file format you want. 

3 Specify if you want the first record to be a Header record or Data record. 

Header records are usually used as titles in export files; for example, some 
header records in an export file of customers might be titled “Customer 
Name,” “Address” and “Telephone Number.” Data records are pieces of 
actual MYOB BusinessBasics information. 

4 Set the filters to restrict the data you are exporting. If you are exporting:

# accounts, specify if you want to export account balances from the 
current or previous financial year, and then select the period whose 
ending balances you want to export. 

# cards, you can restrict the people whose records you export by 
entering custom list entries (see page 99) and Postcodes. If you enter 
a partial Postcode in the Postcode field, only records whose 
Postcodes match the numbers you entered will be exported. 

# journal entries, choose the journal you want to export from. You can 
also select a time period to restrict the journal entries to export.

# sales, you can restrict the sales by status and also limit them to a 
specific time period. 

# Receive Money and Spend Money transactions, you can limit them to 
a specific time period. 

5 Click Continue. The Export Data window appears.
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6 Choose the BusinessBasics fields you want to export, and the order in 
which you want to export them. To do this, click on the first field you want 
to export in the BusinessBasics column. The title Field 1 will appear in the 
Export Order column next to the field you selected. The field name will 
appear at the top of the Export Fields column on the left side of the 
window. Repeat this step for each field you want to export.

NOTE : Some fields must be exported MYOB BusinessBasics fields that 
have asterisks (*) next to them must be included in the Export Fields 
column before you can export any data.

If you want to remove a field’s name from the Export Fields column, click 
the field’s name in the BusinessBasics column. If you want to export all 
the fields in the order they’re shown in the BusinessBasics column, click 
Match All. 

7 When you have selected the fields, click Export. The Save dialog box 
appears. 

8 Enter a file name and location for the export file and click OK or Save. The 
file is exported.
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